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Before You Begin 
This section provides you with safety information, technical support 
information, and sources for additional product information. 

Safety Summary 
Your safety is extremely important. Read and follow all warnings and 
cautions in this document before handling and operating Intermec 
equipment. You can be seriously injured, and equipment and data can be 
damaged if you do not follow the safety warnings and cautions. 

Do not repair or adjust alone 
Do not repair or adjust energized equipment alone under any 
circumstances. Someone capable of providing first aid must always be 
present for your safety. 

First aid 
Always obtain first aid or medical attention immediately after an injury. 
Never neglect an injury, no matter how slight it seems. 

Resuscitation 
Begin resuscitation immediately if someone is injured and stops breathing. 
Any delay could result in death. To work on or near high voltage, you 
should be familiar with approved industrial first aid methods. 

Energized equipment 
Never work on energized equipment unless authorized by a responsible 
authority. Energized electrical equipment is dangerous. Electrical shock 
from energized equipment can cause death. If you must perform 
authorized emergency work on energized equipment, be sure that you 
comply strictly with approved safety regulations. 

 



Before You Begin 

xii MobileLAN access System Manual 

Safety Icons 
This section explains how to identify and understand warnings, cautions, 
and notes that are in this document. 

 

A warning alerts you of an operating procedure, practice, condition, 
or statement that must be strictly observed to avoid death or serious 
injury to the persons working on the equipment. 

Avertissement: Un avertissement vous avertit d’une procédure de 
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit 
être strictement respecté pour éviter l’occurrence de mort ou de 
blessures graves aux personnes manupulant l’équipement. 

 

A caution alerts you to an operating procedure, practice, condition, or 
statement that must be strictly observed to prevent equipment damage 
or destruction, or corruption or loss of data. 

Attention: Une précaution vous avertit d’une procédure de 
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit 
être strictement respecté pour empêcher l’endommagement ou la 
destruction de l’équipement, ou l’altération ou la perte de données. 

Global Services and Support 

Warranty Information 
To understand the warranty for your Intermec product, visit the Intermec 
web site at http://www.intermec.com and click Support > Warranty.  

Disclaimer of warranties: The sample code included in this document is 
presented for reference only. The code does not necessarily represent 
complete, tested programs. The code is provided “as is with all faults.” All 
warranties are expressly disclaimed, including the implied warranties of 
merchantability and fitness for a particular purpose. 

Web Support 
Visit the Intermec web site at http://www.intermec.com to download our 
current manuals in PDF format. To order printed versions of the Intermec 
manuals, contact your local Intermec representative or distributor. 

Visit the Intermec technical knowledge base (Knowledge Central) at 
http://intermec.custhelp.com to review technical information or to request 
technical support for your Intermec product. 
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Telephone Support 
These services are available from Intermec Technologies Corporation. 

 
 
Service 

 
 
Description 

In the U.S.A. and Canada 
call 1-800-755-5505 
and choose this option 

Factory Repair and 
On-site Repair 

Request a return authorization 
number for authorized service 
center repair, or request an on-
site repair technician. 

1 

Technical Support Get technical support on your 
Intermec product. 

2 

Service Contract 
Status 

Inquire about an existing 
contract, renew a contract, or 
ask invoicing questions. 

3 

Schedule Site Surveys 
or Installations 

Schedule a site survey, or 
request a product or system 
installation. 

4 

Ordering Products Talk to sales administration, 
place an order, or check the 
status of your order. 

5 

   

Outside the U.S.A. and Canada, contact your local Intermec 
representative.  

Who Should Read This Document? 
This manual provides you with information about the features of the 
MobileLAN access products, and how to install, configure, operate, 
maintain, and troubleshoot them.  

Before you install and configure the MobileLAN access products, you 
should be familiar with your network and general networking terms, such 
as IP address.  

Related Documents 
The Intermec web site at http://www.intermec.com contains many of our 
documents that you can download in PDF format.  

To order printed versions of the Intermec manuals, contact your local 
Intermec representative or distributor. 
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Patent Information 
Product is covered by one or more of the following patents: 4,910,794; 
5,070,536; 5,295,154; 5,349,678; 5,394,436; 5,425,051; 5,428,636; 
5,483,676; 5,504,746; 5,546,397; 5,574,979; 5,592,512; 5,680,633; 
5,682,299; 5,696,903; 5,740,366; 5,790,536; 5,844,893; 5,862,171; 
5,940,771; 5,960,344. 

There may be other U.S. and foreign patents pending. 
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Getting Started 

This chapter introduces the MobileLAN™access family of access points, 
explains their features, and describes how you can use them to expand your 
data collection network. This chapter covers these topics: 

• Overview of the MobileLAN access family 

• How the access point fits in your network 

• Configuring the access point for the first time 

• Saving configuration changes 

1 
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Overview of the MobileLAN access Family 
Intermec’s MobileLAN™access family of access points delivers reliable and 
seamless wireless performance to almost any operational environment. 
They are designed for standards-based connectivity and they support 
industry standard IEEE 802.11b and IEEE 802.11a wireless technologies. 
The 2100 supports legacy 902 MHz wireless technologies. The 2101, 
2100, and 2102 support also support legacy WLI Forum OpenAir wireless 
technologies.  

™

 

The 2101, WA22, 2100, WA21, or 2102 with an IEEE 802.11b radio 
installed is Wi-Fi® certified for interoperability with other 802.11b wireless 
LAN devices. 

The WA22, WA21, or 2106 with an IEEE 802.11a radio installed is  
Wi-Fi certified for interoperability with other 802.11a wireless LAN 
devices. 

The MobileLAN access family consists of these access points: 

• WA22 

• WA21 

• 2101 

• 2100 

• 2102 

• 2106 

The access point can be configured as an access point or as a point-to-
point or point-to-multipoint bridge. Normally, an access point is 
connected to a wired local area network (LAN) and provides network 
access for wireless end devices. A point-to-point bridge connects two wired 
LANs and is often used to provide wireless communications in locations 
where running cable is difficult, such as across roads or between buildings. 
A point-to-multipoint bridge not only connects two wired LANs, but also 
communicates with wireless end devices. 

An access point can also be configured as a wireless access point (WAP) or 
repeater. A WAP is not connected to a wired LAN; it receives data from 
wireless end devices and forwards the data to an access point (that is 
connected to the wired LAN). A WAP is useful in areas that do not 
support a wired network connection. 
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Management and Configuration
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On the left, this illustration shows the ways you can manage and configure the access point, and on the right, 
it shows the access point’s general multiport bridge architecture. 

Access points are multiport (Ethernet-to-wireless) bridges, and because 
wireless end devices operate similarly to other Ethernet devices, all your 
existing Ethernet applications will work with the wireless network without 
any special networking software. Any access point, except the root access 
point, can concurrently receive hello messages on its Ethernet port, its 
radio port, and its IP tunnel port. However, an access point can use only 
one port to attach to the network. Port priorities are structured as follows:  

1 Ethernet 

2 IP tunnel 

3 Radio 

Unlike the physical Ethernet and radio ports, the IP tunnel port does not 
have its own output connector. It is a logical port that provides IP 
encapsulation services for frames that must be routed to reach their 
destinations. Once frames are encapsulated, they are transmitted or 
received through the Ethernet or radio port.  

Wireless end devices may use power management to maintain battery life. 
These end devices periodically wake up to receive frames that arrived while 
their radio was powered down. The access point automatically provides a 
pending message delivery service that holds frames until the end device is 
ready to receive them. 
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Features 
This table lists the features of the various MobileLAN access products. 

MobileLAN access Feature Comparison 

Feature WA22 2101 WA21 2100 2102 2106 

Access Point Yes Yes Yes Yes Yes Yes 

Point-to-Point Bridge 
(Wireless Bridge) 

Yes Yes Yes Yes Yes Yes 

Wireless Access Point 
(WAP) or Repeater 

Yes Yes Yes Yes  No Yes 

Secure Wireless Hops 
(SWAP) 

Yes Yes Yes Yes Yes Yes 

Secure Wireless Hops 
(TLS or TTLS) 

Yes Yes (2101B) Yes Yes 
(2100D) 

No Yes 

Radios 802.11b, 
802.11a 

802.11b, 
OpenAir 

802.11b, 
802.11a 

802.11b, 
OpenAir, 
900 MHz 

802.11b, 
OpenAir 

802.11a 

Dual Radio Support Yes Yes Yes Yes No No 

Wi-Fi Compliant Yes Yes Yes Yes Yes Yes 

802.1x Authenticator Yes Yes Yes Yes Yes Yes 

802.1x Authentication 
Server 

Yes Yes (2101B) Yes Yes 
(2100D) 

No Yes 

Access Control List 
(ACL) Server 

Yes Yes (2101B) Yes Yes 
(2100D) 

Yes Yes 

Password Server Yes Yes Yes Yes Yes Yes 

Secure Web Browser 
Interface (HTTPS) 

Yes Yes (2101B) Yes Yes 
(2100D) 

No Yes 

10BaseT/100BaseTx Yes Yes (2101B) Yes Yes 
(2100D) 

10BaseT Yes 

Fiber Optics Option Yes Yes Yes Yes No No 

Serial Port Yes Yes Yes Yes Yes No 

Data Link Tunneling Yes Yes Yes Yes Yes Yes 

IP Tunneling Yes Yes Yes Yes Yes Yes 

Antenna Diversity Yes Yes Yes Yes Yes No 

Non-incentive 
Antenna System 

Yes No Yes Yes No No 

NEMA 4/IP 54 
Protection 

No No Yes Yes No No 

Power Supply No DC AC AC DC DC 

Power Over Ethernet Yes No Yes No Yes with 
MobileLAN 
splitter 

Yes with 
MobileLAN 
splitter 

Heater Option No No Yes Yes No  No 
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Other features of all access points include: 

• the ability to be managed by MobileLAN manager, a web browser, 
telnet, and SNMP. 

• the ability to be a DHCP server or client and a NAT server. 

• the ability to be an ARP server. 

• easy software distribution. 

• advanced filtering of wired data traffic. 

• enhanced power management for wireless end devices. 

• fast roaming reliability for wireless end devices. 

• load balancing. 

• IEEE 802.1x security and dynamically rotating WEP keys for 802.11b 
or 802.11a networks. The access point can be an authenticator and an 
authentication server. 

• basic WEP 64 or WEP 128 security for 802.11b or 802.11a radios. 

• the ability to upgrade over the network or serial port, if the access point 
has a serial port. 

What’s New for Software Releases 1.90? 
Software release 1.90 can be installed on all MobileLAN access products. 
However, some features are only available on newer access points, which 
have a faster processor and more flash memory. Newer access points are 
the WA22, 2101B, WA21, 2100D, and the 2106.  

 

Note: To determine the model of your access point, from the menu 
choose Maintenance > About this Access Point. In the Config String 
field, the first five characters tell you the model. 

New features include these items: 

• Added functionality for the 802.11a radio. Wireless hops are now fully 
supported, a single radio can provide both master and station 
functionality, the radio can be configured to dynamically choose the 
correct frequency, statistics can be viewed.  

• MobileLAN access Configuration Wizard. This wizard runs on a PC 
that is on the same Ethernet segment as the access points. It discovers 
the access points, helps you configure new networks, and helps you 
manage previously configured networks. 

• Domain Name Server (DNS) support 

• Find This AP button to make locating access points easier 

• Hyperlinks to make access point configuration easier and to help 
identify potential configuration problems 
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• IP tunnel filter that supports the AirFortress™ gateway 

New security features include these items: 

• (Newer access points only) Spanning tree security for 802.1x 
authentication. Authentication can now be performed over wired or 
wireless connections using TLS or TTLS (MSCHAPv2).  

• VLAN support for each radio 

• Support for the EAP-PEAP authentication method 

• Configurable ACL client password 

• EAP-OL key message verification, which means that the access point 
verifies when a new WEP key is delivered to a wireless end device. If it is 
not delivered, the key message is resent. 

• Ability to configure up to six RADIUS servers 

• (External RADIUS servers only) Ability to configure the port number 
for the RADIUS client access point 

• Additional authentication slots (up to 60) to let more wireless end 
devices authenticate simultaneously 

• Fast roaming for Trakker Antares terminals always enabled 

Understanding the LEDs 
The 2102 and 2106 have four LEDs; the WA22, 2101, WA21, and 2100 
have five LEDs. The WA22, 2101, WA21, and 2100 have a separate LED 
for each of the radios. To use the LEDs to help troubleshoot the radios, see 
“Troubleshooting the Radios” in Chapter 8. To understand the LEDs 
during normal use, see the next table. 

LED Descriptions 

Icon LED Description 

 
Power Remains on when power is applied. 

 
Wireless #1 or Radio Flashes when a frame is transmitted or received on the 

radio port for the radio installed in radio slot 1. 

 
Wireless #2 (WA22, 
2101, WA21, 2100,) 

Flashes when a frame is transmitted or received on the 
radio port for the radio installed in radio slot 2 (if a 
second radio is installed).  

 
Wired LAN Flashes when a frame is transmitted or received on the 

Ethernet port. 

 
Root/error Flashes if this device is configured as the root. May also 

remain on if an error is detected. 
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U n i v e r s a l  A c c e s s  P o i n t  ™

21XXT018.eps

Power

Wireless #1

Wireless #2

Wired LAN
Root/error

 

WA22 and 2101 LEDs: This illustration shows the LEDs that are on the WA22 and the 
2101. For help understanding these LEDs, see the LED Descriptions table on page 6. 

 21XXT003.eps

Power
Wireless

#1
Wireless

#2 Wired LAN
Root/
error

 

WA21 and 2100 LEDs: This illustration shows the LEDs that are on the WA21 and the 
2100. For help understanding these LEDs, see the LED Descriptions table on page 6. 
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Power
Radio

Wired
LAN

Root/error

21XXT031.eps 

2102 and 2106 LEDs: This illustration shows the LEDs that are on the 2102 and the 
2106. For help understanding these LEDs, see the LED Descriptions table on page 6. 

Understanding the Ports 
The WA22, 2101, 2102, and 2106 ports are located on the bottom of the 
access point. For more information on connecting the ports, see 
Chapter 2, “Installing the Access Points.” 

Port Descriptions 

Port Description 

Power 
(Not WA22, 
optional WA21) 

Used with an appropriate power cable, this port connects the 
access point to an AC power source. 

Serial 
(Not 2106) 

Used with an RS-232 null-modem cable, this port connects the 
access point to a terminal or PC to perform configuration. 

10BaseT/100BaseTx 
(WA22, 2101B, 
WA21, 2100D, 2106 
only) 

Used with an appropriate cable, this port connects the access 
point to your Ethernet network. The access point auto-
negotiates with the device it is communicating with so that the 
data rate is set at the highest rate at which both devices can 
communicate. 

10BaseT 
(2102 only) 

Used with an appropriate cable, this port connects the access 
point to your Ethernet network. 

Fiber optic 
(WA22, 2101, 
WA21, 2100 only) 

Optional 100BaseFX port. You must use an MT-RJ connector. 
Used with an appropriate cable, this port connects the access 
point to your fiber optic network.  

  

To access the ports on the WA21 and the 2100, you must remove the 
cable access door. 

To remove the WA21 or 2100 cable access door 

1 Unscrew the two thumbscrews on the cable access door. 

2 Remove the door. 
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Serial port

10BaseT/100BaseTx
Ethernet port

Fiber optic
port (optional)

21XXT077.eps

 

WA22 ports: This illustration shows the ports that are on the WA22. For help 
understanding these ports, see the Port Descriptions table on page 8.  

 Serial port

10BaseT/100BaseTx
Ethernet port

Power port

Fiber optic
port (optional)

21XXT036.eps

 

2101 ports: This illustration shows the ports that are on the 2101. For help 
understanding these ports, see the Port Descriptions table on page 8.  
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21XXT071.eps

Power port
(optional)

10BaseT/ 
100BaseTx
Ethernet  port

Fiber optic
port (optional)

Serial
port

Cable
access
door

 

WA21 ports: This illustration shows the ports that are on the WA21. For help 
understanding these ports, see the Port Descriptions table on page 8.  

 

21XXT002.eps

Power
port

10BaseT/ 
100BaseTx
Ethernet  port

Serial
port

Fiber optic 
port (optional)

Cable
access
door

 

2100 ports: This illustration shows the ports that are on the 2100. For help 
understanding these ports, see the Port Descriptions table on page 8.  
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10BaseT
Ethernet port

Serial
port

Power
port

21XXT030.eps  

2102 ports: This illustration shows the ports that are on the 2102. For help 
understanding these ports, see the Port Descriptions table on page 8.  

 

10BaseT/100BaseTx
Ethernet port

Power
port

21XXT035.eps  

2106 ports: This illustration shows the ports that are on the 2106. For help 
understanding these ports, see the Port Descriptions table on page 8.  

How the Access Point Fits in Your Network 
In general, the access point forwards data from wireless end devices to the 
wired Ethernet network. You can also use the access point as a point-to-
point bridge, or if your access point has two radios, you can use it as a 
point-to-multipoint bridge or a WAP. Use the access point in the 
following locations and environments. 

Which Access Point to Use for Your Environment 

Access Point Environment 

WA22 and 2101 Use in most indoor environments. 

WA21 and 2100 Use in locations where an access point is exposed to extreme 
environments. 

2102 and 2106 Use when you have a simple wireless network, do not need mixed 
radios, or want a point-to-point bridge to a secondary LAN. 

  

The access point supports a variety of network configurations. These 
configurations are explained in this section. 
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Using One Access Point in a Simple Wireless Network 
You can use an access point to extend your existing Ethernet network to 
include wireless end devices. The access point connects directly to your 
wired network and the end devices provide a wireless extension of the 
wired LAN. 

 

Host

Access 
point

21XXT004.eps

Ethernet

 

This illustration shows a simple wireless network with one access point and some 
wireless end devices. 

In a simple wireless network, the access point that is connected to the 
wired network serves as a transparent bridge between the wired network 
and wireless end devices. 

To install a simple wireless network 

1 Configure the initial IP address. For help, see “Configuring the Access 
Point” on page 29. 

2 Install the access point. For help, see Chapter 2, “Installing the Access 
Points.” 

3 Configure the Ethernet network. For help, see Chapter 3, “Configuring 
the Ethernet Network.” 

4 Configure the radios. For help, see Chapter 4, “Configuring the 
Radios.” 

5 Decide what level of security you want to implement in your network. 
For help, see Chapter 6, “Configuring Security.” 
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Example - Configuring an 802.11b Access Point 

 

Host

Access 
point

21XXT004.eps

Ethernet

 

In this example, there is one 802.11b  radio in the access point. Wireless end devices use 
the access point to communicate with the host and other end devices. 

Configuring an 802.11b Access Point Parameters 

Screen Parameter Access Point 

IEEE 802.11b Radio Node Type Master 

 SSID (Network Name) Manufacturing 

Spanning Tree Settings Root Priority 5 

 Ethernet Bridging Enabled Checked 

   

Intermec recommends that you always implement some type of security. 

Using Multiple Access Points and Roaming Wireless End Devices 
For larger or more complex environments, you can install multiple access 
points so wireless end devices can roam from one access point to another. 
Multiple access points establish coverage areas or cells similar to those of a 
cellular telephone network. End devices can connect with any access point 
that is within range and belongs to the same wireless network. 
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Host

Ethernet

UAP

21XXT006.eps

UAPUAP

 

This illustration shows a wireless network with multiple access points. Wireless end 
devices can roam between the access points to communicate with the host and other 
end devices. 

An end device initiates a roam when it attaches to a new access point. The 
access point sends an attach message to the root access point, which in turn 
forwards a detach message to the previous access point, allowing each 
access point to update its forwarding database. Intermediate access points 
monitor these exchanges and update their forwarding databases. 

With the access point’s multichannel architecture, you can have more than 
one access point within the same cell area to increase throughput and 
provide redundancy. For more information, see “Using Dual Radio Access 
Points for Redundancy” on page 28. 

To install multiple access points with roaming end devices 

1 Follow the instructions for installing a simple wireless network on page 
12. 

2 Configure the LAN ID. For help, see “Configuring the Spanning Tree 
Parameters” in Chapter 5.  

3 Configure one of the access points to be a root access point. For help, 
see “About the Primary LAN and the Root Access Point” in Chapter 5. 

4 If your network has a switch that is not IEEE 802.1d-compliant and is 
located between access points, configure data link tunneling. For help, 
see “About Data Link Tunneling” in Chapter 5. 
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Example - Configuring an OpenAir Access Point with Roaming End 
Devices 

 

Host

Ethernet

UAP

21XXT007.eps

AP1

AP2

AP3

 

In this example, there is one OpenAir radio in each access point. Wireless end devices 
can roam between the access points to communicate with the host and other end 
devices. 

Configuring OpenAir Access Points Parameters 

 
 
Screen 

 
 
Parameter 

AP1 
OpenAir 
Radio (Root) 

AP2 
OpenAir 
Radio 

AP3 
OpenAir 
Radio 

OpenAir 
Radio 

Node Type Master Master Master 

 Security ID Op3rat!ons Op3rat!ons Op3rat!ons 

 Channel 1 2 3 

 Subchannel 1 1 1 

 MAC 
Configuration 

Default Default Default 

Spanning 
Tree Settings 

LAN ID 0 0 0 

 Root Priority 5 4 3 

 Ethernet Bridging 
Enabled 

Checked Checked Checked 

 Secondary LAN 
Bridge Priority 

0 0 0 

     

You should configure different channel/subchannel combinations for each 
access point. The access points communicate with each other through the 
spanning tree. The wireless end devices are configured as stations with 
LAN ID set to 0 and Security ID set to Op3rat!ons. 
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Using an Access Point as a WAP 
You can extend the range of your wireless network by configuring a dual 
radio access point as a wireless access point (WAP). The WAP and the 
wireless end devices it communicates with comprise a secondary LAN. You 
can position WAPs in strategic locations so they receive data from end 
devices, and then forward the data to the wired network. This 
configuration can be useful when distance or physical layout impedes radio 
reception and transmission.  

Host

21XXT011.eps

E
th

er
ne

t

WAP
Access
point

 

This illustration shows a simple wireless network with one access point and one WAP. 
Wireless end devices use the WAP to forward data to the access point. 

WAPs send data from end devices to the access points via wireless hops. 
Wireless hops are formed when data from end devices move from one 
access point to another access point through the radio ports. The master 
radio in the access point transmits hello messages, which allow the WAPs 
to attach to the spanning tree in the same way as access points. 

If you have an 802.11b or an OpenAir network, the WAP must contain 
two radios. The WAP master radio must match the end devices radios and 
the WAP station radio must match the master radio in the access point.  

If you have an 802.11a or 902 MHz network, the WAP only needs one 
radio because this radio can simultaneously be a master and a station. This 
radio will create wireless hops automatically when it cannot communicate 
to the wired network. 

 
Note: The 2102 cannot be WAPs because it only contains one 802.11b 
radio. 

WAPs must be on the same IP subnet as the access point. Also, data from 
wireless end devices should not go through more than three wireless hops 
before it gets to an access point on the primary LAN. 
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The following procedure explains how to install a simple wireless network 
with a WAP and no roaming end devices. For help installing a simple 
wireless network with a WAP and roaming end devices, see the two 
examples in the next sections. 

To install a simple wireless network with a WAP and no roaming end devices 

1 Follow the instructions for installing a simple wireless network on page 
12. 

2 Configure the LAN ID. For help, see “Configuring the Spanning Tree 
Parameters” in Chapter 5. 

3 (802.11b, OpenAir) Configure the station radio in the WAP. 

a From the main menu, click the link corresponding to the station 
radio. The radio screen appears. 

    

b In the Node Type field choose Station, and then click Submit 
Changes. 

c (OpenAir) Click Master List. The Master List screen appears. 

  

In the Channel field and Subchannel field, enter the channel and 
subchannel of all master radios with which this station can 
communicate. 
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4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

5 Configure the master radio (in the WAP) to communicate with the end 
devices. For help, see Chapter 4, “Configuring the Radios.” 

6 Configure the master radio in the access point. 

a From the main menu, click the link corresponding to the master 
radio. The radio screen appears. 

b In the Node Type field, choose Master and then click Submit 
Changes. 

7 Configure the access point to be a root access point. For help, see 
“About the Primary LAN and the Root Access Point” in Chapter 5. 

8 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Example - Configuring an 802.11b WAP With Roaming End Devices 
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In this example, there is one 802.11b radio in the access point and there are two 802.11b 
radios (IEEE 802.11b-1 and IEEE 802.11b-2) in the WAP. Wireless end devices can roam 
between the WAP and the access point. 

Configuring an 802.11b Access Point and WAP Parameters 

 
Screen 

 
Parameter 

Access Point  
IEEE 802.11b 

WAP IEEE 
802.11b-1 

WAP IEEE 
802.11b-2 

IEEE 
802.11b 
Radio 

Node Type Master Master Station 

 SSID Manufacturing Manufacturing Manufacturing 

Spanning 
Tree 
Settings 

LAN ID 11 11 11 

 Root Priority 5 0 N/A 

 Ethernet 
Bridging 
Enabled 

Checked Checked N/A 

     

You need to configure the wireless end devices to have the same SSID, 
LAN ID, and frequency as the WAP master radio (IEEE 802.11b-1). You 
do not need to configure any secondary LAN settings because the WAP is 
not connected to a secondary LAN. 

Intermec recommends that you always implement some type of security. 
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Example - Configuring an 802.11a WAP With Roaming End Devices 
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In this example, there is one 802.11a radio in the access point and there is one 802.11a 
radio in the WAP. Wireless end devices can roam between the WAP and the access point. 

Configuring an 802.11a Access Point and WAP Parameters 

 
Screen 

 
Parameter 

Access Point  IEEE 
802.11a 

WAP IEEE 
802.11a 

IEEE 802.11a 
Radio 

Node Type Master Master 

 SSID Manufacturing Manufacturing 

Spanning Tree 
Settings 

LAN ID 11 11 

 Root Priority 5 0 

 Ethernet Bridging 
Enabled 

Checked Checked 

 Secondary LAN 
Bridge Priority 

0 0 

    

You need to configure the wireless end devices to have the same SSID, 
LAN ID, and frequency as the WAP radio. You do not need to configure 
any secondary LAN settings because the WAP is not connected to a 
secondary LAN. 

Intermec recommends that you always implement some type of security. 
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Example - Configuring an OpenAir WAP With Roaming End Devices 
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In this example, there are two OpenAir radios in the access point and there are two 
OpenAir radios in the WAP. To provide better throughput, one master radio in the access 
point is configured to allow wireless end devices to communicate with it and the other 
master radio is configured to communicate only with the WAP station radio. 

Configuring an OpenAir Access Point and WAP Parameters 

 
Screen 

 
Parameter 

Access Point 
OpenAir-1 

Access Point 
OpenAir-2 

WAP 
OpenAir-1 

WAP 
OpenAir-2 

OpenAir Radio Node Type Master Master Master Station 

 Security ID Area2 Area1 Area2 Area1 

 Channel 2 1 2 N/A 

 Subchannel 1 1 1 N/A 

 MAC Configuration Default Default Default Default 

Spanning Tree 
Settings 

LAN ID 0 0 0 0 

 Root Priority 5 0 0 0 

 Ethernet Bridging 
Enabled 

Checked Checked Checked Checked 

      

You also need to add the channel (1) and the subchannel (1) of the master 
radio that the WAP station radio is communicating with (Access Point 
OpenAir-2) to the Master List for the WAP station radio. You do not need 
to configure any secondary LAN settings because the WAP is not 
connected to a secondary LAN. 

You need to configure the wireless end devices to have the same LAN ID 
and security ID as the WAP master radio (WAP OpenAir-1). 
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Using Access Points to Create a Point-to-Point Bridge 
You can use access points to create a point-to-point bridge between two 
wired LANs. That is, you can have one access point wired to a primary 
LAN in one building and have a second access point wired to a secondary 
LAN in another building. This configuration lets wired and wireless end 
devices in both buildings communicate with each other, which can be 
useful in a campus environment or any other environment where 
pavement or other objects prevent installation of a wired link. 

 

Host

21XXT013.eps

Primary LAN Secondary LAN

Root
Designated

bridge

 

This illustration shows two simple wireless networks that are connected with access 
points that are acting as point-to-point bridges.  

Point-to-point bridges send data from end devices on the secondary LAN 
to the root access point via wireless hops. Wireless hops are formed when 
data from end devices move from one access point to another access point 
through the radio ports. The master radio in the point-to-point bridge on 
the primary LAN transmits hello messages, which allow the bridge on the 
secondary LAN to attach to the spanning tree in the same way as access 
points. 

If the access points are simply acting as a point-to-point bridge or if you 
have an 802.11a or 902 MHz network, each access point only needs one 
radio. If you have an 802.11b or an OpenAir network and you want the 
designated bridge to also be able to communicate with wireless end devices 
(point-to-multipoint), the designated bridge must be a dual radio access 
point. The designated bridge master radio must match the end device 
radios and the station radio must match the root master radio. 

Data from wireless end devices should not go through more than three 
wireless hops before it gets to an access point on the primary LAN. 
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You need to set the root priorities and secondary LAN bridge priorities for 
the bridge on the primary LAN and for the bridge on the secondary LAN: 

• On the primary LAN bridge, set the root priority to a number that is 
greater than the root priority of the secondary LAN bridge. The access 
points will not form a point-to-point bridge if the primary LAN bridge 
has a lower root priority than the secondary LAN bridge. 

• On the secondary LAN bridge, set root priority to 0 and the secondary 
LAN bridge priority to a number other than 0. 

You may also need to adjust the flooding parameters. Here are some 
recommendations: 

• If there are no end devices on the secondary LAN, the bridge on the 
secondary LAN can use the default flooding settings. The Secondary 
LAN Flooding parameter is disabled. 

• If there are end devices on the secondary LAN, the bridge on the 
secondary LAN should have Secondary LAN Flooding parameter set to 
Multicast. If you also want unicast flooding, you can set this parameter 
to Enabled. 

• If there are end devices on the secondary LAN and the end devices 
communicate with end devices on another secondary LAN, the root 
access point should have its Multicast Flooding parameter set to 
Universal. This setting ensures that all ARP requests and multicast 
traffic is distributed through a second or third hop.  

To install a point-to-point or a point-to-multipoint bridge 

1 Follow the instructions for installing a simple wireless network on page 
12. 

2 Configure the LAN ID. For help, see “Configuring the Spanning Tree 
Parameters” in Chapter 5. 

3 (802.11b, OpenAir) Configure the station radio in the point-to-point 
bridge on the secondary LAN. 

a From the main menu, click the link corresponding to the station 
radio. The radio screen appears. 
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b In the Node Type field choose Station, and then click Submit 
Changes. 

c (OpenAir) Click Master List. The Master List screen appears. 

    

In the Channel field and Subchannel field, enter the channel and 
subchannel of all master radios with which this station can 
communicate. 

4 Configure the spanning tree settings for the point-to-point bridge on 
the secondary LAN. 

a From the main menu, click Spanning Tree Settings. The Spanning 
Tree Settings screen appears. 
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b In the Root Priority field, enter 0. 

c In the Secondary LAN Bridge Priority field, enter a number other 
than zero. 

d In the Secondary LAN Flooding field choose Enabled. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 Configure the master radio in the point-to-point bridge on the primary 
LAN. 

a From the main menu, click the link corresponding to the master 
radio. The radio screen appears. 

b In the Node Type field choose Master, and then click Submit 
Changes. 

7 Configure the spanning tree settings for the point-to-point bridge on 
the primary LAN. 

a From the main menu, click Spanning Tree Settings. The Spanning 
Tree Settings screen appears. 

b In the Root Priority field, enter a number other than 0. 

c In the Secondary LAN Bridge Priority field, enter 0. 

d In the Secondary LAN Flooding field choose Disabled. 

8 If the roaming end devices will be roaming across an IP router, you 
must configure IP tunnels. For help, see “Configuring IP Tunnels” in 
Chapter 5. 

9 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Example - Configuring an 802.11b Bridge 
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In this example, each access point only has one 802.11b radio. Since the designated 
bridge only has a station radio, wireless end devices can only communicate with the 
root access point. However, wired devices on the secondary LAN can communicate with 
the primary LAN. 

Configuring 802.11b Point-to-Point Bridges Parameters 

 
 
Screen 

 
 
Parameter 

 
Bridge - Primary 
LAN (Root) 

Bridge – Secondary 
LAN (Designated 
Bridge) 

IEEE 
802.11b 
Radio 

Node Type Master Station 

 SSID Manufacturing Manufacturing 

Spanning 
Tree Settings 

LAN ID 0 0 

 Root Priority 5 0 

 Ethernet Bridging 
Enabled 

Checked Checked 

 Secondary LAN 
Bridge Priority 

0 1 

 Secondary LAN 
Flooding 

Disabled Enabled 

    

Intermec recommends that you always implement some type of security. 
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Example - Configuring an 802.11a Bridge 
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In this example, each access point only has one 802.11a radio. Since the 802.11a radio 
can function as a master and a station, wireless end devices can communicate with 
either access point.  

Configuring 802.11a Point-to-Point Bridges Parameters 

 
 
Screen 

 
 
Parameter 

 
Bridge - Primary 
LAN (Root) 

Bridge – Secondary 
LAN (Designated 
Bridge) 

IEEE 
802.11b 
Radio 

Node Type Master Master 

 SSID Manufacturing Manufacturing 

Spanning 
Tree Settings 

LAN ID 11 11 

 Root Priority 5 0 

 Ethernet Bridging 
Enabled 

Checked Checked 

 Secondary LAN 
Bridge Priority 

0 1 

 Secondary LAN 
Flooding 

Disabled Enabled 

    

Intermec recommends that you always implement some type of security. 
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Using Dual Radio Access Points for Redundancy 
You can configure WA22s, 2101s, WA21s, and 2100s that have two 
802.11b radios, two 802.11a radios, or two OpenAir radios to provide 
redundancy for your network. During normal operations, end devices send 
frames to the master radio in one of the access points, which bridges the 
frames to the wired network. If a section of the wired network goes down, 
the master radio receives the frames, and then the station radio forwards 
the frames to a master radio in another access point that is within range. 

In each access point, you need to configure one radio’s node type as a 
Master, which communicates with the wireless end devices and configure 
the other radio’s node type as a Station, which communicates to another 
access point with a master radio and within range. 

 

Host

AP1 

21XXT014.eps
Ethernet
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In this example, AP3 is a dual radio access point. It may be located on a loading dock or 
other remote location. During normal operations, AP3 functions as a normal access 
point, transmitting frames to and from the host. However, if the Ethernet connection is 
disrupted, AP3 can function as a WAP and continue operations by transmitting frames 
to a master radio in AP1. AP3 must be within range of AP1. 

To install dual radio access points for redundancy 

• Follow the instructions for installing a simple wireless network with a 
WAP on page 16. 
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Configuring the Access Point (Setting the IP Address) 
The access point will work out of the box if you are using a DHCP server 
to assign it an IP address. By default, the access point is configured to be a 
DHCP client and will respond to offers from any DHCP server. However, 
if you are not using a DHCP server to assign an IP address, you can use: 

• the MobileLAN access Configuration Wizard, which also configures 
radio parameters and security parameters. All access points must be at 
factory defaults. You install this wizard from the MobileLAN access 
Tools CD that shipped with the access point. This wizard can configure 
all the access points that are on the same Ethernet segment and subnet 
as the PC it is installed on. For more information, run the wizard. 

• the MobileLAN access Utility, but you need to know the access point 
MAC address. You install this utility from the MobileLAN access Tools 
CD that shipped with the access point. This utility must be installed on 
a PC that is on the same Ethernet segment and subnet as (or must be 
communicating wirelessly with) the access point. For help, see “Using 
the MobileLAN access Utility” on page 29. 

 

Note:, If your access points are running software release 1.90 or later, 
you must use MobileLAN access Utility v2.0. 

• a communications program, such as HyperTerminal, which also 
configures other parameters. This program must be installed on a PC 
with an open serial port. For help, see “Using a Communications 
Program” on page 31. 

This manual assumes that you are using the MobileLAN access Utility or a 
communications program for your initial configuration, and then using a 
web browser interface to perform all other configurations. You can also 
continue to use a communications program or you can start a telnet 
session to configure the access point. 

Using the MobileLAN access Utility 
The MobileLAN access Utility is an easy-to-use Microsoft® Windows™-
based utility that lets you: 

• set the initial IP address for the access point. This utility eliminates the 
need to serially connect a PC to the access point to configure its IP 
address. 

• restore the access point settings to factory defaults. For help, see the 
online help and “Restoring the Access Point to the Default 
Configuration” in Chapter 8. 

• recover a failed access point. For help, see the online help and 
“Recovering a Failed Access Point” in Chapter 8. 
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• upgrade the access point software. For help, see the online help and 
“Upgrading the Access Points” in Chapter 8. 

After you configure the IP address, you can use a web browser or a telnet 
session to complete the configuration.  

To use the MobileLAN access Utility, you must have the following: 

• Windows 95-OSR2/98SE/ME, Windows NT4.0/2000/XP 

• Access points with software release 1.61 or later 

 
Note: You need to install the MobileLAN access Utility on a PC that is on 
the same IP subnet as the access point. Or, you can install it on a PC that 
is communicating wirelessly (configured to Intermec’s default radio 
settings) to the access point. Before you use the utility, you must have an 
active radio connection. 

To use the MobileLAN access Utility 

 

You must use the appropriate Intermec power supply with these 
devices or equipment damage may occur. 

Attention: Vous devez utiliser la source d’alimentation Intermec 
adéquate avec cet appareil sinon vous risquez d’endommager 
l’équipement. 

1 Insert the MobileLAN access Tools CD into your PC’s CD-ROM 
drive. The CD starts automatically and you will see the CD home page. 
Click Install the MobileLAN access Utility. If you do not see the 
home page, from the Start menu, choose Run. In the Open field, type 
X:\INDEX.HTM, where X is the CD-ROM drive. 

Or, use a web browser to navigate to http://www.intermec.com. From 
the Service & Support menu, click Downloads. Choose Wireless: 
MobileLAN access Utility to download the MobileLAN access Utility. 

2 Follow the instructions that appear on your screen to install the utility. 

3 Start the utility. The MobileLAN access Utility main screen appears. 
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4 In the Select Task field, choose Set IP Address. 

5 In the New IP Address field, enter the IP address. 

6 In the Ethernet MAC Address field, enter the MAC address of the 
access point. This address is located on the bottom of the access point. 

7 Connect the access point to power. The access point has no On/Off 
switch, so it boots as soon as you apply power. 

8 Immediately click Set. The Status box lets you know when the IP 
address has been set. 

9 To continue configuring the access point using a web browser, from the 
Actions menu choose Configure Access Point, and then enter the new 
IP address of this access point. 

Or, to close the utility, from the File menu choose Exit. 

For more help using the utility, from the Help menu choose Contents.  

You are now ready to install the access point in your network. See 
Chapter 2, “Installing the Access Points.” 

Using a Communications Program 
You can use a communications program (such as HyperTerminal) to set 
the initial IP address for the access point. After you configure the IP 
address, you can continue to use the communications program to set other 
parameters or you can use a web browser or a telnet session to complete 
the configuration.  

To use a communications program, you must have 

• a terminal or PC with an open serial port and the communications 
program. 

• an RS-232 null-modem cable. One end of this cable must be a 9-pin 
socket connector to connect to the serial port on the access point. 
Intermec offers a 9-socket to 9-socket null-modem cable (P/N 059167). 
To order this cable, contact your local Intermec representative. 

To use a communications program 

 

You must use the appropriate Intermec power supply with these 
devices or equipment damage may occur. 

Attention: Vous devez utiliser la source d’alimentation Intermec 
adéquate avec cet appareil sinon vous risquez d’endommager 
l’équipement. 

1 Use the RS-232 null-modem cable to connect the serial port on the 
access point to a serial port on your PC. You may need to remove the 
serial port plug. 



Chapter 1 — Getting Started 

32 MobileLAN access System Manual 

2 Start the communications program and configure the serial port 
communications parameters on your PC, and then click OK. You 
should configure the serial port communications parameters to: 

Bits per second 115200 
Data bits 8 
Parity None 
Stop bit 1 
Flow control None 
  

3 Connect the access point to power. The access point has no On/Off 
switch, so it boots as soon as you apply power. 

4 Press Enter when the message “Starting system” appears on your 
PC screen. The Username field appears. 

   

5 In the Username field type the default username Intermec, and then 
press Enter. 

6 In the Password field type the default password Intermec, and then 
press Enter. The Access Point Configuration menu appears. 
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7 If you are not using a DHCP server, you need to manually assign an IP 
address. Configure these parameters in the TCP/IP Settings menu: 

IP Address A unique IP address. 

IP Subnet Mask The subnet mask that matches the other devices in your 
network. 

IP Router 
(Gateway)  

If the access point will communicate with devices on another 
subnet, enter the address of the router that will forward 
frames. 

  

Or, if you are using a DHCP server to automatically assign an IP 
address to your access point, configure these parameters in the TCP/IP 
Settings menu: 

DHCP Mode Set to <Use DHCP if IP Address is Zero>. 

DHCP Server 
Name 

The name of the DHCP server that the access point is to 
access for automatic address assignment. If no server name is 
specified, the access point responds to offers from any server. 

  

8 Press Esc to return to the Access Point Configuration menu. 

9 Choose Save Configuration. 

10 Choose Reboot. 

When the access point is done rebooting, you are ready to install the access 
point in your network. See Chapter 2, “Installing the Access Points.” 
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Using a Web Browser Interface 
After you have set the initial IP address, you can configure, manage, and 
troubleshoot the access point from a remote location using a web browser 
interface. The web browser interface has been tested using Internet 
Explorer v3.0 and later and Netscape Communicator v4.0 and later. 
Remotely accessing the access point using other browsers may provide 
unpredictable results. 

Only one session can be active with the access point at a time. If your 
session terminates abruptly or a new login screen appears, someone else 
may have accessed the access point. When using the web browser interface, 
keep the following points in mind: 

• Your session terminates if you do not use it for 15 minutes. 

• Command Console mode is not available.  

 
Note: If you access the Internet using a proxy server, you must add the IP 
address of the access point to your Exceptions list. The Exceptions list 
contains the addresses that you do not want to use with a proxy server. 

To use a web browser interface 

1 Determine the IP address of the access point. If a DHCP server assigned 
the IP address, you must get the IP address from the DHCP server. 

2 Start the web browser application. 

3 Access the access point using one of these methods: 

• In the Address field (Internet Explorer) or in the Location field 
(Netscape Communicator), enter the IP address, and press Enter. 

• From the File menu, choose Open (Internet Explorer) or choose 
Open Page (Netscape Communicator). In the field, enter the IP 
address and press Enter. 

The Access Point Login screen appears.  
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4 If necessary, enter a user name and a password. The default username is 
Intermec and the default password is Intermec. You can define a user 
name and password. For help, see “Setting Up Logins” in Chapter 6. 

Or, you may want to log in to a secure session.  

5 Click Login. The TCP/IP Settings screen appears.  

   

Your web browser session is established. 

 
Note: Although you can use several different methods to manage the 
access point remotely, this manual assumes you are using a web browser. 

Using a Telnet Session 
After you have configured the IP address, you can configure, manage, and 
troubleshoot the access point from a remote location using a telnet session. 

Only one session can be active with the access point at a time. If your 
session terminates abruptly or a new login screen appears, someone else 
may have accessed the access point. Also, your session terminates if you do 
not use it for 15 minutes. 

To use a telnet session 

1 Determine the IP address of the access point. If a DHCP server assigned 
the IP address, you must get the IP address from the DHCP server. 

2 From a command prompt, type 

 telnet IPaddress 

where IPaddress is the IP address of the access point. 

3 Press Enter. 
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4 If necessary, enter the user name and press Enter. Then, enter the 
password and press Enter. The default username is Intermec and the 
default password is Intermec. You can define a user name and password. 
For help, see “Setting Up Logins” in Chapter 6. 

The Access Point Configuration menu appears. 

   

Your telnet session is established. 

Saving Configuration Changes 
When you are done configuring the access point, you may want to activate 
your changes immediately or you may want to save the changes now and 
activate them later. If you choose to activate the changes later, they will 
become active the next time the access point is booted. 

Access Point Configuration Files 

Configuration File Description 

Default This configuration file is the factory default configuration. 
For help, see “Restoring the Access Point to the Default 
Configuration” in Chapter 8. 

Current When you click Submit Changes, the access point updates 
the current configuration file. The access point does not 
change the active configuration file. You can see a list of 
pending changes when you click Save/Discard Changes. 
Having separate files for the current and active configurations 
lets you make changes while the access point is running 
without interrupting communication. 

Active When you click Save/Discard Changes > Save Changes and 
Reboot, the access point copies the current configuration file 
to the active configuration file. The active configuration file is 
the file that the access point uses. 
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Using a Web Browser Interface 
1 On the menu bar, click Save/Discard Changes.  

   

This screen appears.  

  

2 Verify that all your configuration changes appear in the Pending 
Changes box. 

3 Click Save Changes and Reboot to reboot the access point and 
immediately use your new active configuration. 

Or, click Save Changes without Reboot. The access point saves the 
changes to its current configuration and continues to run its active 
configuration. You will need to reboot the access point when you want 
the current configuration to become the active configuration. 

To discard the changes 

• Click Discard Pending Changes. 

Using a Telnet Session 
1 From the Access Point Configuration menu, choose Save 

Configuration.  

2 Choose Reboot to reboot the access point and immediately use your 
new active configuration. 

Click to use your new 
configuration now. 

Click to use your 
new configuration 
the next time you 
reboot the access 
point. 

Lists configuration 
changes you have 
made. 

Lists possible 
configuration changes 
you may still need to 
make. 
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Installing the Access Points 

This chapter explains how to install the MobileLAN access products in 
your data collection network, provides some tips on how to position access 
points to improve your network performance, and provides some external 
antenna guidelines. This chapter covers these topics: 

• Installation guidelines 

• Installing the access points 

• Connecting to your fiber optic network 

• Connecting power over Ethernet 

• External antenna placement guidelines 

2 
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Installation Guidelines 
Intermec recommends that you have Intermec-certified RF specialist 
conduct a site survey to determine the ideal locations for all your Intermec 
wireless network devices. To conduct a proper site survey, you need to 
have special equipment and training.  

The following general practices should be followed in any installation: 

• Locate access points centrally within areas requiring coverage. 

• Overlap access point radio coverage areas to avoid coverage holes. 

• Position the access point so that its LEDs are visible. The LEDs are 
useful for troubleshooting. 

• Install wired LAN cabling within node limit and cable length 
limitations. 

• Use an uninterruptible power supply (UPS) when AC power is not 
reliable. 

Proper antenna placement can help improve range. For information about 
antenna options, contact your local Intermec representative. For more 
guidelines, see “External Antenna Placement Guidelines” on page 54. 

When determining ideal locations for the access points, be aware that you 
may see network performance degradation from microwave ovens, cordless 
telephones, and other access points. For more information, see the next 
sections. 

 
Note: Microwave ovens, cordless telephones, and other access points do 
not degrade the network performance of the 802.11a radio. 

Microwave Ovens 
Microwave ovens operate in the same frequency band as 802.11b and 
OpenAir radios; therefore, if you use a microwave oven within range of 
your wireless network, you may notice network performance degradation. 
Both your microwave oven and your wireless network will continue to 
function, but you may want to consider relocating your microwave oven 
out of range of your access point. 

For the 802.11b radio, the access point has a Microwave Oven Robustness 
parameter that you can enable to minimize potential interference between 
your microwave oven and your wireless network. For help, see 
“Configuring 802.11b Radio Advanced Parameters” in Chapter 4. 
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Cordless Telephones 
If you have an 802.11b, OpenAir, or 902 MHz radio in your access point, 
the radio may experience interference from some cordless telephones. For 
optimal performance, consider operating cordless telephones out of range 
of your access points. 

Other Access Points 
Access points that are configured for the same frequency and that are in 
the same radio coverage area may interfere with each other and decrease 
throughput. You can reduce the chance of interference by configuring 
access points at least 5 channels apart, such as channels 1, 6, and 11. 

Installing the WA22 
You can place the WA22 horizontally on a desk or counter. The WA22 
also ships with a mounting bracket that lets you mount it vertically to a 
wall. Additional mounting options that you can use with the mounting 
bracket include a cubicle bracket that lets you mount the WA22 on a 
cubicle wall or in a locking bracket.  

• Cubicle bracket kit (P/N 069926) 

• Locking bracket kit (P/N 070184) 

To order one of these kits, contact your Intermec representative. Intermec 
also offers a variety of antennas and antenna accessories. For more 
information, see “Antennas and Antenna Accessories” in Appendix A. 

To install the WA22 

1 Attach the antenna or antennas. For more information, see “External 
Antenna Placement Guidelines” on page 54. 

 
Note: If the WA22 has an 802.11a full-range radio, you must use the 
antennas that are already attached to the antenna connectors. 

2 Mount the WA22. For help see the MobileLAN access WA22 Quick Start 
Guide and the instructions that shipped with the bracket kit. 

3 Connect the WA22 to your wired LAN (unless you are using it as a 
WAP). For help, see “Connecting the WA22 to Your Wired LAN and 
Power” on page 42. 

4 Connect the WA22 to power. For help, see “Connecting the WA22 to 
Your Wired LAN and Power” on page 42. 

When you are done installing the access points, you need to configure 
them to communicate with your network.  
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Connecting the WA22 to Your Wired LAN and Power 
Unless you are using the WA22 as a WAP, you must connect it to your 
Ethernet or fiber optic network. To connect the WA22 to your fiber optic 
network, you must have a WA22 with the fiber optic option. For help, see 
“Connecting to Your Fiber Optic Network” on page 50. 

To connect the WA22 to your Ethernet network and to power, you must 
first connect it to a MobileLAN power bridge, a Cisco power bridge, or 
another 802.3af-power bridge. For help, see “Connecting Power Over 
Ethernet” on page 53 and the documentation that shipped with your 
power bridge. 

Installing the 2101 
You can place the 2101 horizontally on a desk or counter. The 2101 also 
ships with a mounting bracket that lets you mount it vertically to a wall.  

Additional mounting options include a desk bracket that lets you mount 
the 2101 upright on a desk or counter, a cubicle bracket that lets you 
mount the 2101 on a cubicle wall, and a locking bracket. These optional 
mounting brackets and accessories are available: 

• Desk bracket kit (P/N 069657) 

• Cubicle bracket kit (P/N 069926) 

• Locking bracket kit (P/N 070184) 

• Dual antenna bracket kit (P/N 069888) 

• Power supply holder kit (P/N 069893) 

To order one of these kits, contact your Intermec representative. To 
mount the 2101, follow the instructions in the kit. Intermec offers a 
variety of antennas and antenna accessories. For more information, see 
“Antennas and Antenna Accessories” in Appendix A. 

To install the 2101 

1 Attach the antenna or antennas. If you attach only one antenna to the 
802.11b radio, you must attach it to the | (send/receive) port. For more 
information, see “External Antenna Placement Guidelines” on page 54. 

2 Mount the 2101. For help see the MobileLAN access 2101 Quick Start 
Guide and the instructions that shipped with the bracket kit. 

3 Connect the 2101 to your wired LAN (unless you are using it as a 
WAP). For help, see “Connecting the 2101 to Your Wired LAN” on 
page 43. 

4 Connect the 2101 to power. For help, see “Connecting the 2101 to 
Power” on page 43. 
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When you are done installing the access points, you need to configure 
them to communicate with your network. 

Connecting the 2101 to Your Wired LAN 
Unless you are using the 2101 as a WAP, you must connect it to your 
Ethernet or fiber optic network. To connect the 2101 to your fiber optic 
network, you must have a 2101 with the fiber optic option. For help, see 
“Connecting to Your Fiber Optic Network” on page 50. 

To connect the 2101 to your Ethernet network 

• Attach one end of the Ethernet cable to the 10BaseT/100BaseTx port 
on the 2101, and attach the other end to your Ethernet network or a 
MobileLAN splitter (if you are using the power over Ethernet option). 

Connecting the 2101 to Power 
You use a power supply and power cord to connect the 2101 directly to an 
AC power outlet.  

If you are using the power over Ethernet option, you must have the 
MobileLAN power splitter and the MobileLAN power bridge. For help, 
see “Connecting Power Over Ethernet” on page 53 and the 
documentation that shipped with your splitter and power bridge. 

To connect the 2101 to power 

 

You must use the appropriate Intermec power supply with this device 
or equipment damage may occur. 

Attention: Vous devez utiliser la source d’alimentation Intermec 
adéquate avec cet appareil sinon vous risquez endommager 
l’équipement. 

1 Plug one end of the power supply into the power port on the 2101. 

2 Plug one end of the power cord into the power supply and the other 
end into an AC power outlet.  

The access point boots as soon as you apply power. 
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Installing the WA21 
You can place the WA21 horizontally or vertically on a desk or counter. If 
you want to mount the WA21 to a wall or beam using an Intermec 
mounting bracket kit, you need one of these mounting kits:  

• Mounting bracket kit (P/N 068918) 

• Rotating mounting bracket kit (P/N 068751) 

To order one of these kits, contact your Intermec representative.  

To maintain the IP54 environmental rating, you must mount the WA21 
in either the horizontal or vertical position. If you order the WA21 with 
the heater option, you must use one of the mounting bracket kits to 
mount the WA21 with the LEDs facing down. 

A variety of external antenna options are available for the WA21. Contact 
your Intermec representative for information about the various antenna 
options, including higher gain and directional antennas. For more 
information about antennas and antenna accessories, see “Antennas and 
Antenna Accessories” in Appendix A. 

To install the WA21 

1 Attach the antenna or antennas. For more information, see “External 
Antenna Placement Guidelines” on page 54. 

 
Note: If the WA21 has an 802.11a full-range radio, you must use the 
antennas that are already attached to the antenna connectors. 

2 Mount the WA21. For help see the MobileLAN access WA21 Quick Start 
Guide and the instructions that shipped with the bracket kit. 

3 Connect the WA21 to your wired LAN (unless you are using it as a 
WAP). For help, see “Connecting the WA21 to Your Wired LAN” on 
page 45. 

4 Connect the WA21 to power. For help, see “Connecting the WA21 to 
Power” on page 45. 

When you are done installing the access points, you need to configure 
them to communicate with your network. 
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Connecting the WA21 to Your Wired LAN 
Unless you are using the WA21 as a WAP, you need to connect it to your 
Ethernet or fiber optic network. To connect the WA21 to your fiber optic 
network, you must have a WA21 with the fiber optic option. For help, see 
“Connecting to Your Fiber Optic Network” on page 50. 

To connect the WA21 to the Ethernet network 

• Attach one end of the Ethernet cable to the 10BaseT/100BaseTx port 
on the WA21 and attach the other end to your Ethernet network or a 
MobileLAN power bridge (if you are using power over Ethernet), a 
Cisco power bridge or another 802.3af-compliant power bridge. 

Connecting the WA21 to Power 
If your WA21 has the internal power supply option, you can use a power 
cord to connect the WA21 directly to an AC power outlet. 

If you are using the power over Ethernet option, you must have the 
MobileLAN power bridge, a Cisco power bridge, or another 802.3af-
power bridge. For help, see “Connecting Power Over Ethernet” on page 
53 and the documentation that came with your power bridge. 

To connect the WA21 to power 

• Plug one end of the power cord into the power port on the WA21 and 
plug the other end into an AC power outlet. The access point boots as 
soon as you apply power. 

Installing the 2100 
You can place the 2100 horizontally or vertically on a desk or counter. If 
you want to mount the 2100 to a wall or beam using an Intermec 
mounting bracket kit, you need one of these mounting kits:  

• Mounting bracket kit (P/N 068918) 

• Rotating mounting bracket kit (P/N 068751) 

To order one of these kits, contact your Intermec representative.  

To maintain the IP54 environmental rating, you must mount the 2100 in 
either the horizontal or vertical position. If you order the 2100 with the 
heater option, you must use one of the mounting bracket kits to mount 
the WA21 with the LEDs facing down. 

A variety of external antenna options are available for the 2100. Contact 
your Intermec representative for information about the various antenna 
options, including higher gain and directional antennas. For more 
information about antennas and antenna accessories, see “Antennas and 
Antenna Accessories” in Appendix A. 
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To install the 2100 

1 Attach the antenna or antennas. For more information, see “External 
Antenna Placement Guidelines” on page 54. 

2 Mount the 2100. For help see the MobileLAN access 2100 Quick Start 
Guide and the instructions that shipped with the bracket kit. 

3 Connect the 2100 to your wired LAN (unless you are using it as a 
WAP). For help, see “Connecting the 2100 to Your Wired LAN” in the 
next section. 

4 Connect the 2100 to power. For help, see “Connecting the 2100 to 
Power” later in this chapter. 

When you are done installing the access points, you need to configure 
them to communicate with your network. 

Connecting the 2100 to Your Wired LAN 
Unless you are using the 2100 as a WAP, you need to connect it to your 
Ethernet or fiber optic network. To connect the 2100 to your fiber optic 
network, you must have a 2100 with the fiber optic option. For help, see 
“Connecting to Your Fiber Optic Network” on page 50. 

To connect the 2100 to the Ethernet network 

• Attach one end of the Ethernet cable to the 10BaseT/100BaseTx port 
on the 2100 and attach the other end to your Ethernet network. 

Connecting the 2100 to Power 
You use a power cord to connect the 2100 directly to an AC power outlet.  

To connect the 2100 to power 

• Plug one end of the power cord into the power port on the 2100 and 
plug the other end into an AC power outlet. The access point boots as 
soon as you apply power. 
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Installing the 2102/2106 
You can install the 2102 or the 2106 horizontally on a desk or counter, or 
you can install it vertically to a wall using the mounting bracket that ships 
with it. An optional cubicle bracket is also available for mounting the 2102 
or the 2106 on a cubicle wall. These optional mounting bracket kits and 
accessories are available for the 2102 or the 2106: 

• Cubicle bracket kit (P/N 070366) 

• Power supply holder kit (P/N 069893) 

This optional mounting bracket kit is available for the 2102: 

• Dual antenna bracket kit (P/N 069888) 

Intermec also offers a variety of antennas and antenna accessories, 
including diversity antennas. For more information, see “Antennas and 
Antenna Accessories” in Appendix A. Contact your Intermec 
representative for more information about ordering access point 
accessories.  

To install the 2102 or 2106 

1 Mount the 2102 or 2106. For help see the MobileLAN access 2102 
Quick Start Guide or the MobileLAN access 2106 Quick Start Guide and 
the instructions that shipped with your bracket kit. 

2 Position or install the antenna. For help, see “Positioning the Standard 
Antenna” or “Attaching an External Antenna (2102)” on pages 47-48. 

3 Connect the 2102 or 2106 to your wired LAN (unless you are using it 
as a WAP). For help, see “Connecting the 2102 or 2106 to Your 
Ethernet Network” on page 49. 

4 Connect the 2102 or 2106 to power. For help, see “Connecting the 
2102 or 2106 to Power” on page 49. 

When you are done installing the access points, you need to configure 
them to communicate with your network. 

Positioning the Standard Antenna 
The 2102 and the 2106 feature a built-in standard antenna that rotates 
180° as shown in the next illustration. Use these guidelines when 
positioning the antenna. 

 
Note: Do not force the antenna past the hard stop at 0° or 180° or you 
may break the antenna connector. 

• Place the antenna at 0° when storing the 2102 or the 2106. 

• Place the antenna at 90° when using the 2102 or the 2106 horizontally; 
for example, when the 2102 is positioned on a desk or counter. 
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• Place the antenna at 180° when using the 2102 or the 2106 vertically; 
for example, when it is mounted on a wall or cubicle. 

  
2102G015.eps

90°

180°

0°

 

Antenna positions on the 2102 and 2106: This illustration shows the different ways 
that you can position the antenna on the 2102 and 2106. 

Attaching an External Antenna (2102) 
To attach an external antenna to the 2102, you must first disconnect the 
built-in antenna, and then attach an antenna cable directly to the radio 
card. You need this tool: 

• Needle-nose pliers 

To attach an external antenna 

1 Remove the radio card door. 

2 Pull straight up on the antenna wire to disconnect it from the radio 
card. 

  

Door

Antenna
wire

21XXT010.eps  
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3 Tuck the antenna wire inside the 2102 housing. 

4 Remove the punch-out tab from the door. 

  

Punch-out 
tab

Pliers

Door

21XXT009.eps  

5 Attach the antenna cable to the radio by inserting the cable connector 
into the radio card. 

6 Replace the door. 

Connecting the 2102 or 2106 to Your Ethernet Network 
If you purchased the MobileLAN power splitter and the MobileLAN 
power bridge so that you can use power over Ethernet, see “Connecting 
Power Over Ethernet” on page 53. 

To connect the 2102 or the 2106 to your Ethernet network 

• (2102) Attach one end of the 10BaseT cable to the 10BaseT port on the 
2102, and attach the other end to your Ethernet network.  

(2106) Attach one end of the Ethernet cable to the 10BaseT/100BaseTx 
port on the 2106 and attach the other end to your Ethernet network. 

Connecting the 2102 or 2106 to Power 
You use a power supply and power cord to connect the 2102 or the 2106 
directly to an AC power outlet.  

If you are using the power over Ethernet option, you must have the 
MobileLAN power splitter and the MobileLAN power bridge. For help, 
see “Connecting Power Over Ethernet” on page 53 and the 
documentation that shipped with your splitter and power bridge. 

 
Note: The 2102 and 2106 use different power cords. 
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To connect the 2102 or the 2106 to power 

 

You must use the appropriate Intermec power supply with this device 
or equipment damage may occur. 

Attention: Vous devez utiliser la source d’alimentation Intermec 
adéquate avec cet appareil sinon vous risquez endommager 
l’équipement. 

1 Plug one end of the power supply into the power port on the 2102 or 
the 2106. 

2 Plug one end of the power cord into the power supply and plug the 
other end into an AC power outlet.  

The access point boots as soon as you apply power. 

Connecting to Your Fiber Optic Network 
You can order your WA22, 2101, WA21, or 2100 access points with a 
fiber optic option. To connect the access point with the fiber optic option 
to your fiber optic network, you must have a patch cord and an adapter. 
Patch cords and adapters are available from many different manufacturers. 
Using adapters and patch cords, you can connect your access point to: 

• an MT-RJ network. 

• a square connector (SC) network. 

• a straight tip (ST) network. 

For help choosing the proper cord and adapter, contact your local 
Intermec representative. 

 
Note: All cables must be multimode, 62.5/125 µm. 

Connecting to an MT-RJ Network 
To connect to an MT-RJ network, you need: 

• a patch cord for connecting the MT-RJ transceiver to the MT-RJ 
adapter. 

• an adapter for connecting an MT-RJ cord to an MT-RJ network. 
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To connect to an MT-RJ network 

1 Remove any cable protectors attached to the patch cord and adapter. 

2 Connect the access point to your network. 

21XXU039.eps
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Connecting to an SC Network 
To connect to an SC network, you need: 

• a patch cord for connecting the MT-RJ transceiver to the SC adapter. 

• an adapter for connecting an SC cord to an SC network. 

To connect to an SC network 

1 Remove any cable protectors attached to the patch cord and adapter. 

2 Connect the access point to your network as shown in the next 
illustrations. 
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Connecting to an ST Network 
To connect to an ST network, you need: 

• a patch cord for connecting the MT-RJ transceiver to the ST adapter. 

• an adapter for connecting an ST cord to an ST network. 

To connect to an ST network 

1 Remove any cable protectors attached to the patch cord and adapter. 

2 Connect the access point to your network. 
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Connecting Power Over Ethernet 
The WA22 is powered by power over Ethernet. The WA21 can be 
powered by AC power or by power over Ethernet or both. You can power 
the 2101, 2102, or 2106 using power over Ethernet if you connect them 
to a MobileLAN splitter. For all access points, you need a power bridge.  

You order the splitter and the power bridges as accessories: 

• (2101, 2102) MobileLAN power splitter, 5 VDC (P/N 071581) 

• (2106) MobileLAN power splitter, 3.3 VDC (P/N 072158) 

For a list of the power bridges that Intermec sells, contact your local 
Intermec representative. 

You connect the splitter to the power bridge using a typical Ethernet cable 
(CAT5). In this cable, four twisted pair lines are used for data and four are 
unused. Using the data lines, data simply passes through the splitter. Using 
the unused lines, the splitter receives power from the power bridge, which 
it converts to the input voltage required by the access point (5 VDC or 
3.3 VDC). An LED on the splitter lights when power is being supplied to 
the access point.  
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Connecting 2101 using power over Ethernet: This illustration shows how you 
connect the 2101 to the MobileLAN splitter and a power bridge so that you can run 
power over Ethernet. 
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To connect power over Ethernet 

1 Install the power bridges. For help, see the documentation that shipped 
with the power bridge. 

2 (2101, 2102, 2106) Connect the splitter to the Ethernet port and to the 
power port of the access point. 

3 (2101, 2102, 2106) Use an Ethernet cable to connect the splitter to the 
power bridge. 

(WA22, WA21) Use an Ethernet cable to connect the power bridge to 
the Ethernet port of the access point. 

External Antenna Placement Guidelines 
Antennas and their placement play a vital role when installing a wireless 
network. Every wireless network environment presents its own unique 
obstacles. Therefore, the exact range that you will achieve with each access 
point is difficult to determine. Intermec recommends that you allow an 
Intermec-certified RF specialist to perform a site survey before you install a 
wireless network. For more information, contact your local Intermec 
representative. 

Radio signals may reflect off some obstacles and be absorbed by others. For 
example, two radios may achieve up to 305 m (1,000 ft) of range if 
positioned outdoors within line of sight, with no obstacles between them. 
However, the same two radios may only achieve 152 m (500 ft) of range 
when the RF signal has to travel through items such as cubicles. If the 
signal must penetrate office walls, the signal range may decrease to 91 m 
(300 ft). 

Using the proper antennas for your environment and placing them in the 
proper areas can help improve range. For information about antenna 
options, contact your local Intermec representative. Here are some general 
guidelines for positioning antennas: 

• Place the antenna as high as possible. In an office environment, try to 
place it above cubicle walls.  

• Do not place a sheet of metal (such as a filing cabinet) between two 
antennas.  

These next sections provide detailed information about antenna placement 
for those access points that can have more than one antenna. 
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Positioning Antennas for 802.11b and 802.11a Radios 
The 802.11b radios have two ports: one is a transmit/receive port and the 
other is a receive-only port. The 802.11a radios have two ports; both ports 
are transmit/receive ports. Intermec recommends that you use two 
antennas for optimal performance of the 802.11b and 802.11a radios. If 
you only attach one antenna to the 802.11b radio, you must attach it to 
the transmit/receive port.  

On the WA22 and the WA21, use antenna connectors 1 and 2 or 3 and 4 
to attach antennas to the send/receive ports. On the 2100, use antenna 
connectors 1 and 3 or 2 and 4 to attach antennas to the send/receive ports. 
On the 2101 and 2102, both antenna ports are visible. The antenna ports 
are marked | and ||. Port | is the transmit/receive port; port || is the receive-
only port.  

 
Note: The antenna diversity system uses only one antenna at a time. 

Positioning Antennas for Antenna Diversity 
Antenna diversity lets you attach two antennas to one radio to increase the 
odds of receiving a better signal on either of the antennas. The 802.11b 
radio and the 802.11a radio feature antenna diversity. If you are using 
antenna diversity, placement of the antennas is critical because each 
antenna has a particular function. Antennas placed too close together may 
cause interference with each other. Antennas placed too far apart may not 
be able to establish two-way communications with other radios.  

To achieve optimum placement for the two antennas, you must place the 
transmit/receive antenna so that it is within range of all the radios that the 
receive-only antenna can hear. Note these important points: 

• Use external antennas to achieve the recommended antenna separation 
for placement of either omni or directional antennas. 

• Position omni antennas for the 802.11b or the 802.11a radio at least 
0.61 m (2 ft) apart.  

• Position directional antennas so they point in the same direction. 

• Position the antennas so that both antennas are within range of the 
radios they need to communicate with.  

• Do not position the two antennas around a corner or so that a wall is 
between them. 

• Follow the recommended antenna separation precisely when using the 
closest distances. Movement of as little as 3.05 cm (1.2 in) may strongly 
affect performance. You should choose the greatest distance possible 
within the constraints of your environment.  
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Recommended Antenna Separation for Antenna Diversity 

Location Recommended Antenna Separation 

Highly reflective warehouse 
environment  

0.33 m (13 in) or 0.64 m (25 in) 

Moderately reflective warehouse 
environment 

0.64 m (25 in), 1.22 m (4 ft), or 1.83 m (6 ft) 

Open/Office environment 1.22 m (4 ft) to 3.05 m (10 ft) 

  

Positioning Antennas for Dual Radio Access Points 
These recommendations apply to omni antennas; if you are using 
directional antennas, you should increase the recommended separation 
between the antennas: 

• If your access point has two 802.11b or two 802.11a radios, position 
the antennas for one radio at least 3.05 m (10 ft) from the antennas for 
the other radio.  

• If your access point has at least one 802.11b or one 802.11a radio (the 
other radio may be any radio), cable the antennas for the 802.11b or 
802.11a radio at least 3.05 m (10 ft) from the access point.  

• If your access point has an 802.11b radio and an 802.11a full-range 
radio, cable the antennas for the 802.11b at least 3.05 m (10 ft) from 
the access point. 

• If your access point has an 802.11b radio and an 802.11a mid-range 
radio, cable the antennas for either the 802.11b radio or the 802.11a 
radio at least 3.05 m (10 ft) from the access point. 

Positioning Antennas for an OpenAir WAP 
For OpenAir WAPs, you must use external antennas and position them at 
the recommended distances for proper functioning. There are two types of 
Intermec-recommended antennas you can use:  

• Omni 

• Directional 

You can position the antennas in one of three ways: 

• Horizontal. Both antennas are mounted in the same plane (at the same 
height).  

• Stacked. One antenna is mounted directly above the other.  

• Angled. The two antennas are mounted some distance apart and at 
different heights. 
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You can use two omni antennas, two directional antennas or you can use 
one omni antenna and one directional antenna. The following table shows 
the minimum distance that must exist between the two antennas. 

Recommended Antenna Separation for an OpenAir WAP 

Position 2 Omni Antennas 2 Directional Antennas 1 Omni, 1 Directional Antenna 

Horizontal 3dBi omni, 3 m (10 ft) 

6dBi omni, 6.1 m (20 ft) 

9dBi omni, 12.2 m (40 ft) 

3 m (10 ft) 6.1 m (20 ft) 

Stacked 0.6 m (2 ft) (does not apply) 0.6 m (2 ft) 

Angled 1.1 m (3.5 ft) vertically and
7.3 m (24 ft) horizontally 

0.6 m (2 ft) vertically and 
3 m (10 ft) horizontally 

0.6 m (2 ft) vertically and 
6.1 m (20 ft) horizontally 

Mounting Mount so antennas point 
down 

Mount antennas back-to-
back. 

If antennas are not stacked, mount 
the directional antenna pointing 
away from the omni antenna. 

If the antennas are stacked, mount 
the directional antenna above the 
omni antenna. 
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Configuring the Ethernet 
Network 

This chapter explains how to configure the MobileLAN access products so 
that they communicate with your Ethernet network. This chapter explains: 

• Configuring TCP/IP settings 

• Configuring other Ethernet or fiber optic settings 

• Configuring Ethernet filters 

3 
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Configuring the TCP/IP Settings 
If you are using a DHCP server to automatically assign an IP address to 
the access point, go to “Configuring the Access Point as a DHCP Client” 
on page 61. If you are not using a DHCP server, you need to manually 
assign some TCP/IP parameters.  

 
Note: You should have already configured an IP address for the access 
point. For help, see “Configuring the Access Point (Setting the IP 
Address)” in Chapter 1. 

To configure the TCP/IP settings 

1 From the menu, click TCP/IP Settings. The TCP/IP Settings screen 
appears. 

   

2 Configure the TCP/IP settings. For help, see the next table. 

3 If you want to configure the access point as a DHCP server, see 
“Configuring the Access Point as a DHCP Server” on page 62. 

4 If you want to configure the access point as a NAT server, see “About 
Network Address Translation (NAT)” on page 65. 

5 If you want to configure the access point to send ARP requests, see 
“Configuring the Access Point to Send ARP Requests” on page 66. 

6 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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TCP/IP Settings Descriptions 

Parameter Explanation 

IP Address Enter the IP address of the access point. The IP address has the form 
x.x.x.x, where x is a number from 0 to 255. 

IP Subnet Mask Enter the subnet mask that matches the other devices in your 
network. The subnet mask has the form x.x.x.x, where x is a number 
from 0 to 255. 

IP Router 
(Gateway) 

Enter the IP address of the router that will forward frames if the 
access point will communicate with devices on another subnet. The 
IP address has the form x.x.x.x, where x is a number from 0 to 255. 

DNS Address 1 Enter the IP address of a domain name server that the access point 
uses to resolve DNS names. If this access point is a DHCP server, this 
DNS address will be distributed to DHCP clients. You can enter up 
to two DNS addresses to be delivered to DHCP clients. 

DNS Address 2 Enter the IP address of a domain name server that the access point 
uses to resolve DNS names if the DNS server at DNS Address 1 is 
not responding. If this access point is a DHCP server, this DNS 
address will be distributed to DHCP clients. 

DNS Suffix 1 Enter a domain name suffix that will be appended to DNS names 
that cannot be resolved. If the access point is a DHCP server, this is 
the only DNS suffix that is delivered to DHCP clients. 

For example, enter a suffix of UVW.COM. When you try to resolve 
ABC, the DNS will look for ABC.UVW.COM.  

DNS Suffix 2 Enter a domain name suffix that will be appended to DNS names 
that cannot be resolved either by themselves or using DNS suffix 1. 

For example, enter a suffix of XYZ.COM. When you try to resolve 
ABC, the DNS will first look for ABC.UVW.COM and then it will 
look for ABC.XYZ.COM. 

  

Configuring the Access Point as a DHCP Client 
You can use a DHCP server to automatically assign an IP address and 
other TCP/IP settings to your access point; that is, the access point can act 
as a DHCP client. 

 
Note: You cannot configure the access point as both a DHCP server and a 
DHCP client. 

 
Note: If you are using the embedded authentication server feature, do not 
configure the access point as a DHCP client. 

To configure the access point as a DHCP client 

1 From the menu, click TCP/IP Settings. The TCP/IP Settings screen 
appears. 
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2 In the DHCP Mode field, choose either Always Use DHCP or Use 
DHCP if IP Address is Zero. If you choose Use DHCP if IP Address is 
Zero, make sure that the IP Address field is 0.0.0.0. 

3 In the DHCP Server Name field, enter the name of the DHCP server 
that the access point is to access for automatic address assignment. If no 
server name is specified, the access point responds to offers from any 
server.  

4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring the Access Point as a DHCP Server 
You can configure the access point as a simple DHCP server that provides 
DHCP server functions for small installations where no other DHCP 
server is available. The DHCP server will offer IP addresses and other 
TCP/IP settings to any DHCP client it hears as long as a pool of 
unallocated IP addresses is available. These clients may include other access 
points, wireless end devices, wired hosts on the distribution LAN, or wired 
hosts on secondary LANs. 

 
Note: If you configure the access point as a DHCP server, it is not 
intended to replace a general purpose, configurable DHCP server, and it 
makes no provisions for synchronizing DHCP policy between itself and 
other DHCP servers. Customers with complex DHCP policy 
requirements should use other DHCP server software. 

 
Note: You cannot configure the access point as both a DHCP server and a 
DHCP client. 
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To avoid a single point of failure, you can configure more than one access 
point to be a DHCP server; however, the access points do not share 
DHCP client databases. You should configure each DHCP server with a 
different address pool from which to allocate client IP addresses. 

To configure the access point as a DHCP server 

1 From the menu, click TCP/IP Settings. The TCP/IP Settings screen 
appears. 

   

2 Verify that the IP Address field, IP Subnet Mask field, and IP Router 
field are configured. For help, see “Configuring the TCP/IP Settings” 
on page 60. 

3 In the DHCP Mode field, choose This AP is a DHCP Server.  

4 In the DHCP Server Name field, enter the name for this access point 
as a DHCP server. 

5 Click Submit Changes to save your changes. 

6 Click DHCP Server Setup. The DHCP Server Setup screen appears. 
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7 Configure the DHCP server. For help, see the next table. 

8 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

DHCP Server Setup Parameter Descriptions 

Parameter Explanation 

Low Address Enter the low IP address in the range of IP addresses available to the 
DHCP server for distribution to DHCP clients.  

If these addresses are not on the same subnet as the access point, the 
access point will perform Network Address Translation (NAT) for 
the clients to which it grants IP addresses. 

High Address Enter the high IP address in the range of IP addresses available to 
the DHCP server for distribution to DHCP clients.  

If these addresses are not on the same subnet as the access point, the 
access point will perform Network Address Translation (NAT) for 
the clients to which it grants IP addresses. 

Lease Time Specifies the duration of the leases that are granted by the DHCP 
server. Enter the lease time in the format days:hours:minutes. 

If you set the lease time to 0, infinite leases are granted. 

  

Supported DHCP Server Options 
When the access point is acting as a DHCP server, it issues IP address 
leases to configure the IP address, along with the DNS addresses, DNS 
suffixes, IP subnet mask, and IP router. These parameters will contain the 
same values as those configured for the access point. 
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Unsupported DHCP Server Options 
When the access point is acting as a DHCP server, it does not support any 
DHCP options other than those listed. The DHCP server disregards any 
DHCP options that are not explicitly required by the DHCP specification. 
The DHCP server ignores all frames with a non-zero giaddr (gateway IP 
address). The DHCP server only responds to requests from its own subnet. 

About Network Address Translation (NAT) 
NAT allows IP addresses to be used by more than one end device. The 
access point can act as a NAT server, which instantaneously rewrites IP 
addresses and port numbers in IP headers so that frames all appear to be 
coming from (or going to) the single IP address of the access point instead 
of the actual source or destination.  

When an end device uses the access point as an IP router, the access point 
replaces the IP header, which includes the device MAC address, IP source 
address, and TCP/UDP port, with its own. You can configure the DHCP 
server to indicate that the access point is the IP router when the server 
allocates an IP address. Special consideration is given to changing the FTP 
data connection TCP port number, which is in the body of the TCP 
frame. After the frame source is modified, it is forwarded to the proper 
subnet. 

If the destination subnet is a different subnet from the one the access point 
is on, the destination MAC address is changed to the IP router that has 
been configured for the access point. If the destination subnet is the same 
subnet as the one the access point is on, the access point converts the MAC 
address to the MAC address that belongs to the destination IP address. 
This may involve using ARP for MAC address discovery. 

When the access point receives a frame with its IP address, it identifies the 
need for address translation by inspecting the destination port number. If 
the port number is within the pool reserved for NAT operation, it looks 
up the original MAC address, IP address, and port number. The frame is 
then modified and forwarded to the end device. 

NAT operation is disabled or enabled automatically depending on the 
continuous range of addresses you enter into the DHCP server. NAT is 
disabled if the range of addresses to be given to DHCP clients is on the 
same subnet as the access point. NAT is enabled if the range of addresses 
to be given to DHCP clients is not on the same subnet as the access point; 
thus, you are creating a virtual network and the DHCP server will also 
perform NAT translation. 

When NAT operation is enabled, the access point uses the low address in 
the range of addresses as its own. The DHCP/NAT clients also use this 
address as their router IP address. These clients can configure the access 
point using this internal IP address or the normal external IP address. 
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To configure the access point as a NAT server 

1 From the menu, click TCP/IP Settings. The TCP/IP Settings screen 
appears.  

2 Verify that the IP Address field and IP Subnet Mask field are 
configured. For help, see “Configuring the TCP/IP Settings” on page 
60. 

3 In the DHCP Mode field, choose This AP is a DHCP Server. 

4 Click Submit Changes to save your changes. 

5 Click DHCP Server Setup and enter a range of IP addresses that are 
not on the same subnet as the access point. 

6 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring the Access Point to Send ARP Requests 
ARP requests are multicast frames, which means they are sent to all devices 
on the Ethernet network. You can configure the access point to 
periodically send an unsolicited ARP request to the IP router so that all 
routers can update their routing tables. This ARP request lets a network 
management program learn about the access point on the network by 
querying routers. The auto ARP minutes parameter controls the time 
interval between ARP requests. 

If the address of the IP router is 0.0.0.0, then the access point sends an 
ARP request to its own IP address. Without this option, an access point 
might not use its IP address for extended periods of time and the IP 
address would expire from the router ARP table. If the IP address expires, 
the network management program must ping all potential addresses on a 
subnet to locate active IP addresses or require the user to enter a list. You 
should not let the IP address for the access point expire. 

To set the auto ARP period 

1 From the menu, click TCP/IP Settings. The TCP/IP Settings screen 
appears. 

2 In the Auto ARP Minutes field enter a time a period from 1 to 120 
minutes. To disable this parameter, set the time period to 0.  

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Configuring Other Ethernet or Fiber Optic Settings 
Many of the standard Ethernet or fiber optic settings are configured in the 
TCP/IP Settings screen. For help, see “Configuring the TCP/IP Settings” 
on page 60. In the Ethernet screen, you can: 

• set the port type. This field specifies the port that the access point uses 
to communicate with the Ethernet network. If you do not have a fiber 
optic port, you will not see this field. 

• set the link speed. This field specifies the speed and the duplex mode 
that the access point uses to communicate with the Ethernet network. If 
you chose the port type to be fiber optic, the link speed is automatically 
set to 100 Mbps Fiber Optic (full duplex). If you want the access point 
to auto-negotiate this field, choose Auto Select. Auto Select should work 
for most networks. 

• enable or disable the link status check. Check this check box if you want 
the access point to periodically check its Ethernet connection. If it loses 
the connection, this access point can no longer be the root access point 
and any end devices that are connected to this access point (whether or 
not it is the root) will roam to a different access point. The access point 
will attempt to reconnect to the spanning tree through one of its radio 
ports. Clear this check box if this access point must be the root access 
point or if it is used as a WAP. 

To configure the Ethernet or fiber optic settings 

1 From the menu, click Ethernet. The Ethernet screen appears. 

   

2 In the Port Type field, choose 10/100 Mb Twisted-Pair for Ethernet or 
100 Mb Fiber Optic. 

3 (10/100 Mb Twisted-Pair only) In the Link Speed field, choose the 
speed and duplex mode you want this port to use to communicate with 
the Ethernet or fiber optic network. 
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4 Check or clear the Enable Link Status Check check box. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring the Ethernet Address Table 
If you have a secondary LAN, you should configure the Ethernet address 
table in the designated bridge or WAP on the secondary LAN. This table 
contains all the MAC addresses on the secondary LAN that are 
communicating with the primary LAN. You must enter the MAC 
addresses of all devices on the secondary LAN that do not always initiate 
communication. 

If you choose not to configure this table, the designated bridge or WAP 
may need to flood frames to the Ethernet and radio ports to learn the path 
to the MAC address. 

These addresses become permanent entries in the forwarding table of the 
designated bridge or WAP.  

To configure the Ethernet address table 

1 From the main menu, click Ethernet, and then click Ethernet Filters. 

2 Click Address Table. The Address Table screen appears. 

   

3 Enter up to 20 MAC addresses. MAC addresses consist of six hex pairs 
that are separated by spaces, colons, or hyphens. 

4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Configuring Ethernet Filters 
You can set both Ethernet and IP tunnel filters, and you can create 
protocol filters for both predefined and user-defined protocol types. In 
addition, you can define arbitrary frame filters based on frame content. 
Setting Ethernet filters prevents the Ethernet port from sending out 
unnecessary traffic to the wireless network. 

Ethernet frame type filter and predefined subtype filter settings override 
customizable subtype filter settings. However, Intermec recommends that 
when creating customizable subtype filters, you do not duplicate existing 
frame type or predefined subtype filters or unexpected results may occur. 

For more examples of using Ethernet filters and for help configuring IP 
filters, see “Configuring IP Tunnel Filters” in Chapter 5. 

Using Ethernet Frame Type Filters 
You can define filters for common networking protocols such as IP, Novell 
IPX, and 802.2 LLC. You can also set filters that will pass only those 
Ethernet frame types found on your network.  

You can set the default action for general and specific frame types. For 
example, you can not pass the DIX-Other EtherTypes frame parameter, 
and then use the subtype menus to pass only those specific DIX types that 
are used in your radio network. 

You can also set the scope for general and specific frame types. For 
example, for DIX-IP-TCP ports, you can not pass all frame types. Then, 
all IP frames with the TCP type will be dropped even if specific TCP parts 
are set to pass in the subtype menus. 

Here is the action and scope you can set for each parameter: 

Allow/ 
Pass 

Check or clear this check box. Check the check box to pass all frames of that 
type. Clear the check box to drop all frames of that type. 

Scope Set scope to Unlisted or All. If you select All, then all frames of that type are 
unconditionally passed or dropped, depending on the action you specified. If 
you select Unlisted, then frames are passed or dropped only if the frame type 
is not listed in the predefined or customizable tables. 
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To set frame type filters 

1 From the main menu, click Ethernet > Frame Type Filters. The Frame 
Type Filters screen appears. 

   

2 For each frame type field, check or clear the check box to configure if 
the frame types are passed or are dropped. If you check the check box, 
the frame type is allowed to pass. 

For each frame type field, set the Scope field to Unlisted or All. 

For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

4 If you set the Scope field to Unlisted for any of the frame types, you 
must also configure predefined subtype filters or customizable subtype 
filters. For help, see “Using Predefined Subtype Filters” on page 71 or 
“Customizing Subtype Filters” on page 72. 
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Frame Type Filter Descriptions 

Frame Type Explanation 

DIX IP TCP Ports 
DIX IP UDP Ports 
SNAP IP TCP Ports 
SNAP IP UDP Ports 

Primary Internet Protocol Suite (IP) transport 
protocols. 

DIX IP Other Protocols 
SNAP IP Other Protocols 

IP protocols other than TCP or User Datagram 
Protocol (UDP). 

DIX IPX Sockets Novell NetWare protocol over Ethernet II frames. 

SNAP IPX Sockets Novell NetWare protocol over 802.2 SNAP frames. 

802.3 IPX Sockets Novell NetWare protocol over 802.3 RAW frames. 

DIX Other Ethernet Types 
SNAP Other Ethernet Types 

DIX or SNAP registered protocols other than IP or 
IPX. 

802.2 IPX Sockets Novell running over 802.2 Logical Link Control 
(LLC). 

802.2 Other SAPs 802.2 SAPs other than IPX or SNAP. 

  

 
Note: You should not filter HTTP, Telnet, SNMP, and ICMP frames if 
you are using WAPs because these frame types are used for configuring, 
troubleshooting, and upgrading WAPs.  

Using Predefined Subtype Filters 
You can configure the access point to pass or drop certain predefined 
frame subtypes. 

To configure predefined subtype filters 

1 From the main menu, click Ethernet > Predefined Subtype Filters. 
The Predefined Subtype Filters screen appears. 
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2 For each frame subtype field, check or clear the check box to configure 
if the frame subtypes are passed or are dropped. If you check the check 
box, the frame subtype is allowed to pass. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Customizing Subtype Filters 
You can configure the access point to pass or drop certain customized 
frame subtypes. You define the action, subtype, and value parameters.  

Allow/ 
Pass 

Check or clear this check box. Check this check box to pass all frames of the 
subtype and value. Clear this check box to drop all frames of the subtype and 
value. 

Subtype Selects the frame subtype you wish to configure. 

Value The following table describes frame subtypes and their values. The value 
must be two hex pairs. When a match is found between frame subtype and 
value, the specified action is taken. 

  

To customize subtype filters 

1 From the main menu, click Ethernet > Customizable Subtype Filters. 
The Customizable Subtype Filters screen appears. 

   

2 For each subtype field, check or clear the check box to configure if the 
subtypes are passed or are dropped. If you check the check box, the 
subtype is allowed to pass. 
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3 In the SubType field, choose the customizable frame subtype. For help, 
see the next table. 

4 In the Value field, enter the two hex pairs. For help, see the next table. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Subtype Filter Descriptions 

Subtype Value 

DIX-IP-TCP-Port Port value in hexadecimal. 

DIX-IP-UDP-Port Port value in hexadecimal. 

DIX-IP-Protocol Protocol number in hexadecimal. 

DIX-IPX-Socket Socket value in hexadecimal. 

DIX-EtherType Specify the registered DIX type in hexadecimal. 

SNAP-IP-TCP-Port Port value in hexadecimal. 

SNAP-IP-UDP-Port Port value in hexadecimal. 

SNAP-IP-Protocol Port value in hexadecimal. 

SNAP-IPX-Socket Socket value in hexadecimal. 

SNAP-EtherType SNAP type in hexadecimal. To filter on both SNAP type and 
OUI, use advanced filters. 

802.3-IPX-Socket Socket value in hexadecimal. 

802.2-IPX-Socket Socket value in hexadecimal. 

802.2-SAP 802.2 SAP in hexadecimal. 

  

Example 
This example shows you how to use customizable filters to only allow the 
wireless end devices (DHCP clients) that are communicating with the 
access point (DHCP server) to receive TCP/IP settings. This example 
prevents the wireless end devices from receiving TCP/IP settings from 
another DHCP server on the Ethernet network. It also prevents the access 
point from providing TCP/IP settings to DHCP clients on the wired 
network.  
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For this example, set these customizable subtype filters. 

  

Example – Customizable Subtype Filter 

Filter Parameter Value Explanation 

1 Allow/Pass Clear (drop) 

 Subtype DIX-IP-UDP-Port 

 Value 00 43 

This filter drops DHCP 
responses to wireless end 
devices communicating with 
this access point. 

2 Allow/Pass Clear (drop) 

 Subtype DIX-IP-UDP-Port 

 Value 00 44 

This filter drops DHCP 
requests from DHCP clients 
on the Ethernet network. 

    

Configuring Advanced Filters 
You can configure advanced filters if you need more flexibility in your 
filtering. Settings for advanced filters execute after those for other filters; 
that is, advanced filters are only applied if the frame has passed the other 
filters. 

You can use filter values and filter expressions to minimize network traffic 
over the wireless links; however, Intermec recommends that you use 
advanced Ethernet filters only if you have an extensive understanding of 
network frames and their contents. Use other existing filters whenever 
possible. 

Setting Filter Values 
You can associate an ID with a pattern value by selecting a filter, and then 
entering an ID and a value. All values with the same value ID belong to 
the same list. 
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To set the value ID and value 

1 From the main menu, click Ethernet > Advanced Filters. The Filter 
Values screen appears. 

   

2 Enter up to 22 value IDs and values.  

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Setting Filter Expressions 
You can set filter expressions by specifying parameters for frame filters. 
You can also create a filter expression, which is executed in ascending order 
based on the ExprSeq values until the access point determines whether to 
pass or drop the frame.  

To set filter expressions 

1 From the main menu, click Ethernet > Advanced Filters. 

2 Click Filter Expressions. The Filter Expressions screen appears. 
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3 Configure the filter expressions parameters. For help, see the next table. 

4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Filter Expressions Parameter Descriptions 

Parameter Explanation 

ExprSeq 
(Expression 
Sequence) 

Indicates the order in which the filters will be executed. When you 
change the parameter, the statements are reordered and renumbered so 
the Expression Sequence order is maintained. The range is from 0 to 
255. 

This parameter works with the Action parameter; for example, if the 
action is set to And, then the next sequence in another expression is 
processed.  

Offset Identifies a point inside the frame where testing for the expression is to 
start. The range is from 0 to 65535. 

Mask Applies a data pattern to the frame. If the data pattern in the mask 
matches the frame, then the specific action is performed. The mask 
indicates the bits that are significant at the specified offset. A bit is 
significant if a bit in the mask is set to one. If this field is empty, the 
length of the field is determined by the longest value in the Filter 
Values menu for the specified value ID. The mask values are entered in 
hexadecimal pairs. You can enter 0 to 8 pairs. 

Op 
(Operation)  

Performs a logical operation when a data pattern matches a value in the 
Filter Values menu to determine if the specified action should be 
taken. Valid operations include: EQ (equal), NE (not equal), GT 
(greater than), LT (less than or equal) 
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Filter Expressions Parameter Descriptions (continued) 

Parameter Explanation 

Value ID Represents a value in the Filter Values menu. The bytes after the frame 
offset are compared to the data pattern indicated by the value. Value 
ID can be from 0 to 255 and must match one or more value IDs in the 
Filter Values menu. 

Action Sets the action to Pass, Drop, or And. If you set the action to And, the 
filter expression with the next highest sequence is applied. 

  

Example 1 
This example shows you how to use Ethernet filters to filter all traffic that 
passes through the access point to the wireless network except for traffic 
for specified MAC addresses. These filters do not prevent wireless traffic 
from reaching the Ethernet network. For this example, set these filter 
values. 

  

Example 1 - Filter Values 

Value ID Value Description 

1 ff ff ff ff ff ff Allows multicast traffic to enter the wireless 
network, which is necessary for IP end devices to 
communicate 

2 00 02 2d 04 b7 a4 The MAC address of an end device you want to 
be able to communicate. 

3 00 02 2d 0d 54 25 The MAC address of an end device you want to 
be able to communicate. 
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For this example, set these filter expressions. 

  

Example 1 –Filter Expressions 

Parameter Value Explanation 

ExprSeq 10 The order that you want the expressions executed. You 
must have an expression for each Value ID that is listed in 
the Filter Values menu. 

Offset 0 Since the filter is applied to the destination address, which 
is the first value in the frame, the offset is 0. 

Mask ff ff ff 
ff ff ff 

Compares the entire 6-byte destination address for an 
exact match. 

Op EQ Compares the value after the offset and mask are applied 
to the value of the Value ID from the Filter Values menu 
to see if they are equal. (If the value at the offset equals the 
specified value on the Filter Values menu, the frame is 
multicast.) 

Value ID 1 This filter expression applies to value ID 1 from the Filter 
Values menu. 

Action Pass If this filter expression is true, continue to the next 
expression. 

   

You must enter a filter expression for each Value ID in the Filter Values 
menu. In this example, only the ExprSeq value and the Value ID value 
change. 
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Example 2 
This example shows how to use Ethernet filters to discard all DIX IP 
multicast frames except those from selected devices. Three entries have a 
value ID of 3 to demonstrate how to enter a list. All entries with the same 
value ID belong to the same list. For this example, set these filter values. 

  

Example 2 - Filter Values 

Value ID Value Description 

1 08 00 Check for a DIX IP frame. 

2 01 Check for a multicast frame. 

3 00 c0 b2 00 00 01 
00 c0 b2 00 00 02 
00 c0 b2 00 00 03 

Check for these specific MAC device addresses. 

   

You must enter a filter expression for each Value ID in the Filter Values 
menu. In this example, three expressions combine to form a single 
compound expression. The compound expression forms an advanced filter 
that drops all DIX IP multicast frames except those from the three 
Ethernet stations whose addresses are listed on the Filter Values menu. 

The default action is the opposite of the action specified in the last 
expression. In this example, the action of the last expression is drop; 
therefore, the default action is pass. Any frame that meets the conditions 
specified in the advanced filter is passed. 
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Set the first filter expression as shown below. 

  

Example 2 – First Filter Expression 

Parameter Value Explanation 

ExprSeq 1 The first expression that is executed. You must have an 
expression for each Value ID that is listed in the Filter 
Values menu. 

Offset 0 Since the filter is applied to the destination address, which 
is the first value in the frame, the offset is 0. 

Mask 01 Checks only the Ethernet multicast bit. 

Op EQ Compares the value after the offset and mask are applied 
to the value of the Value ID from the Filter Values menu 
to see if they are equal. (If the value at the offset equals the 
specified value on the Filter Values menu, the frame is 
multicast.) 

Value ID 2 This filter expression applies to value ID 2 from the Filter 
Values menu. 

Action And If this filter expression is true, continue to the next 
expression. 
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Set the second filter expression as shown below. 

  

Example 2 – Second Filter Expression 

Parameter Value Explanation 

ExprSeq 2 The second expression that is executed. 

Offset 12 Checks for the DIX IP frame type, which starts 12 bytes 
from the destination address. 

Mask ff ff Checks the 2-byte DIX IP frame type for an exact match. 

Op EQ Compares the value after the offset and mask are applied 
to the value of the Value ID from the Filter Values menu 
to see if they are equal. (If the value at the offset equals the 
specified value on the Filter Values menu, the frame is 
DIX IP.) 

Value ID 1 This filter expression applies to value ID 1 from the Filter 
Values menu. 

Action And If this filter expression is true, continue to the next 
expression. 

   



Chapter 3 — Configuring the Ethernet Network 

82 MobileLAN access System Manual  

Set the third filter expression as shown below. 

  

Example 2 – Third Filter Expression 

Parameter Value Explanation 

ExprSeq 3 The third expression that is executed. 

Offset 6 Checks the source Ethernet address, which starts 6 bytes 
from the destination address. 

Mask ff ff ff 
ff ff ff 

Checks the 6-byte source Ethernet address for an exact 
match. 

OP NE Compares the value after the offset and mask are applied to 
the value of the Value ID from the Filter Values menu to 
see if they are not equal. (Compare the source Ethernet 
address with the list of MAC addresses from the Filter 
Values menu.) 

Value ID 3 This filter expression applies to value ID 3 from the Filter 
Values menu. 

Action Drop If the source Ethernet address does not match any address in 
the list on the Filter Values menu, then drop the frame. 
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Configuring the Radios 

This chapter explains how to configure the radios in the MobileLAN 
access products so that they communicate with your wireless end devices. 
This chapter covers these topics: 

• Configuring the IEEE 802.11b radio 

• Configuring the IEEE 802.11a radio 

• Configuring the WLI Forum OpenAir radio 

• Configuring the 902 MHz radio 

4 
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About the Radios 
MobileLAN access products may contain one or two radios. You can use 
access points that contain two different types of radios to support two 
different types of wireless networks, such as legacy networks. You can use 
access points with two of the same type of radios as WAPs, as point-to-
multipoint bridges, to increase throughput in a busy network, or to 
provide redundancy.  

Access Point Radios Supported and Features 

 
Access Point 

 
Radios Supported 

Dual Radio 
Support 

Radio 
Independent 

WA22 802.11b, 802.11a Yes Yes 

2101 802.11b, OpenAir Yes Yes 

WA21 802.11b, 802.11a Yes Yes 

2100 802.11b, OpenAir 
902 MHz 

Yes Yes 

2102 802.11b, OpenAir No Yes 

2106 802.11a No No 

    

The next sections explain how to configure the radios that are in your 
access point. If the radio is not installed in your access point, then you will 
not see it listed in the main menu. 
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Configuring the IEEE 802.11b Radio 
The IEEE 802.11b radio will communicate with other 802.11b radios that 
have the same: 

• SSID (Network Name) 

• Security 

To configure the 802.11b radio 

1 From the main menu, click IEEE 802.11b Radio. The IEEE 802.11b 
Radio screen appears. 

   

2 Configure the parameters for the radio. For help, see the next table. 

3 Configure the advanced parameters for the radio. For help, see 
“Configuring 802.11b Radio Advanced Parameters” on page 87. 

4 (Master only) Configure inbound filters. For help, see “Configuring 
802.11b Radio Inbound Filters” on page 89. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 (Optional) Configure security by clicking Configure security settings 
for this radio. For help, see Chapter 6, “Configuring Security.” 
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802.11b Radio Parameter Descriptions 

Parameter Explanation 

Node Type Configure the 802.11b radio as a master or station. You can also 
disable the radio. 

SSID 
(Network Name) 

Enter the network name for this access point. 802.11b radios 
communicate with other 802.11b radios with the same network 
name. You need to assign the same network name to the wireless 
end devices that will connect to the access point.  

The network name is case sensitive and can be no more than 32 
alphanumeric characters. 

Frequency 
(Master radio only) 

Choose the frequency within the 2.4 to 2.5 GHz range that this 
access point uses to transmit and receive frames. The available 
frequencies are country-dependent and are determined by the 
radio. See the “Worldwide Frequencies for the 802.11b Radio” 
table. 

Configure all access points used in Spain, France, or Japan to a 
common frequency. For all other countries, configure all access 
points to a common frequency, or select up to three frequencies 
that are at least three channels (or 25 MHz) apart. For example, 
you could select 2412 MHz, 2437 MHz, and 2462 MHz. You 
may want to use a single frequency to isolate the installation to 
part of the band; for example, use a single frequency if other 
wireless networks or microwave ovens are in the area. 

For optimal performance of master radios in access points that 
are in range of each other, configure the frequencies to be at least 
five channels apart. For example, configure the frequency to use 
channels 1, 6, and 11.  

  

Worldwide Frequencies for the 802.11b Radio 

Channel FCC ETSI France Japan Israel 

1 2412 2412  2412  

2 2417 2417  2417  

3  2422 
(default) 

2422 
(default) 

 2422 
(default) 

2422 
(default) 

4 2427 2427  2427  

5 2432 2432  2432  

6 2437 2437  2437  

7 2442 2442  2442  

8 2447 2447  2447  

9 2452 2452  2452  

10 2457 2457 2457 2457  

11 2462 2462 2462 
(default) 

2462  

12  2467 2467 2467  

13  2472 2472 2472  

14    2484  
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The 802.11b channels that are allowed in a given country may change 
without notice. Be sure you use only those frequencies that are permissible 
in the given country. Note the following: 

• FCC countries include the United States, Canada, China, Taiwan, 
India, Thailand, Indonesia, Malaysia, Hong Kong, and most South 
American countries.  

• ETSI countries include all European Union countries except France. It 
also includes Switzerland, Iceland, Norway, Czech Republic, Slovenia, 
Slovakia, Turkey, Russia, and the United Arab Emirates.  

• France, Mexico, and Singapore use the same channels.  

Configuring 802.11b Radio Advanced Parameters 
1 From the main menu, click IEEE 802.11b Radio > Advanced 

Configuration. The Advanced Configuration screen appears. 

   

2 Configure the advanced parameters. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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802.11b Radio Advanced Parameter Descriptions 

Parameter Description 

Data Rate Choose the rate at which the access point transmits data. In 
general, higher speeds mean shorter range and lower speeds mean 
longer range. You can set this rate to 11, 5.5, 2, or 1 Mbps. 

Allow Data Rate 
Fallback 

Determines if you want the radio to drop to a slower data rate 
when it has trouble communicating with another radio. 

Basic Rate Choose the rate at which the access point transmits multicast 
and beacon frames. In general, higher speeds mean shorter range 
and lower speeds mean longer range. Do not set this rate higher 
than the maximum rate at which your end devices can receive 
multicast frames. You can set this rate to 11, 5.5, 2, or 1 Mbps. 
This parameter should usually be left at the default 2 Mbps. 

Enable Medium 
Reservation 

Determines if you want to specify a reservation threshold. Check 
this check box to set a threshold value. If you clear this check 
box, you may improve network response time in installations 
that usually send very small frames or that have no hidden 
stations. 

Reservation 
Threshold 

If you enable medium reservation, you need to set a threshold 
value, which is the largest data frame that can be transmitted 
without reserving air time. Air time is normally reserved to help 
prevent collisions with other transmitters.  

Distance Between 
APs 

Controls the roaming sensitivity of your end devices. This setting 
should match the setting on your end devices.  

You can use this parameter to virtually reduce the range of your 
access point. If you choose Small or Medium, you do not reduce 
the absolute range of your radio, but you modify the collision 
detection mechanism to allow significant overlap of the wireless 
cells. Thus, you create a higher performance radio network, but 
you need more access points to cover an area. 

Enable Microwave 
Oven Robustness 

Determines if the access point activates a modified algorithm for 
automatic rate fallback, which prevents the access point from 
falling back to 1 Mbps when trying to retransmit radio frames 
when 2.4 GHz interference is present. 

Enable Load 
Balancing 

Determines if end devices can distribute their connections across 
multiple access points. 

Enable Medium 
Density Distribution 

Determines if these access point parameters—Enable Medium 
Reservation, Distance Between APs, Enable Microwave Oven 
Robustness—are distributed to end devices that support this 
feature. 
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802.11b Radio Advanced Parameter Descriptions (continued) 

Parameter Description 

Data/Voice Settings 
(Master radio only) 

Choose the setting that optimizes the wireless network.  

Set to Data Traffic Only if the access point will transmit only 
data traffic.  

Set to SpectraLink Traffic Only if the access point will transmit 
only voice traffic. SpectraLink telephone frames will be sent with 
a priority setting. All other multicast/broadcast frames will be 
dropped. 

Set to Data and SpectraLink Traffic if the access point will 
transmit both data and voice traffic. SpectraLink telephone 
frames will be sent in the high priority queue. Frames in the high 
priority queue are sent ahead of frames in the normal priority 
queue. No special filtering. 

Disallow Network 
Name of ‘ANY’ 
(Master radio only) 

Determines if end devices that have their SSID (Network Name) 
set to ANY or are left blank can associate with this access point. 
Clear this check box to allow these end devices to associate with 
this access point. This setting is 802.11b compliant, but not very 
secure. 

Check this check box to prevent end devices with an SSID of 
ANY or are left blank from associating with this access point. 

DTIM Period 
(Master radio only) 

Specifies the number of beacon frames to skip before including a 
DTIM (delivery traffic indication message) in a beacon frame. 
Setting a higher DTIM period may conserve battery life in an 
end device, but it may increase response time.  

  

Configuring 802.11b Radio Inbound Filters 
When configuring a master radio, you can filter different types of wireless 
traffic that it may receive. You may want to use this feature by itself or 
with an access control list (ACL) to help secure your network. If you clear 
all the check boxes, the radio cannot communicate with any other radios. 
You should check the Allow IAPP check box so the access point can 
communicate with other access points and participate in the spanning tree.  

You can use this feature to form a secure wireless hop. Clear all check 
boxes, except for the Allow IAPP check box. Or, you may want to use this 
feature in a terminal emulation environment when you know the end 
devices are sending only UDP Plus or Wireless Transport Protocol (WTP) 
frames. Check the Allow UDP Plus check box or the Allow Wireless 
Transport Protocol check box and clear all other check boxes (except the 
Allow IAPP check box). The access point master radio will only accept the 
UDP Plus or WTP frames and discard all other frames, which can make a 
more secure network.  

 
Note: If any of the devices are also DHCP clients, you need to check the 
Allow DHCP check box. 
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To configure 802.11b radio inbound filters 

1 From the main menu, click IEEE 802.11b Radio > Inbound Filters. 
The Inbound Filters screen appears. 

   

2 For each frame type, check or clear each check box. For help, see the 
next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

802.11b Radio Inbound Filter Descriptions 

Parameter Description 

Allow IAPP Determines if this radio accepts IAPP frames from other access 
point station radios. The IAPP frames must match Ethernet 
protocol 875c. 

Allow Wireless 
Transport Protocol 
(WTP)  

Determines if this radio accepts WTP frames from end devices. 
The WTP frames must match Ethernet protocol 875b. 

Allow SpectraLink 
Voice Protocol (SVP) 

Determines if this radio accepts SVP frames from MobileLAN 
voice wireless telephones. The SVP frames must match IP 119. 

Allow UDP Plus 
(UDP/IP Port 5555)  

Determines if this radio accepts UDP Plus frames from end 
devices. The UDP Plus frames must match the UDP network 
port 5555 on the DCS 30X or ARP. 

Allow DHCP Determines if this radio accepts DHCP frames. The DHCP 
frames must match UDP destination port 67 and ARP. Check 
this check box if the end devices are DHCP clients. 

Allow All Other 
Protocols 

Determines if this radio accepts all other protocols that are not 
filtered by one of the filters in this screen. 
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Configuring a SpectraLink Network  

SpectraLink wireless telephone systems simplify network infrastructure and 
network management by combining voice and data traffic over one 
wireless network, leveraging 802.11b wireless LAN technology. You use 
your SpectraLink telephone to make and receive calls, just like a regular 
telephone, subject to the restrictions of your PBX. 

SpectraLink telephones and gateways operate as adjuncts to existing 
wireless LANs and PBXs. SpectraLink networks use digital spread 
spectrum radio technology and integrate with enterprise telephone 
switching and networking systems. These features provide voice quality 
throughout the coverage area because there are no clicks, no fading, and no 
dead spots. 

If you are using a SpectraLink network with your MobileLAN access 
products and wireless data collection network, you need to configure an 
802.11b radio port to accept voice traffic. An 802.11b radio can support 
both voice and data communications. You still need to define the normal 
802.11b parameters, such as SSID (Network Name) and security. 

SpectraLink and MobileLANaccess Products - Number of Phones Supported 

 
Access Point 

Number of 
802.11b Radios 

Number of Phones 
Supported (Voice Only) 

Number of Phones 
Supported (Voice and Data) 

WA21, WA22, 2101 
(any), 2100 (any) 

2 7 per radio (both radios set 
to voice traffic only) 

7 (one radio set to voice traffic 
only, the other radio dedicated to 
data or data and voice traffic) 

WA21, WA22, 
2101B, 2100D 

1 7 7 

2101A, 2100A, 
2100B, 2100C 

1 7 5 

2102 1 7 5 

    

To configure a SpectraLink network 

 
Note: If your access point contains dual radios, use a different SSID 
(Network Name) for each radio so you can specify which end 
devices/telephones attach to which radio. You also must enter the Network 
Name on each telephone. 

1 From the main menu, click IEEE 802.11b Radio > Advanced 
Configuration. The Advanced Configuration screen appears. 

2 In the Data/Voice Settings field, choose either Data and SpectraLink 
Traffic or SpectraLink Traffic only. For help, see “Configuring 802.11b 
Radio Advanced Parameters” on page 87. 

3 Check the Allow Data Rate Fallback check box. 
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4 In the Basic Rate field: 

• if you are using a 2 Mbps SpectraLink telephone, set the Basic Rate 
to 2 Mbps. 

• if you are using a 1 Mbps SpectraLink telephone, set the Basic Rate 
to 1 Mbps. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring the IEEE 802.11a Radio 
The IEEE 802.11a radio will communicate with other 802.11a radios that 
have the same: 

• SSID (Network Name) 

• Security 

The 802.11a radio ships with either the full-range (5.15 to 5.35 GHz ) 
option or the mid-range (5.25 to 5.35 GHz) option. The full-range option 
can only be used indoors and with the integrated antenna. 

If you configure an 802.11a radio as a master radio, it provides 
simultaneous master and station support. This feature means that not only 
do you only need one radio in WAPs and point-to-multipoint bridges, but 
also it can “heal itself.” If the access point can no longer communicate with 
the Ethernet network, it will try to wirelessly connect to the root through 
another access point. Any access point that may become a WAP should 
have a root priority set to 0 and have a secondary LAN bridge priority. 

To configure the 802.11a radio 

1 From the main menu, click IEEE 802.11a Radio. The IEEE 802.11a 
Radio screen appears. 

   

2 Configure the parameters for the radio. For help, see the next table. 
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3 Configure the advanced parameters for the radio. For help, see 
“Configuring 802.11a Radio Advanced Parameters” on page 94. 

4 (Master only) Configure inbound filters. For help, see “Configuring 
802.11a Radio Inbound Filters” on page 96. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 (Optional) Configure security by clicking Configure security settings 
for this radio. For help, see Chapter 6, “Configuring Security.” 

802.11a Radio Parameter Descriptions 

Parameter Explanation 

Node Type Configure the 802.11a radio as a master or station. You can also 
disable the radio. 

Choose Master if you want this radio to operate in Master mode 
when it sees the root access point on its Ethernet port. If it 
cannot see the root, it operates in Master/Station mode and tries 
to find the root through its radio port. 

Choose Station if you want this radio to always operate in 
Station mode. 

SSID (Network 
Name) 

Enter the network name for this access point. 802.11a radios 
communicate with other 802.11a radios with the same network 
name. You need to assign the same network name to the wireless 
end devices that will connect to the access point.  

The network name is case sensitive and can be no more than 32 
alphanumeric characters. 

Frequency  
(Master radio only) 

Choose the frequency within the 5.15 to 5.35 GHz range that 
this access point uses to transmit and receive frames. You can 
also set the frequency to Dynamic, which lets the access point 
choose the best available channel to use.  

The available frequencies depend on the country and the radio 
option configured on the access point. See the “Worldwide 
Frequencies for the 802.11a Radio” table on page 94. If the 
radio is a mid range radio, you can only choose 52, 56, 60, or 
64. 

You may want to use a single frequency to isolate the installation 
to part of the band; for example, use a single frequency if other 
wireless networks or microwave ovens are in the area. 
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Worldwide Frequencies for the 802.11a Radio 

Channel FCC ETSI France Japan Israel 

36* 5180 (default) N/A N/A N/A N/A 

40* 5200 N/A N/A N/A N/A 

42 5210 Turbo N/A N/A N/A N/A 

44* 5220 N/A N/A N/A N/A 

48* 5240 N/A N/A N/A N/A 

50 5250 Turbo N/A N/A N/A N/A 

52 5260 (default) N/A N/A N/A N/A 

56 5280 N/A N/A N/A N/A 

58 5290 Turbo N/A N/A N/A N/A 

60 5300 N/A N/A N/A N/A 

64 5320 N/A N/A N/A N/A 

      
• Channels marked with an asterisk (*) are not available in the mid-range radio.  

• If you set the Frequency parameter to Dynamic, turbo channels are never selected. 

• FCC countries include the United States, Canada, China, Taiwan, India, Thailand, 
Indonesia, Malaysia, Hong Kong, and most South American countries. The 802.11a 
channels that are allowed in a given country may change without notice. Be sure you 
use only those frequencies that are permissible in the given country. 

Configuring 802.11a Radio Advanced Parameters 
You can configure other advanced parameters for the 802.11a radio, such 
as Data Rate and Medium Reservation. 

To configure other advanced parameters 

1 From the main menu, click IEEE 802.11a Radio > Advanced 
Configuration. The Advanced Configuration screen appears. 

   

2 Configure the advanced parameters. For help, see the next table. 
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3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

802.11a Radio Advanced Parameter Descriptions  

Parameter Description 

Data Rate Choose the rate at which the access point transmits data. In 
general, higher speeds mean shorter range and lower speeds mean 
longer range. If you choose the Speed Mode to be 802.11 
compliant, you can set this rate to 54, 48, 36, 24, 12, or 6 Mbps. 

Allow Data Rate 
Fallback 

Determines if you want the radio to drop to a slower data rate 
when it has trouble communicating with another radio. 

Basic Rate Choose the rate at which the access point transmits multicast 
and beacon frames. In general, higher speeds mean shorter range 
and lower speeds mean longer range. Do not set this rate higher 
than the maximum rate at which your end devices can receive 
multicast frames. You can set this rate to 24, 12, or 6 Mbps. 
This parameter should usually be left at the default of 6 Mbps. 

Reservation 
Threshold 

You may need to set a threshold value, which is the largest data 
frame that can be transmitted without reserving air time. Air 
time is normally reserved to help prevent collisions with other 
transmitters. 

If you set this threshold to 2347, this parameter is disabled. 

Fragmentation 
Threshold 

Specifies the largest data frame that can be transmitted without 
fragmentation. On certain radios, the fragmentation does not 
occur unless the radio detects interference. Larger frame sizes can 
improve throughput on a reliable connection. Smaller frame sizes 
can improve throughput on a poor connection. 
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802.11a Radio Advanced Parameter Descriptions (continued) 

Parameter Description 

Disallow Network 
Name of ‘ANY’ 
(Master radio only) 

Determines if end devices that have their SSID (Network Name) 
set to ANY or are left blank can associate with this access point. 
Clear this check box to allow these end devices to associate with 
this access point. This setting is 802.11a compliant, but not very 
secure. 

Check this check box to prevent end devices with an SSID of 
ANY or are left blank from associating with this access point. 

Beacon Period Specifies how often the access point sends out a beacon frame. 
This rate is in TU. A TU is 1024 microseconds, and is often 
considered to be equivalent to one millisecond. 

DTIM Period Specifies the number of beacon periods to skip before including 
a DTIM (delivery traffic indication message) in a beacon frame. 
Setting a higher DTIM period may conserve battery life in an 
end device, but it may increase response time. 

  

Configuring 802.11a Radio Inbound Filters 
When configuring a master radio, you can filter different types of wireless 
traffic that it may receive. You may want to use this feature by itself or 
with an access control list (ACL) to help secure your network. If you clear 
all the check boxes, the radio cannot communicate with any other radios. 
You check the Allow IAPP check box so the access point can 
communicate with other access points and participate in the spanning tree.  

You can use this feature to form a secure wireless hop. Clear all check 
boxes, except for the Allow IAPP check box. Or, you may want to use this 
feature in a terminal emulation environment when you know the end 
devices are sending only UDP Plus or Wireless Transport Protocol (WTP) 
frames. Check the Allow UDP Plus check box or the Allow Wireless 
Transport Protocol check box and clear all other check boxes (except the 
Allow IAPP check box). The access point master radio will only accept the 
UDP Plus or WTP frames and discard all other frames, which can make a 
more secure network.  

 
Note: If any of the devices are also DHCP clients, you need to check the 
Allow DHCP check box. 
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To configure 802.11a radio inbound filters 

1 From the main menu, click IEEE 802.11a Radio > Inbound Filters. 
The Inbound Filters screen appears. 

   

2 For each frame type, check or clear each check box. For help, see the 
next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

802.11a Radio Inbound Filter Descriptions 

Parameter Description 

Allow IAPP Determines if this radio accepts IAPP frames from other access 
point station radios. The IAPP frames must match Ethernet 
protocol 875c. 

Allow Wireless 
Transport Protocol 
(WTP)  

Determines if this radio accepts WTP frames from end devices. 
The WTP frames must match Ethernet protocol 875b. 

Allow UDP Plus 
(UDP/IP Port 5555)  

Determines if this radio accepts UDP Plus frames from end 
devices. The UDP Plus frames must match the UDP network 
port 5555 on the DCS 30X or ARP. 

Allow DHCP Determines if this radio accepts DHCP frames. The DHCP 
frames must match UDP destination port 67 and ARP. Check 
this check box if the end devices are DHCP clients. 

Allow All Other 
Protocols 

Determines if this radio accepts all other protocols that are not 
filtered by one of the filters in this screen. 
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Configuring the WLI Forum OpenAir Radio 
The WLI Forum OpenAir radio will communicate with other OpenAir 
radios that have the same: 

• LAN ID (Domain). For help, see “Configuring the Spanning Tree 
Parameters” in Chapter 5. 

• Security ID 

• Channel 

• Subchannel 

You should configure each master radio with a unique channel/subchannel 
combination. When a station radio locates a master radio that has the same 
LAN ID and security ID as itself, it autoconfigures its channel and 
subchannel so it can communicate with the master radio. 

 

Intermec recommends that you set the security ID to a value other 
than null. Failure to change the default setting could expose your 
network to a security breach by an unauthorized wireless device. 

Attention: Intermec vous recommande de régler l’ID de sécurité sur 
une valeur autre que nul. Si le paramètre par défaut n’est pas modifié, 
vous risquez d’exposer votre réseau à une brèche de sécurité par un 
périphérique sans fil non autorisé. 

To configure the OpenAir radio 

1 From the main menu, click OpenAir Radio. The OpenAir Radio 
screen appears. 

   

2 Configure the parameters for the radio. For help, see the next table. 

3 (Station only) List the master radios with which this station radio can 
communicate. For help, see “Configuring the Master List” on page 100. 

4 (Master only) Configure inbound filters. For help, see “Configuring 
OpenAir Radio Inbound Filters” on page 100. 
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5 (MAC Configuration–Manual only) Configure the manual MAC 
parameters for the radio. For help, see “Setting Manual MAC 
Parameters” on page 102. 

6 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

OpenAir Radio Parameter Descriptions 

Parameter Explanation 

Node Type Configure the OpenAir radio as a master or station. You can also 
disable the radio. 

Security ID Sets a security identification value. All access points and end 
devices with OpenAir radios must have the same security ID to 
communicate with each other. Intermec recommends that you 
set this parameter as it helps prevent unauthorized radios from 
communicating with the access point. Security ID values can be 
from 0 to 20 characters. 

If you have RT1100, RT1700, or RT5900 devices that have 
OpenAir radios that are communicating with this access point, 
you must limit the security ID to a maximum of 16 characters. 

Channel 
(Master radio only) 

Sets the hopping sequence for the radio. If you have more than 
one access point in the same coverage area, configure each access 
point with a unique channel. The Channel value can be any 
number from 1 to 15.  

Subchannel 
(Master radio only) 

Set this parameter if you have more than 16 access points. The 
subchannel allows access points to share the same channel. If 
access points have the same channel and different subchannels, 
they share the same hopping sequence, but behave as if they were 
on different channels. 

MAC Configuration Adjusting this parameter may enhance the performance of your 
radio. It changes the settings for the radio protocol in different 
environments. Intermec recommends that you do not change 
this parameter from Default unless you are told to do so by 
Intermec Technical Support. 

The Interference value may enhance performance in 
environments with high interference or multipath.  

The Throughput value may enhance performance of file transfer 
operations in open or uncongested environments, such as office 
areas.  

Manual lets you adjust the MAC parameters individually using 
the Manual MAC Parms command. To adjust these parameters, 
see “Setting Manual MAC Parameters” on page 102. 
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Configuring the Master List 
The master list contains the channels and subchannels of all the master 
radios with which this station radio can communicate. 

To configure the master list 

1 From the main menu, click OpenAir Radio > Master List. The Master 
List screen appears. 

   

2 For each master radio, enter the channel and subchannel. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring OpenAir Radio Inbound Filters 
When configuring a master radio, you can filter different types of wireless 
traffic that it may receive. You may want to use this feature by itself or 
with an access control list (ACL) to help secure your network. If you clear 
all the check boxes, the radio cannot communicate with any other radios. 
You check the Allow IAPP check box so the access point can 
communicate with other access points and participate in the spanning tree.  

You can use this feature to form a secure wireless hop. Clear all check 
boxes, except for the Allow IAPP check box. Or, you may want to use this 
feature in a terminal emulation environment when you know the end 
devices are sending only UDP Plus or Wireless Transport Protocol (WTP) 
frames. Check the Allow UDP Plus check box or the Allow Wireless 
Transport Protocol check box and clear all other check boxes (except the 
Allow IAPP check box). The access point master radio will only accept the 
UDP Plus or WTP frames and discard all other frames, which can make a 
more secure network.  
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Note: If any of the devices are also DHCP clients, you need to check the 
Allow DHCP check box. 

To configure OpenAir radio inbound filters 

1 From the main menu, click OpenAir Radio > Inbound Filters. The 
Inbound Filters screen appears. 

   

2 For each frame type, check or clear each check box. For help, see the 
next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

OpenAir Radio Inbound Filter Descriptions 

Parameter Description 

Allow IAPP Determines if this radio accepts IAPP frames from other access 
point station radios. The IAPP frames must match Ethernet 
protocol 875c. 

Allow Wireless 
Transport Protocol 
(WTP)  

Determines if this radio accepts WTP frames from end devices. 
The WTP frames must match Ethernet protocol 875b. 

Allow UDP Plus 
(UDP/IP Port 5555)  

Determines if this radio accepts UDP Plus frames from end 
devices. The UDP Plus frames must match the UDP network 
port 5555 on the DCS 30X or ARP. 

Allow DHCP Determines if this radio accepts DHCP frames. The DHCP 
frames must match UDP destination port 67 and ARP. Check 
this check box if the end devices are DHCP clients. 

Allow All Other 
Protocols 

Determines if this radio accepts all other protocols that are not 
filtered by one of the filters in this screen. 
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Setting Manual MAC Parameters 
Intermec recommends that you do not change the MAC Configuration 
parameter from Default. Occasionally, you may need to fine-tune your 
OpenAir radio MAC parameters. 

 
Note: An inefficient MAC Configuration parameter can adversely affect 
the performance of your wireless network. 

To set manual MAC parameters 

1 From the main menu, click OpenAir Radio > Manual MAC 
Parameters. The Manual MAC Parameters screen appears. 

   

2 Configure the manual MAC parameters. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Manual MAC Parameter Descriptions 

Parameter Explanation 

Hop Period 
(Master radio only) 

Specifies how long the master radio stays on a frequency in the 
hopping sequence before stepping to the next frequency. Longer 
time periods result in better throughput while shorter time 
periods result in faster roaming response and immunity from 
interference. This parameter can be set to 100, 200, or 400 ms.  

Beacon Frequency 
(Master radio only) 

Specifies the number of hops between beacons (the access point 
periodically transmits a beacon to allow end devices to quickly 
scan each frequency to find a master access point). You can set 
this parameter to a value from 1 to 7. 

Deferral Slot 
(Master radio only) 

Works with the Fairness Slot parameter to determine the average 
back-off time when the channel is busy. You may want to reduce 
the number of slots on lightly loaded networks to increase 
throughput or increase the number of slots to help prevent 
repeated collisions under a heavy load. You can set this 
parameter to 1, 3, 7, or default. 

Fairness Slot 
(Master radio only) 

Works with the Deferral Slot parameter to determine the average 
back-off time when the channel is busy. You may want to 
increase the number to prioritize the channel access for nodes 
that have been waiting the longest to access the channel or you 
may need to decrease the number to minimize initial back-off 
delays. You can set this parameter to 1, 3, 7, or default. 

Fragment Size Specifies the maximum fragment size that can be sent over the 
radio during interference (fragments are created when errors 
occur in transmission). You may want to set a smaller fragment 
size if your environment has a high level of interference. You can 
set this parameter to a value from 1 to 1540. 

Transmit Mode Modulates the transmit signal and sets the bits per second. 
AUTO automatically adapts the bit rate to the error conditions. 
The transmit mode is automatically selected for the best range 
and throughput. 

BFSK (Binary Frequency Shift Keying) transmits at 0.8 Mbps. 
Data is transmitted by shifting between two frequencies to 
represent one bit of 0 or 1. BFSK has extended range over QFSK 
at the expense of throughput. 

QFSK (Quadrature Frequency Shift Keying) transmits at 1.6 
Mbps. Data is transmitted by shifting among four frequencies to 
represent two bits of 0 or 1. QFSK has better throughput than 
BFSK at the expense of range. 

Normal Ack Retry Controls the number of times an unfragmented frame is resent 
unsuccessfully before fragmenting. You can set the parameter to 
a value from 1 to 255. The default is 255, which allows the radio 
to choose an optimal value. 

The Norm Ack Retry count includes the Norm QFSK Retry 
count; therefore, Norm Ack Retry should be greater than Norm 
QFSK Retry. 
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Manual MAC Parameter Descriptions (continued) 

Parameter Explanation 

Fragment Ack Retry Controls the number of times a fragmented frame is resent 
unsuccessfully before fragmenting. You can set the parameter to 
a value from 1 to 255. The default is 255, which allows the radio 
to choose an optimal value. 

The Fragment Ack Retry count includes the Fragment QFSK 
Retry count; therefore, Fragment Ack Retry should be greater 
than Fragment QFSK Retry. 

Normal QFSK Retry When Transmit Mode is set to AUTO, this parameter controls 
the number of times that an unfragmented QFSK frame is resent 
unsuccessfully before switching to BFSK. You can set this 
parameter to a value from 1 to 255. 

Fragment QFSK 
Retry 

When Transmit Mode is set to AUTO, this parameter controls 
the number of times a fragmented QFSK frame is resent 
unsuccessfully before switching to BFSK. You can set this 
parameter to a value from 1 to 255. 

  

Configuring the 902 MHz Radio (2100 Only) 
The 902 MHz radio will communicate with other 902 MHz radios that 
have the same: 

• LAN ID. For help, see “Configuring the Spanning Tree Parameters” in 
Chapter 5. 

• Mode-Channel. 

If you configure an 902 MHz radio as a master radio, it provides 
simultaneous master and station support. This feature means that not only 
do you only need one radio in WAPs and point-to-multipoint bridges, but 
also it can “heal itself.” If the access point can no longer communicate with 
the Ethernet network, it will try to wirelessly connect to the root through 
another access point. Any access point that may become a WAP should 
have a root priority set to 0 and have a secondary LAN bridge priority. 

To configure the 902 MHz radio 

1 From the main menu, click 902 MHz Radio. The 902 MHz Radio 
screen appears. 
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2 Configure the parameters for the radio. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

902 MHz Radio Parameter Descriptions 

Parameter Explanation 

Port Control Enable or disable the 902 MHz port. 

Mode-Channel Sets the bit rate option. Generally, the higher the bit rate, the 
lower the range of the access point. Mode-Channel defines a 
frequency range that is a small portion of the available 
bandwidth. 

Mode-Channel displays the list of mode and channel 
combinations available on the access point. Mode-Channel 
options are country-dependent.  

These combinations are valid in the United States: 

DS 225K-Channel 25 uses one direct-sequenced channel at 
225,000 bits per second. This one moderate-speed channel uses 
all available bandwidth. 

DS 090K-Channels 10 through 40 use one of several direct-
sequenced channels at 90,000 bits per second. Seven low-speed 
channels share the available bandwidth. 

DS 450K-Channel 25 uses one direct-sequence channel at 
450,000 bits per second. This one high-speed channel uses all 
available bandwidth. 

Multicast Filter Determines if this radio can receive and send multicast frames. 

File Name Specifies the name of the radio’s driver software. Intermec 
recommends that you change this name only when directed to 
do so by Intermec Technical Support. 

Hello Period Controls how frequently the access point broadcasts hello 
messages on this radio port. Hello messages help maintain the 
spanning tree and serve as beacon messages to synchronize 
communications with end devices. 
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Configuring the Spanning 
Tree 

This chapter explains how to configure the MobileLAN access products so 
that they create a spanning tree topology. This chapter covers these topics: 

• About the access point spanning tree 

• Configuring the spanning tree parameters 

• About IP tunnels 

• Configuring IP tunnels 

• Filter examples 

• Comparing IP tunnels to mobile IP 

• Configuring global parameters 

5 
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About the Access Point Spanning Tree 
MobileLAN access products with the same LAN ID arrange themselves 
into a self-organized network using a spanning tree topology. The 
spanning tree provides efficient, loop-free forwarding of frames through 
the network and allows efficient roaming of wireless end devices. It 
contains at least a primary LAN and a root access point, but it may also 
contain secondary LANs, designated bridges, and other access points.  

 

Root

Designated 
bridge

Primary LAN
(root IP subnet)

Secondary LAN
(remote IP subnet)

21XXT074.eps

Host

 

This spanning tree contains a root access point on the primary LAN and a designated 
bridge on the secondary LAN. 

Within the spanning tree, access points use Intermec’s IAPP (Inter Access 
Point Protocol) or secure IAPP to communicate with each other across the 
Ethernet network, over wireless secondary LANs, and through IP tunnels 
to remote IP subnets. IAPP also enables fast roaming in an 802.11b or 
802.11a network using 802.1x security. Secure IAPP prevents 
unauthorized MobileLAN access products from joining the spanning tree. 

For example, when an end device roams to a new access point, the new 
access point informs the old access points via the root access point that any 
traffic for the end device needs to be routed to the new access point. As 
end devices are added to or removed from the network, access points are 
automatically updated so they can maintain reliable operation and 
communication.  
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About the Primary LAN and the Root Access Point 
The primary LAN (also called the root IP subnet) contains the root access 
point, which initiates the spanning tree. When choosing the primary LAN, 
ideally you should choose the IP subnet that contains gateways or servers 
for the wireless end devices. However, these gateways and servers may also 
be on another subnet. 

The root coordinates the network and distributes common system 
parameters to other access points and end devices. The root is elected from 
a group of access points that are designated as root candidates (access 
points that are powered on, active, and do not have a root priority of 0). 
The root should not be an access point that handles a large volume of 
wireless traffic. The access point with the highest root priority is the root. 

The election process also occurs in the event of a root access point failure. 
Besides the root, you should have two or three access points with a non-
zero root priority. If two access points have the same root priority, the 
access point with the highest Ethernet address becomes the root. You 
should configure your network with overlapping coverage so that the 
network can automatically recover from any single point of failure. 

After the root access point is elected, it transmits hello messages on all 
enabled ports. The spanning tree forms as other access points receive hello 
messages and attach to the network on the optimal path to the root. A 
non-root access point also transmits hello messages after it is attached to 
the network. Each hello message contains the LAN ID of the access point 
that originated the message. IAPP does not allow wireless links to exist 
between access points that do not have matching LAN IDs. 

To configure a root access point 

1 On an access point that is installed on the primary LAN, from the main 
menu click Spanning Tree Settings. The Spanning Tree Settings screen 
appears. 

2 Configure the LAN ID. All access points that want to participate in the 
spanning tree must have the same LAN ID. 

3 Set the Root Priority parameter to be the highest number of all access 
points on the primary LAN. Verify that the Enable Ethernet Bridging 
check box is checked. 

4 Verify that the Secondary LAN Bridge Priority is zero and the 
Secondary LAN Flooding parameter is Disabled. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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About Secondary LANs and Designated Bridges 
There are two types of secondary LANs: a wireless secondary LAN is 
connected to the primary LAN wirelessly via a WAP, and a remote IP 
subnet is connected via an IP tunnel.  

Comparison of Wireless Secondary LANS and Remote IP Subnets 

Wireless Secondary LANs (WAPs) Remote IP Subnets (IP Tunnels) 

Any access point can provide a wireless 
link to another access point. 

Only the root access point can originate an 
IP tunnel to another access point. 

A wireless link provides a transparent 
bridge for both wired and wireless 
devices. 

An IP tunnel provides a transparent bridge 
for wireless end devices on a remote IP 
subnet.  

  

The access point that is responsible for bridging data between a secondary 
LAN and the primary LAN is called the designated bridge. The designated 
bridge must be an access point: 

• on the secondary LAN. 

• with the Secondary LAN Bridge Priority value set to a non-zero 
number. 

• with at least one radio set to Station mode or that is the endpoint of an 
IP tunnel. For more information, see “About IP Tunnels” on page 115. 

If more than one access point meets these requirements, the access point 
with the highest secondary LAN bridge priority is the designated bridge. If 
two access points have the same secondary LAN bridge priority, the access 
point with the highest Ethernet address becomes the designated bridge. If 
the designated bridge goes offline, the remaining access points negotiate to 
determine which access point becomes the new designated bridge. 

To configure a designated bridge 

1 On an access point that is installed on the secondary LAN and within 
radio coverage of an access point on the primary LAN, from the main 
menu click Spanning Tree Settings. The Spanning Tree Settings screen 
appears. 

2 Configure the LAN ID. All access points that want to participate in the 
spanning tree must have the same LAN ID. 

3 Set the Root Priority parameter to zero. All access points on the 
secondary LAN should have a root priority of zero. 

4 Verify that the Enable Ethernet Bridging check box is checked. 

5 Set the Secondary LAN Bridge Priority to be the highest number of all 
access points on the secondary LAN. 
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6 Set the Secondary LAN Flooding parameter to Enabled. 

7 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

About Data Link Tunneling 
Data link tunneling passes data from wireless end devices communicating 
with access points on the same subnet to the root access point or 
designated bridge. Use data link tunneling if you have Ethernet switches 
that do not support the IEEE 802.1d requirements for backward learning. 
Some proprietary VLAN switches and ATM LANE bridges do not support 
this standard.  

If the access points are connected to different ports on an Ethernet switch, 
each time an end device roams to a new access point, it appears on a 
different port. Thus, frames sent to the end device from the host will be 
sent to the wrong port. If the switch does not support 802.1d, it may 
become confused and communications with the end device is disrupted. 
Data link tunneling makes end device roaming transparent to the switch. 
All the information appears to originate from only one port on the switch–
the port that is connected to the root access point or designated bridge. 

You should also use data link tunneling when you are using IP tunnels to 
provide mobility of other routable protocols, such as IPX. In some 
network installations, detecting these addresses may generate alarms or 
cause switches to behave erroneously. There is no additional forwarding 
overhead for disabling bridging in this situation. 

To enable data link tunneling, disable Ethernet bridging. When an access 
point receives data from an end device, it encapsulates the data into an 
OWL data frame. This frame is then forwarded via the Ethernet port to 
the next access point on the path and so on until the frame reaches the 
root access point or designated bridge. The root access point or designated 
bridge unencapsulates the frame and forwards it to the host. When the 
root access point or designated bridge receives data on the Ethernet 
network for an end device, it reverses this process.  

Unless you need to use data link tunneling, Intermec recommends that 
you enable Ethernet bridging on all access points. Data link tunneling 
increases network traffic. 

To enable data link tunneling on the primary LAN 

1 Make sure that all access points have the same LAN ID. 

2 On the root access point, on the Spanning Tree Settings screen verify 
that the Enable Ethernet Bridging check box. is checked. 
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3 On all other access points on the primary LAN, clear the Enable 
Ethernet Bridging check box.  

4 Make sure that the Root Priority parameter. for all other access points 
is less than the root access point. 

To enable data link tunneling on the secondary LAN 

1 Make sure that all access points have the same LAN ID as the ones on 
the primary LAN. 

2 On the designated bridge, on the Spanning Tree Settings screen verify 
that the Enable Ethernet Bridging check box is checked.  

3 On all other access points on the secondary LAN, clear the Enable 
Ethernet Bridging check box.  

4 Make sure that the Secondary LAN Bridge Priority parameter for all 
other access points is less than the designated bridge. 

If you use data link tunneling on the secondary LAN and end devices have 
IP addresses on the secondary LAN, network monitoring tools and other 
network components cannot detect their MAC/IP addresses. For more 
information, see “About IP Tunnels” on page 115. 

About Routable and Non-Routable Network Protocols 
Hosts that use a routable network protocol such as IP or IPX may be 
located on any IP subnet; however, triangular routing can be minimized if 
servers are located on the root IP subnet. (Note that this is also true for 
standard mobile IP.) You should be able to use default flooding and 
spanning tree settings if you are using routable protocols, even if hosts are 
located on remote IP subnets. 

Some Intermec wireless end devices use the Intermec NNL protocol, 
which is a simple Non-routable Network Layer protocol. This NNL 
protocol is used to carry high-layer data in a local area network 
environment. An Intermec NNL gateway forwards NNL traffic to non-
NNL hosts such as TCP/IP hosts. If NNL gateways are located on the root 
IP subnet, you can use the default flooding and spanning tree settings, and 
minimize triangular routing. If NNL gateways are located on remote IP 
subnets, you must enable outbound multicast flooding and secondary 
bridging. 
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Configuring the Spanning Tree Parameters 
When you configure the spanning tree parameters, you identify the access 
point as part of the spanning tree. That is, you specify if this access point is 
a root or a backup root or a designated bridge or a backup designated 
bridge, uses data link tunneling to encapsulate wireless traffic or if wireless 
traffic gets dumped raw on the Ethernet network. 

On the designated bridge, if you enable Ethernet bridging, wireless traffic 
gets dumped raw on the secondary LAN. If you disable Ethernet bridging 
or if you set the secondary LAN bridge priority to 0, wireless traffic is 
encapsulated on the secondary LAN, which eliminates communication 
from wired devices on the secondary LAN.  

To configure the spanning tree parameters 

1 From the main menu, click Spanning Tree Settings. The Spanning 
Tree Settings screen appears. 

   

2 Configure the spanning tree parameters. For help, see the next table.  

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

4 (Optional) Configure security by clicking Spanning Tree Security. For 
help, see “Establishing Secure Communications Between Access Points” 
in Chapter 6. 
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Spanning Tree Parameter Descriptions 

Parameter Explanation 

AP Name Enter a unique name for this access point. The name can be 
from 1 to 16 characters. The default is the access point serial 
number. 

If this access point has an OpenAir master radio, only the first 11 
characters are used. 

LAN ID (Domain) Enter the LAN ID. All access points must have the same LAN 
ID to participate in the same spanning tree. The LAN ID is a 
number from 0 to 254. 

If you are using OpenAir radios, all OpenAir devices in a 
network must have the same LAN ID to be able to 
communicate. Also, if you assign a LAN ID greater than 15, the 
access point uses a LAN ID that is the remainder after dividing 
the LAN ID by 16. For example, if you set the LAN ID to 21 or 
37, the access point uses 5. 

Root Priority Determines if this access point is a candidate to become the root 
of the spanning tree. The access point with the highest root 
priority becomes the root whenever it is powered on and active.  

The root priority can be a value from 0 to 7. If you set the root 
priority to 0, the access point can never become the root access 
point. 

For more information, see “About the Primary LAN and the 
Root Access Point” on page 109. 

 

Note: If your network contains 6710 and MobileLAN access 
products, configure a MobileLAN access product as the root. 

Enable Ethernet 
Bridging  

Determines how frames from end devices are dumped on the 
Ethernet network and vice versa. Check this check box if you 
want frames to be forwarded directly to the Ethernet network. 
Intermec recommends that you enable this parameter on all 
access points. 

Enabling this parameter on the root or designated bridge and 
disabling it on all other access points on the same IP subnet will 
enable data link tunneling on the IP subnet. For help, see 
“About Data Link Tunneling” on page 111. 

Enable GVRP for 
VLAN  

The access point uses GARP VLAN Registration Protocol 
(GVRP) to request a VLAN-capable Ethernet switch to forward 
traffic for specific VLANs.  

Enabling this parameter lets the switch exchange VLAN 
configuration information with other GVRP switches, prune 
unnecessary broadcast, prune unknown unicast traffic, and 
dynamically create and manage VLANs on switches connected 
through 802.1Q trunk ports. 

A switch may also be configured statically to always forward 
specific VLANs to specific ports. You should clear this check box 
for a static configuration. 
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Spanning Tree Parameter Descriptions (continued) 

Parameter Explanation 

Secondary LAN 
Bridge Priority 

Determines when this access point can become the designated 
bridge in a secondary LAN. The access point that meets all the 
other requirements and has the highest secondary LAN bridge 
priority becomes the designated bridge. 

The secondary LAN bridge priority can be a value from 0 to 7. If 
you set this value to 0, the access point can never become the 
designated bridge. 

For more information, see “About Secondary LANs and 
Designated Bridges” on page 110. 

Secondary LAN 
Flooding 
(Outbound) 
(Designated bridge 
only) 

Specifies the types of frames it forwards from the primary LAN 
to the secondary LAN. 

Choose Disabled if no flooding occurs unless the root access 
point (in the Global Flooding screen) enables the Multicast or 
Unicast Outbound to Secondary LANs parameter. 

Choose Enabled if multicast and unicast flooding occurs unless 
the root access point (in the Global Flooding screen) disables 
multicast or unicast flooding. 

Choose Multicast if multicast flooding occurs unless the root 
access point (in the Global Flooding screen) disables multicast 
flooding. 

Choose Unicast if unicast flooding occurs unless the root access 
point (in the Global Flooding screen) disables unicast flooding. 

  

About IP Tunnels 
The physical boundary of a network is usually defined by the existence of 
an IP router. Before IP tunnels technology was developed, wireless end 
devices could only operate within the limited coverage area of their own 
network and could not roam across IP subnet boundaries. Using IP tunnel 
technology, end devices can roam across IP subnet boundaries. IP tunnel 
technology safely and transparently coexists with routed IP installations 
while supporting mobility for end devices. IP tunnels do the following: 

• Enable access points on different remote IP subnets to belong to the 
same wireless network.  

• Support fast roaming of end devices between access points that are on 
different IP subnets without losing network connections.  

• Support end devices using both IP and other routable or nonroutable 
protocols. 
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Only one IP tunnel can exist between the root access point and an access point (usually 
the designated bridge) on a remote IP subnet. The root access point has a one-to-one 
relationship with each wireless network. All roaming end devices must have an IP 
address from the root IP subnet. 

IP tunnels use encapsulation to establish a virtual LAN segment through 
IP routers. The virtual LAN segment includes the root IP subnet and 
logically extends to include end devices attached to access points on remote 
IP subnets. IP tunnels are branches in the spanning tree topology. 

Any access point on a secondary LAN that can receive IP hello messages 
can be the endpoint of an IP tunnel. Usually, the access point that is the 
endpoint of an IP tunnel is also the designated bridge. After an IP tunnel is 
formed between the root access point and an access point on a remote IP 
subnet, end devices can roam to the remote IP subnet. End devices must 
have an IP address from the root IP subnet. However, there are no address 
restrictions for non-IP end devices. When end devices roam to the remote 
IP subnet, their data is IP tunneled back to the root IP subnet (where it 
belongs) and everything works properly. 

If you have a DHCP server in your network, it must be on the root IP 
subnet. All access points on secondary LANs must have permanent IP 
addresses. On the root access point, you must allow IP multicast frames to 
pass. 
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When an access point at the endpoint of the IP tunnel receives data from 
an end device, it uses a standard IP protocol called Generic Router 
Encapsulation (GRE) to encapsulate the data into a frame. These 
encapsulated IP/GRE frames use normal IP routing to pass through IP 
routers to the root access point. The root access point unencapsulates the 
frame and forwards it to the host. When the root access point receives data 
on the Ethernet network for an end device that is communicating on a 
remote IP subnet, it reverses this process. 

IP tunneling also allows non-routable traffic, such as WTP and NNL, to 
roam across routers. The end devices using these protocols are not IP 
based, but they work in the same way. Data traffic that is not passed by 
routers (since they are not IP) will be tunneled from the remote IP subnet 
to the root subnet. It will be dumped on the Ethernet on the root subnet 
(where it belongs) and everything works properly. 

Creating IP Tunnels 
An IP tunnel is established when an access point on a remote IP subnet 
attaches to the root access point through its IP tunnel port. The number of 
IP tunnels the root access point can originate is practically unlimited. 
However, currently the IP address list can only contain eight entries, 
which effectively limits the number of tunnels that can be created if you 
want to use unicast and directed broadcast IP addresses.  

The IP address list can contain any combination of IP unicast, IP 
broadcast, or IP multicast addresses: 

• Only one IP tunnel can be created for each IP unicast address in the list.  

• One IP directed broadcast address can be used to create a practically 
unlimited number of tunnels to a single remote IP subnet. (An IP 
directed broadcast address is typically used to specify all hosts on a single 
remote subnet.)  

• One IP multicast address can be used to create a practically unlimited 
number of tunnels to remote IP subnets. For help, see “Using One IP 
Multicast Address for Multiple IP Tunnels” on page 119. 

Once you have configured the IP tunnels, the root access point sends IP 
hello messages to each IP address in its IP address list. An IP tunnel is 
automatically established when an access point on a remote IP subnet 
receives this hello message. This access point then transmits IP hello 
messages on its subnet so that other access points on the same subnet that 
do not receive hello messages can also attach to the spanning tree. 
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To create a unicast IP tunnel 

1 Make sure that end devices that will roam between the root IP subnet 
and the remote IP subnet have IP addresses from the root IP subnet and 
have their default router set the same as the root access point. There are 
no address restrictions for non-IP end devices. 

2 Make sure that the root access point and the access point at the 
endpoint of the IP tunnel have the same LAN ID. 

3 On the root access point, set the Mode parameter to Originate if Root. 
For help configuring a root access point, see “About the Primary LAN 
and the Root Access Point” on page 109. 

4 On the access point at the endpoint of the IP tunnel, set the Mode 
parameter to Listen. 

5 On the root access point, click IP Tunnels > IP Addresses. Enter the 
IP address or DNS name of the access point at the endpoint of the IP 
tunnel. 

6 On the root access point and the access point at the endpoint of the IP 
tunnel, click Frame Type Filters. If you have end devices 
communicating using IP, set these DIX filters to Pass: 

• DIX-IP-TCP Ports 

• DIX-IP-UDP Ports 

• DIX-IP-Other Protocols 

• DIX-IPX Sockets 

• DIX-Other EtherTypes 

7 On the root access point and the access point at the endpoint of the IP 
tunnel, click Predefined Subtype Filters. If you have end devices 
communicating using IP, set these filters to Pass: 

• DIX ARP 

• ICMP 

8 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Using One IP Multicast Address for Multiple IP Tunnels 
IP tunneling supports IP multicast and Internet Group Management 
Protocol (IGMP). IP multicast provides an ideal way to distribute IP hello 
messages. These hello messages are only forwarded to those IP subnets and 
IP hosts (such as access points) that participate in the multicast group. IP 
multicast has these advantages:  

• You do not have to know the unicast or directed broadcast IP addresses 
in advance. 

• IP multicast provides better built-in redundancy than IP unicast, 
because any access point can establish an IP tunnel. 

IGMP is a standard protocol that lets you originate multiple IP tunnels 
using one IP multicast address. It allows IP multicast frames to be routed 
to remote IP subnets that have hosts participating in the multicast group. 
Note that IGMP is independent of IP; it can be used to facilitate multicast 
for IP or any other application. IGMP has these advantages: 

• Causes IP hello messages to be forwarded only to those subnets that 
participate in the IP multicast group 

• Increases redundancy because multiple access points on a remote subnet 
can receive IP hello messages 

IP routers only forward multicast frames to those subnets that have IP 
hosts that participate in the respective IP multicast group. An IP host uses 
IGMP to notify IP routers that it wants to participate in an IP multicast 
group.  

Access points can act as IP hosts and participate in an IP multicast group 
by enabling IGMP. The Internet Assigned Numbers Authority has 
allocated 224.0.1.65 for Intermec’s Inter Access Point protocol (IAPP). 
You must enter this address in the IP address list in the root access point. 
(Note that the address list may contain other IP addresses.) and in the 
Multicast Address field in the other access points. 

If you enable IGMP on the root access point, the root access point uses a 
Class D IP multicast address to send IP hello messages through IP routers 
to access points on other subnets. If you enable IGMP on remote IP 
subnets, intermediate IP routers will forward the IP hello messages to those 
subnets. Normally, you should enable IGMP and configure the IP 
multicast address in at least one access point on each remote IP subnet. 
(Some routers can provide proxy IGMP services for IP hosts.)  
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To create a multicast IP tunnel 

1 Make sure that end devices that will roam between the root IP subnet 
and the remote IP subnet have IP addresses from the root IP subnet and 
their default router is set the same as the root access point. There are no 
address restrictions for non-IP end devices. 

2 Make sure that your routers are configured to pass multicast frames. 

3 Make sure that the root access point and the access point at the 
endpoint of the IP tunnel have the same LAN ID. 

4 On the root access point, set the Mode parameter to Originate if Root. 
For help configuring a root access point, see “About the Primary LAN 
and the Root Access Point” on page 109. 

5 On the access point at the endpoint of the IP tunnel, set the Mode 
parameter to Listen. 

6 On the root access point, click IP Tunnels > IP Addresses. Enter the 
Intermec multicast address 224.0.1.65. 

7 On the access point at the end of the IP tunnel, check the Enable 
IGMP check box. 

8 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

How Frames Are Forwarded Through IP Tunnels 
The access point maintains a forwarding database of all MAC addresses, 
and it knows the correct port for each MAC address. The access point 
updates this database by monitoring source addresses on each port 
(backward learning), by receiving explicit attachment messages, and by 
examining messages exchanged between access points when end devices 
roam. The database also includes the power management status of each 
end device, which allows the access point to support the pending message 
feature of the network. The forwarding database allows the Ethernet 
bridging software to make efficient forwarding decisions. 

Any frame that is sent through an IP tunnel is addressed to the unicast IP 
address of the access point at the other end of the tunnel. An access point 
at the remote end of the tunnel learns the unicast IP address of the root 
access point by listening to IP hello messages. The root access point learns 
the unicast IP address of a remote access point when the access point 
attaches to the network. 
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Outbound Frames 
Frames are forwarded outbound (to a secondary LAN) through an IP 
tunnel if: 

• an end device is known to be attached to an access point on a remote IP 
subnet. 

• the frame type is configured to pass. 

IP and ARP frames are never forwarded outbound through an IP tunnel 
unless the destination IP address belongs to the root IP subnet. Usually, 
these frames are destined for wireless end devices that have roamed away 
from their root IP subnet. 

Unicast frames are not flooded. Unicast frames are only forwarded 
outbound through an IP tunnel if the destination address identifies an end 
device that has roamed to a remote IP subnet. End devices attach to the 
root access point, which maintains entries for these devices in its 
forwarding database. The database entries indicate the correct subnet for 
outbound forwarding. 

For TCP/IP applications, IP and ARP frames must be forwarded through 
IP tunnels. An IP or ARP frame is only forwarded outbound if the 
destination address identifies an end device on the root IP subnet. Usually, 
ARP requests (which are multicast frames) that originate on the root IP 
subnet are forwarded outbound to all devices on the network, including 
through IP tunnels to remote IP subnets. However, if you enable ARP 
flooding, ARP frames are only sent through the IP tunnel to the 
destination end device. 

MAC frames that are forwarded outbound are encapsulated in the root 
access point, forwarded through the network, unencapsulated by the access 
point at the remote end of the IP tunnel, and forwarded to the appropriate 
access point (if necessary) for delivery to the destination end device. 

Inbound Frames 
Frames are forwarded inbound (to the primary LAN) through an IP 
tunnel if: 

• an end device is known to be attached to an access point on a remote IP 
subnet. 

• the frame type is configured to pass. 

IP and ARP frames are only forwarded inbound through the IP tunnel if 
the source IP address belongs to the root IP subnet. Usually, these frames 
originate from wireless end devices that have roamed away from their root 
IP subnet. Frames transmitted by servers or wired devices that are 
connected to a remote IP subnet are not forwarded inbound through IP 
tunnels if the IP address does not belong to the root IP subnet.  
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MAC frames that are forwarded inbound are encapsulated by the access 
point at the remote end of the IP tunnel, forwarded through the IP tunnel 
to the root access point, unencapsulated, and placed on the network. 

Frame Types That Are Never Forwarded 
Certain frame types are never forwarded through IP tunnels. Frame types 
that are never forwarded include IP frames used for coordinating routers 
and MAC frames used for coordinating bridges. Other frame types that are 
never forwarded include: 

• 802.1d bridge frames 

• Proprietary VLAN switch frames 

• IP frames with a broadcast or multicast Ethernet address 

• IP frames with the following router protocol types and decimal values: 

• DGP (86) (Dissimilar Gateway Protocol) 

• EGP (8) (Exterior Gateway Protocol) 

• IDPR (35) (Inter-Domain Policy Routing Protocol) 

• IDRP (45) (Inter-Domain Routing Protocol) 

• IGP (9) (Interior Gateway Protocol) 

• IGRP (88) 

• MHRP (48) (Mobile Host Routing Protocol) 

• OSPFIGP (89) (Open Shortest Path First Interior Gateway Protocol) 

• IP ICMP (Internet Control Message Protocol) types: 

• IPv6 

• Mobile IP 

• Router Advertisement 

• Router Selection 

• IP/UDP (User Datagram Protocol) frames with the following 
destination protocol port numbers: 

• BGP (179) (Border Gateway Protocol) 

• RAP (38) (Route Access Protocol) 

• RIP (520) (Routing Information Protocol) 

• IP/TCP frames with the following destination or source protocol port 
numbers: 

• BGP (179) (Border Gateway Protocol) 

• RAP (38) (Route Access Protocol) 
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Configuring IP Tunnels 
For guidelines, see “About IP Tunnels” on page 115. 

To configure the IP Tunnels screen 

1 From the main menu, click IP Tunnels. The IP Tunnels screen 
appears. 

   

2 Configure the IP tunnels parameters. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

IP Tunnel Parameter Descriptions 

Parameter Explanation 

Mode Choose Originate if Root to let the root access point and root 
candidates originate the IP tunnel if they are functioning as the 
root access point for the network.  

Choose Listen to configure access points that are designated 
bridges or designated bridge candidates for their remote IP 
subnets to serve as the endpoint of an IP tunnel. 

Choose Disabled to disable the IP tunnel port. 

Allow IP Multicast 
(Originate if Root)  

Determines if the root access point should forward IP multicast 
frames through its IP tunnels. Check this check box if you have a 
DHCP server issuing TCP/IP information to end devices. 

Enable IGMP 
(Listen)  

Determines if IGMP is enabled or disabled.  

Multicast Address 
(Enable IGMP 
checked only)  

Enter the Class D IP multicast address. You also need to enter 
this IP address in the root access point’s IP address list. The 
Internet Assigned Numbers Authority has allocated 224.0.1.65 
for Intermec’s inter-access-point protocol (IAPP). 
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Configuring the IP Address List 
On the root access point and root candidates, the IP address list contains 
the IP addresses of all the access points at the endpoint of the IP tunnels. 

To configure the IP address list 

1 From the main menu, click IP Tunnels > IP Addresses. The IP 
Addresses screen appears. 

   

2 If you enabled IGMP, enter the Class D IP multicast address. The 
default is 224.0.1.65. 

3 Enter the IP addresses or DNS names of all the access points that can be 
the endpoints of IP tunnels. 

4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Configuring IP Tunnel Filters 
You can set both Ethernet and IP tunnel filters, and you can create 
protocol filters for predefined protocol types. In addition, you can define 
arbitrary frame filters based on frame content.  

By default, all IP tunnel traffic (except NNL traffic) is dropped. IP tunnel 
filters are only outbound filters. That is, when you configure IP tunnel 
filters in the root access point, you are only defining what type of traffic 
the root will send through the tunnel. The root will receive anything sent 
to it by the access point at the endpoint of the tunnel. The access point at 
the endpoint of the tunnel acts the same way. In order for a particular type 
of traffic to pass, you need to set the same filters to pass in both in the root 
access point and in the access point at the endpoint of a tunnel.  

For help configuring Ethernet filters, see “Configuring Ethernet Filters” in 
Chapter 3. 
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Using IP Tunnel Frame Type Filters 
The IP tunnel port automatically provides some filtering for wireless end 
devices. You can define permanent IP tunnel port filters to prevent 
unwanted frame forwarding through an IP tunnel. ICMP frames with the 
following types are always forwarded: 

• Echo Request • Parameter Problem 

• Echo Reply • Time Stamp 

• Destination Unreachable • Time Stamp Reply 

• Source Quench • Address Mask Request 

• Redirect • Address Mask Reply 

• Alternate Host Address • Trace Route 

• Time Exceeded  

IP and ARP frames are never forwarded inbound through an IP tunnel to 
the root IP subnet unless the source IP address belongs to the root IP 
subnet. (Frames are only forwarded inbound if the source IP address in the 
IP or ARP frame identifies an end device that has roamed away from its 
root IP subnet.) IP and ARP frames are never forwarded outbound 
through an IP tunnel by the root access point unless the destination IP 
address belongs to the root IP subnet. (Frames are only forwarded 
outbound to end devices that have roamed away from the root IP subnet.) 
For detailed information about other frame types that are never forwarded, 
see “Frame Types That Are Never Forwarded” earlier in this chapter.  

You can set the default action and scope for general and specific frame 
types: 

Allow/ 
Pass 

Check or clear this check box. Check this check box to pass all frames of the 
type. Clear this check box to drop all frames of the type. 

Scope Set scope to Unlisted or All. If you select All, then all frames of that type are 
unconditionally passed or dropped, depending on the action you specified. If 
you select Unlisted, then frames are passed or dropped only if the frame type 
is not listed in the predefined or customizable tables. 
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To use IP tunnel frame type filters 

1 From the main menu, click IP Tunnels > Frame Type Filters. The 
Frame Type Filters screen appears. 

   

2 For each frame type field, check or clear the check box to configure if 
the frame types are passed or are dropped. If you check the check box, 
the frame type is allowed to pass. 

For each frame type field, set the Scope field to Unlisted or All. 

For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

4 If you set the Scope field to Unlisted for any of the frame types, you 
must also configure predefined subtype filters or customizable subtype 
filters. For help, see “Using Predefined Subtype Filters” on page 127 or 
“Customizing Subtype Filters” on page 128. 
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Frame Type Filter Descriptions 

Frame Type Explanation 

DIX IP TCP Ports 
DIX IP UDP Ports 
SNAP IP TCP Ports 
SNAP IP UDP Ports 

Primary Internet Protocol Suite (IP) transport 
protocols. 

DIX IP Other Protocols 
SNAP IP Other Protocols 

IP protocols other than TCP or User Datagram 
Protocol (UDP). 

DIX IPX Sockets Novell NetWare protocol over Ethernet II frames. 

SNAP IPX Sockets Novell NetWare protocol over 802.2 SNAP frames. 

802.3 IPX Sockets Novell NetWare protocol over 802.3 RAW frames. 

DIX Other Ethernet Types 
SNAP Other Ethernet Types 

DIX or SNAP registered protocols other than IP or 
IPX. 

802.2 IPX Sockets Novell running over 802.2 Logical Link Control 
(LLC). 

802.2 Other SAPs 802.2 SAPs other than IPX or SNAP. 

  

 
Note: You should not filter HTTP, Telnet, SNMP, and ICMP frames if 
you are using IP tunnels, because these filters are used for configuring, 
troubleshooting, and upgrading access points. 

Using Predefined Subtype Filters 
You can configure the access point to pass or drop certain predefined 
frame subtypes. 

To configure predefined subtype filters 

1 From the main menu, click IP Tunnels > Predefined Subtype Filters. 
The Predefined Subtype Filters screen appears. 
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2 For each frame subtype field, check or clear the check box to configure 
if the frame subtypes are passed or are dropped. If you check the check 
box, the frame subtype is allowed to pass. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Customizing Subtype Filters 
You can define output filters that restrict customized frame subtypes that 
can pass through an IP tunnel. Frames can be filtered by the DIX, 802.2, 
or 802.3 SNAP type, the IP protocol type, or the TCP or UDP port 
number. By default, the filters drop all protocol types except the NNL 
DIX Ethernet type (hexadecimal 875B). Filters must be configured in all 
root candidates and in any access point that can attach to the remote end 
of an IP tunnel.  

You define the action, subtype, and value parameters in customized filters: 

Allow/ 
Pass 

Check or clear this check box. Check this check box to pass all frames of the 
subtype and value. Clear this check box to drop all frames of the subtype and 
value. 

Subtype Selects the frame subtype you wish to configure. 

Value The following table describes frame subtypes and their values. The value 
must be two hex pairs. When a match is found between frame subtype and 
value, the specified action is taken. 

  

To customize subtype filters 

1 From the main menu, click IP Tunnels > Customizable Subtype 
Filters. The Customizable Subtype Filters screen appears. 
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2 For each frame subtype field, check or clear the check box to configure 
if the frame subtypes are passed or are dropped. If you check the check 
box, the frame subtype is allowed to pass. 

3 In the SubType field and choose the customizable frame subtype. For 
help, see the next table. 

4 In the Value field enter the two hex pairs. For help, see the next table. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Subtype Filter Descriptions 

Subtype Value 

DIX-IP-TCP-Port Port value in hexadecimal. 

DIX-IP-UDP-Port Port value in hexadecimal. 

DIX-IP-Protocol Protocol number in hexadecimal. 

DIX-IPX-Socket Socket value in hexadecimal. 

DIX-EtherType Specify the registered DIX type in hexadecimal. 

SNAP-IP-TCP-Port Port value in hexadecimal. 

SNAP-IP-UDP-Port Port value in hexadecimal. 

SNAP-IP-Protocol Port value in hexadecimal. 

SNAP-IPX-Socket Socket value in hexadecimal. 

SNAP-EtherType SNAP type in hexadecimal. To filter on both SNAP type and 
OUI, use advanced filters. 

802.3-IPX-Socket Socket value in hexadecimal. 

802.2-IPX-Socket Socket value in hexadecimal. 

802.2-SAP 802.2 SAP in hexadecimal. 
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Filter Examples 
These examples illustrate how to set both Ethernet and IP tunnel filters to 
optimize network performance. The next illustration includes: 

• wireless end devices using TCP/IP to communicate with other devices. 

• a secondary LAN containing IP and IPX hosts, linked by AP2 and AP4. 

• an IPX router connecting to another Novell network. 

• DIX and 802.3 SNAP frames. 

Root
(AP1)

 IP Host Novell Server

AP3 

IPX Router

AP2 

Designated
bridge (AP4)

AP5 AP6 

 IP Host  IPX Host

Primary LAN
(root IP subnet)

Secondary LAN
(remote IP subnet)

21XXT027.eps  

This illustration shows a typical network that will be used in the next examples. 
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Example 1 
The root (AP1), AP3, AP5, and AP6 service only wireless end devices. 
These access points need to pass IP traffic, but not pass IPX traffic that 
does not need to be forwarded to the primary or secondary LAN.  

For this example, set these options on the Ethernet Frame Type Filters 
screen. No subtype filters are needed.  

  

Example 2 
AP2 and AP4 (designated bridge) service end devices and the IP host and 
IPX host on the secondary LAN. Also, these access points pass IPX traffic.  

The IPX router in this network periodically sends IPX RIP frames for 
coordinating with other routers. These do not need to be forwarded to the 
secondary LAN, because the secondary LAN does not contain a router. 

To filter the IPX RIP frames, you need to configure subtype filters. This 
example sets filters for three different cases: DIX, 802.2, and 802.3 SNAP 
frames. In many actual networks, only one type of filter is required, 
because all stations are configured using one of the three options. 
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For this example, set these options on the Ethernet Frame Type Filters 
screen.  

  

In the Predefined Subtype Filters screen, set the 802.2-IPX-RIP field to 
drop 802.2, DIX, and 802.3 frames.  
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Example 3 
If you have a DHCP server on a Windows NT server and you want to use 
this DHCP server to assign TCP/IP parameters to end devices on a remote 
IP subnet, you need to set these filters to allow for the necessary IP 
tunneling.  

1 On the root access point, set these filters: 

• On the IP Tunnels screen, check the Allow IP Multicast check box. 

• In the IP Tunnel Frame Type Filter table, configure DIX-IP-UDP 
Ports to pass all frames. 

2 On the access point at the endpoint of the IP tunnel, set this filter: 

• In the IP Tunnel Frame Type Filter table, configure DIX-IP-UDP 
Ports to pass all frames. 

Example 4 
If you have a Linux or Unix DHCP server and want to use this DHCP 
server to assign TCP/IP parameters to end devices on a remote subnet, you 
need to set this filter to allow for the necessary IP tunneling: 

• In the IP Tunnel Frame Type Filter table, configure DIX-IP-UDP Port 
to pass all frames. 
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Comparing IP Tunnels to Mobile IP 
MobileLAN access products support IP tunneling, which allows end 
devices to roam across different subnets (routers) without having to change 
IP addresses. IP tunneling supports IETF RFC 1701 using GRE and the 
same encapsulation technique as mobile IP. IP tunnels technology is 
designed primarily to operate in local environments, where handheld or 
vehicle-mounted devices may move rapidly between access point coverage 
areas on a subnet (although it is possible to attach a geographically remote 
subnet through an IP tunnel). 

The Internet Engineering Task Force developed RFC 2002, IP Mobility 
Support, commonly referred to as mobile IP, to provide mobility for IP 
hosts. Mobile IP is designed primarily to address the needs of wireless end 
devices that may move between geographically separated locations. 

The two technologies are complimentary and may coexist. Both protocols 
use similar encapsulation to forward frames to or from end devices that 
have roamed away from a root IP subnet. The root access point functions 
much like a mobile IP home agent; an access point attached to the remote 
end of an IP tunnel functions much like a mobile IP foreign agent.  

IP Tunnels and Mobile IP Comparison 

Issue IP Tunneling Mobile IP 

Software compatibility No changes are required to existing IP 
software stacks in end devices. 

Requires a mobile IP client software stack 
in end devices. 

Addressing limitations for 
IP end devices 

Requires that end device IP addresses 
belong to the root IP subnet. 

None. 

Security Guest addresses are not used. Data link 
security. 

Mobile IP authentication is required for 
“guest” access to foreign subnets. 

Roaming detection Data link indications facilitate fast roaming 
with no added broadcast traffic. 

Foreign agent advertisements. 

Roaming restrictions Currently, roaming is limited to a single 
network that may include multiple IP 
subnets. 

None. 

Roaming support for non-
IP protocols 

Configurable using IP filters. None. 

Scalability No practical limitations using IGMP. Has no inherent limitations. 

Special network software Standard network feature. No additional 
network software is required. 

Requires home and foreign agents located 
on each network or subnetwork. 
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Configuring Global Parameters 
Global parameters are configured on the root access point and on any 
other access point that is a root candidate (does not have a root priority of 
0). The root access point sends these settings to all other access points in 
the spanning tree. You should set the same global parameters for the root 
access point and its backup candidates. Any global parameters you set on 
the root access point will override those you set in other access points. 

Configuring Global Flooding 
When the destination address is unknown, most bridges flood frames on 
all ports. Most wireless end devices operate at lower speeds than the 
Ethernet can support, therefore, indiscriminate flooding from a busy 
Ethernet network can consume a substantial portion of the available 
wireless bandwidth and reduce system performance. On the access point, 
you can set flooding control options for both unicast and multicast frames 
to free up bandwidth and improve system performance.  

Access points try to forward frames to the port with the shortest path to 
the destination address. When the access point has not learned the 
direction of the shortest path, you can configure it to flood the frames in 
certain directions to try to locate the destination address.  

ARP requests are multicast frames that are periodically sent out to all 
devices on the Ethernet network. An ARP cache is a table of known MAC 
addresses and their IP addresses that the access point maintains. When an 
access point receives an ARP request, it checks its ARP cache to determine 
if the destination end device’s IP address is known.  
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To configure global flooding 

1 From the main menu, click Spanning Tree Settings > Global 
Flooding. The Global Flooding screen appears. 

   

2 Configure the Global Flooding parameters. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Global Flooding Parameter Descriptions 

Parameter Explanation 

Multicast Flooding Determines the flooding structure when this access point 
receives inbound multicast frames on non-root ports with 
unknown destination addresses. Choose Disabled if you do not 
want the access point to flood any inbound multicast frames. 

Choose Universal if the access point forwards the multicast 
frame to every port. This option uses more bandwidth. Use this 
option if the root access point is supporting more than one 
wireless hop to ensure that ARP requests and multicast traffic 
are distributed. 

Choose Hierarchical if the access point forwards the multicast 
frame only to the port to which the root access point is 
attached. 

Multicast Outbound 
to Secondary LANs 
(Multicast Flooding 
enabled) 

Specifies if outbound multicast frames with unknown 
destination addresses are flooded toward secondary LANs.  

Choose Enabled if the root access point controls flooding for 
all the designated bridges on secondary LANs. Enabling this 
parameter makes managing secondary LANs easier because you 
do not need to set secondary LAN flooding parameters. 

Choose Set Locally if the designated bridges control flooding 
on their LANs. 
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Global Flooding Parameter Descriptions (continued) 

Parameter Explanation 

Allow Multicast 
Outbound to 
Terminals (Multicast 
Flood Mode enabled) 

(802.11b, 802.11a, and OpenAir radios only) Determines if 
outbound multicast frames with unknown destination 
addresses are flooded toward end devices. Typically, this 
parameter is checked. However, if your wired devices do not 
need to initiate communication with wireless end devices, you 
may want to clear this check box. 

Unicast Flooding  Determines the flooding structure when this access point 
receives inbound unicast frames on non-root ports with 
unknown destination addresses. Choose Disabled if you do not 
want the access point to flood any inbound unicast frames. 

Choose Universal if the access point forwards the unicast frame 
to every port. This option uses more bandwidth. 

Choose Hierarchical if the access point forwards the unicast 
frame only to the port to which the root access point is 
attached. 

Unicast Outbound to 
Secondary LANs 
(Unicast Flood Mode 
enabled) 

Specifies if outbound unicast frames with unknown destination 
addresses are flooded toward secondary LANs.  

Choose Enabled if the root access point controls flooding for 
all the designated bridges on secondary LANs. Enabling this 
parameter makes managing secondary LANs easier because you 
do not need to set secondary LAN flooding parameters. 

Choose Set Locally if the designated bridges control flooding 
on their LANs. 

Allow Unicast 
Outbound to 
Terminals (Unicast 
Flood Mode enabled) 

(802.11b, 802.11a, and OpenAir radios only) Determines if 
outbound unicast frames with unknown destination addresses 
are flooded toward end devices.  

Enable ARP Flooding Check this check box to enable ARP flooding. When an access 
point receives an ARP request, it checks its ARP cache to 
determine if the destination end device’s IP address is known. 
If you enable ARP flooding and: 

• the destination end device is known, the access point 
translates the ARP request into a unicast frame, which is 
only forwarded to the destination end device. Therefore, all 
end devices do not need to wake up to listen to the ARP 
request, which saves battery life. 

• the destination end device is not known, the access point 
forwards the ARP request based on its flooding and filtering 
settings. 

If you disable ARP flooding, the access point ignores ARP 
requests for destination end devices that are not in its ARP 
cache. You should only use this option if you have no IP 
devices in your wireless network. 
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Configuring Global RF Parameters 
Use global RF parameters to set various parameters on the access points. If 
you are configuring the root access point and you check the Set Globally 
check box, the value for that parameter is set globally for all access points 
and wireless end devices in the network. If you are configuring the root 
access point and you clear the Set Globally check box or if you are not 
configuring the root access point, each device uses its local setting.  

To configure global RF parameters 

1 From the menu, click Spanning Tree Settings > Global RF 
Parameters. The Global RF Parameters screen appears. 

   

2 Configure the global RF parameters. Click the links in the Global RF 
Parameters menu to set more parameters. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Global RF Parameter Descriptions 

Parameter Explanation 

Perform 
RFC1042/DIX 
Conversion 
(802.11b or 802.11 
radios only) 

Determines how the access point will handle the conversion of 
RFC1042/DIX frames that are received on its 802.11b or 
802.11a ports.  

Check this check box if the frames that are received and have a 
protocol type equal to a value in the “RFC1042 types to pass 
through” list are forwarded without conversion. If the frame has 
a protocol types that is not found in the list, it will be converted 
to DIX format before it is forwarded. 

Clear this check box if the frames that are received are forwarded 
without conversion; that is, when a SNAP frame is received from 
an 802.11b or 802.11a radio with an OUI (Organizationally 
Unique Identifier) equal to 000000, it will be forwarded without 
conversion. 

S-UHF Rfp 
Threshold  
(S-UHF radios only) 

Specifies the largest data frame that can be transmitted without 
reserving air time. Air time is normally reserved to help prevent 
collisions with other transmitters; however, when the amount of 
data is small enough, sending the data may be more effective 
than creating the reservation. 

S-UHF Frag Size 
(S-UHF radios only) 

Specifies the largest data frame that can be transmitted without 
fragmentation. On certain radios, fragmentation does not occur 
unless the radio detects interference. Larger frame sizes can 
improve throughput on a reliable connection, while smaller 
frame sizes can improve throughput on a poor connection. 

902 MHz Frag Size 
(902 MHz radios 
only) 

Specifies the largest data frame that can be transmitted without 
fragmentation. On certain radios, fragmentation does not occur 
unless the radio detects interference. Larger frame sizes can 
improve throughput on a reliable connection, while smaller 
frame sizes can improve throughput on a poor connection. 

S-UHF/902 MHz 
Awake Time 
(S-UHF and 902 
MHz radios only) 

Specifies the amount of time that a wireless end device stays 
awake when radios are inactive. A sleeping device is less 
responsive to radio activity; however, the longer a device is kept 
fully awake, the larger the drain on the battery. You should set a 
device to stay awake long enough to receive an expected reply to 
a transmission and short enough to reduce power consumption. 
The awake time can be set to a number from 0 to 250 tenths of a 
second.  

RFC1042 Types to 
Pass Through 
(802.11b or 802.11a 
radios only) 

If the RFC1042/DIX Conversion field is Enabled, this 
parameter specifies values for protocol types that are to be passed 
without conversion. The list includes the Apple Talk protocol 
type, value 80F3. 

Values entered in this parameter represent the protocol types of 
frames that will be passed without conversion to DIX format. 
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Configuring Security 

This chapter explains how to use different security solutions to ensure that 
you have a secure wireless network. This chapter covers these topics: 

• About the different security features and solutions you can implement  

• Enabling access methods 

• Setting up logins 

• Enabling spanning tree security 

• Configuring an access control list (ACL) 

•  (IEEE 802.11b or IEEE 802.11a radios) Configuring WEP 
64/128/152 security 

• (IEEE 802.11b or IEEE 802.11a radios) Configuring IEEE 802.1x 
security 

• Configuring VLANs 

6 
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Understanding Security 
MobileLAN access products provide many different security features and 
solutions that you can use to create a secure wireless network. To create a 
secure wireless network, you need to be concerned about: 

• securing your backbone. Only authorized users should be able to 
communicate with your network. 

• keeping your data private. Make it difficult for an eavesdropper, such as 
a rogue access point, to monitor your data. 

• authenticating wireless end devices. End devices must prove who they 
are before they are allowed to communicate with your network. 

Depending on the radios in the access point and the amount of security 
you need in your network, you can implement one or more of the security 
solutions in the following table. 

MobileLAN access Security Solutions 

 
Security Type 

Secure 
Backbone 

Data 
Privacy 

Client 
Authentication 

Change default parameters X   

Disable access methods X   

Enable secure IAPP X   

Enable secure wireless hops X  X 

Use a password server to manage 
access point logins 

X   

Configure a VLAN for each radio X   

Use an access control list (ACL)   X 

Use WEP 64/128/152 security  X  

Use an 802.1x security solution X X X 

    

These security features and solutions are listed below in the order of 
amount of security and ease of use (most basic/least secure to most secure). 
Intermec recommends you at least change the default parameters, enable 
secure communications between access points, and use basic security 
(WEP 64/128/152 security or security ID). 

1 Change default parameters on access points and wireless end devices.  

(802.11b/802.11a) Change the SSID from its default value of 
INTERMEC and check the Disallow Network Name of ‘ANY’ check 
box. 

(OpenAir) Change the LAN ID from its default value of 0.  

For help, see Chapter 4, “Configuring the Radios.” 
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2 Enable/disable access methods. For example, if you are not using Telnet 
sessions to configure or manage your access point, you can disable this 
access method. For help, see “Controlling Access to Access Point 
Menus” on page 144. 

3 Use a password server to maintain a list of authorized users who can 
configure and manage the access points. You can either use an external 
RADIUS server or you can use any access point’s embedded 
authentication server (EAS).  

Or, change the default login for users who need to be able to configure 
or manage the access point.  

For help, see “Setting Up Logins” on page 145. 

4 Enable secure communications between access points, which includes 
secure IAPP and secure wireless hops. For help, see “Enabling Secure 
Communications Between Access Points” on page 150. 

5 Use a RADIUS server to maintain an access control list (ACL), which is 
a list of MAC addresses of end devices that can connect to the network 
through access point. You can either use an external RADIUS server or 
you can use any access point’s embedded authentication server (EAS). 
For help, see “Using an Access Control List (ACL)” on page 152. 

6 Use a dual radio access point to configure VLANs that allow secure and 
non-secure communications in your network. For help, see 
“Configuring VLANs” on page 162. 

7 (802.11b/802.11a) Configure basic WEP 64/128/152 security. You can 
configure up to four different WEP keys on the access point and most 
wireless end devices, and then you specify which key is being used to 
encrypt data. You should periodically change which WEP key these 
devices use. For help, see “Configuring WEP 64/128/152 Security” on 
page 154. 

(OpenAir) Use a security ID. For help, see “Configuring the WLI 
Forum OpenAir Radio” in Chapter 4. 

8 (802.11b/802.11a) Use an 802.1x security solution. 802.1x security 
provides a framework to authenticate user traffic to a protected 802.11b 
or 802.11a network. Using 802.1x security provides secure data 
transmission by enabling secure IAPP, enabling secure wireless hops, 
and dynamically rotating the WEP keys. You configure the access point 
as an authenticator.  

For the authentication server, you can either use an external RADIUS 
server or you can use a newer access point’s embedded authentication 
server (EAS).  

For help, see “Implementing an 802.1x Security Solution” on page 156. 

For help troubleshooting security, see “Troubleshooting Security” in 
Chapter 8. 
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Controlling Access to Access Point Menus 
There are several ways that you can manage who can configure and 
manage the access points in your network: 

• Enable/disable access methods. 

• Set up individual logins. 

• Change the default logins and create a read-only login. 

The next sections explain how to configure these methods. 

Enabling Access Methods 
There are five access methods that you can enable or disable depending on 
how you want users to be able to configure or manage the access points: 

• Web browser interface (HTTP or HTTPS) 

• Telnet session 

• MobileLAN manager or any other SNMP management station 

• TFTP 

• MobileLAN access Utility or any other program that uses ICMP echo 

All access methods are enabled by default. You may want to disable any of 
these methods that you will not use to prevent access by an unauthorized 
method. 

To enable or disable access methods 

1 From the main menu, click Security. The Security screen appears. 
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2 Enable or disable the access methods that users can use to connect to the 
access point. For help, see the next table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Security Parameter Descriptions 

Parameter Description 

Browser Access Determines if users can use a web browser to configure or 
manage this access point. Browser access is through either port 
80 or port 443. 

Choose Secure-Only if you want to force users to log in using 
the secure web browser (HTTPS) interface. Secure-only access 
is through port 443. This feature is only available on the newer 
access points (WA22, 2101B, WA21, 2100D, and 2106). 

Allow Telnet Access 
(Port 23) 

Determines if users can use a telnet session (or a 
communications program) to configure or manage this access 
point. 

Allow SNMP Access 
(Port 161/162) 

Determines if users can use MobileLAN manager or another 
SNMP management station to configure or manage this access 
point. 

Allow TFTP Access 
(Read-Only) 

Determines if users can use TFTP clients to exchange files with 
the access point.  

Allow ICMP 
Configuration 

Determines if users can use the MobileLAN access Utility or 
another program that uses ICMP echo (PING) to set the IP 
address or restore factory defaults on this access point. 

  

Setting Up Logins 
To ensure login security for configuring or maintaining the access points, 
you should either use a password server (typically an EAS or another 
RADIUS server) or change the default user name and password.  

To use the password server, you must have: 

• a password server on the network that contains the user name/password 
database. For help, see “Configuring the Access Point to Use a Password 
Server” on page 146. 

You can either configure an EAS or you can use an external RADIUS 
server as a password server.  

• access points, which are the RADIUS clients. 
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If you use a password server, you enable RADIUS for login authorization. 
That is, when a user attempts to log in to the access point, the user must 
enter a user name and password. This login is sent through the RADIUS 
client (access point) to the RADIUS server. The server compares the login 
to its list of authorized logins. If a match is found, the server returns an 
access-accept frame and the user is logged in to the access point with 
read/write privileges.  

If no RADIUS server is available when the user attempts a login and the 
Allow Service Password check box is checked, the service password is 
checked. If the login does not match the service password, the login fails. 

 
Note: Each time the service password login attempt fails, the process may 
take up to eight seconds.  

If you do not want to enable RADIUS authorization, you should change 
the default login user name and password. You may also want to change 
the read-only password. For help, see “Changing the Default Login” on 
page 148. 

Configuring the Access Point to Use a Password Server 
If you use a password server to manage users who can log in to this access 
point, you need to tell this access point how to communicate with the 
password server and then you need to configure the password server. The 
password server can either be an EAS or an external RADIUS server.  

To configure the access point to use a password server 

1 From the main menu, click Security > Passwords. The Passwords 
screen appears. 
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2 Check the Use RADIUS for Login Authorization check box.  

3 Click Submit Changes to save your changes.  

4 (Optional) Check the Allow Service Password check box.  

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 Configure the password server by clicking Select a RADIUS server for 
login authorization. The RADIUS Server List screen appears. 

 

7 For each password server, enter the IP address or DNS name, enter the 
shared secret key, Port number, and check the Login check box. 

 

Note: If you enter more than one password server, the other password 
servers simply serve as backup servers. The access point uses the first 
password server (starting with Server 1) whose IP address/DNS name 
and secret key are the same as one in the list. 

8 Configure the password server database.  

• In the EAS database, in the Type field choose Login and then enter 
the user name and password for each login. For help, see Chapter 7, 
“Configuring the Embedded Authentication Server (EAS). 

• For help configuring an external RADIUS server database, see the 
documentation that came with your server. 
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Changing the Default Login 
If you are not using a password server to authorize user logins, you should 
change the default user name and password and create a read-only 
password.  

To set up logins 

1 From the main menu, click Security > Passwords. The Passwords 
screen appears. 

   

2 Clear the Use RADIUS for Login Authorization check box.  

3 Click Submit Changes to save your changes.  

4 Configure the parameters. For help, see the next table. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

Once the changes are activated, you must enter these new values when you 
use a web browser or telnet to connect to this access point.  
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Password Parameter Descriptions 

Parameter Description 

Use RADIUS for 
Login Authorization 

Determines if you are using a password server to authenticate 
end devices that can communicate with this access point. Clear 
this check box. 

User Name Enter the user name you need to use to log in to this access 
point. This parameter can be from 0 to 16 characters long.  

If you leave the user name and password fields blank, a user 
will not need to log in to the access point. 

Password Enter the password you need to use to log in to this access 
point. This password gives you read and write access to the 
access point configuration. This parameter can be from 0 to 16 
characters long.  

If you leave the user name and password fields blank, a user 
will not need to log in to the access point. 

Read Only Password Enter the password you need to use to log in to this access 
point. This password gives the user read-only access to the 
access point. This user is able to view the configuration and 
execute diagnostics but cannot perform any tasks that affect the 
operation of the access point, such as changing configuration 
options, rebooting, or downloading software. 

To disable this password, delete it. 

Allow Service 
Password 

If the user enters a login that does not match either the user 
name and password or the read only password, check this check 
box to allow the login to be checked against the service 
password. Intermec Technical Support may use this service 
password if they need to troubleshoot this access point. 
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Establishing Secure Communications Between Access Points 
To enable secure communications between access points, enable secure 
IAPP. Secure IAPP prevents unauthorized MobileLAN access products 
from joining the spanning tree and it encrypts IAPP frames. If you enable 
secure IAPP, when access points communicate with each other through the 
radios, they will create secure wireless hops using one of the authentication 
methods you have chosen: SWAP, TTLS, TLS. 

Unless you are implementing an 802.1x security solution, by default, 
secure IAPP is disabled. You can enable secure IAPP and secure wireless 
hops in any type of radio network. If you enable secure IAPP, all 
MobileLAN access products have the same default IAPP secret key so they 
can communicate with each other. Intermec recommends that you change 
the default IAPP secret key to prevent rogue MobileLAN access products 
from joining your spanning tree. Make sure that all access points in your 
network have the same IAPP secret key. 

By default, Secure Wireless Authentication Protocol (SWAP) is enabled. If 
you have an older access point or you are not implementing an 802.1x 
security solution, you can use SWAP. SWAP forces access points to 
authenticate each other using an EAP-MD5 challenge. For more 
information on the other authentication methods, see “Implementing an 
802.1x Security Solution” on page 156. 

Note these potential problems: 

• If you enable secure IAPP on a root access point that is running software 
release 1.80 or later and other access points in your network are running 
an earlier software release than 1.80, the access points with the earlier 
software release will not attach to the root. The access points with the 
earlier software release do not support secure IAPP. If you want to use 
secure IAPP, upgrade all access points to software release 1.80. 

• If you enable secure IAPP on a non-root access point and the root access 
point has secure IAPP disabled, the access points will form separate 
spanning trees with the same LAN ID. If you want to use secure IAPP, 
enable secure IAPP on all access points. 

To configure spanning tree security 

 
Note: You do not need to perform this procedure if you are implementing 
an 802.1x security solution. 802.1x authentication automatically enables 
secure IAPP and secure wireless hops. See “Implementing an 802.1x 
Security Solution” on page 156. 

1 From the main menu, click Security > Spanning Tree Security. The 
Spanning Tree Security screen appears. 
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2 Check the Secure IAPP check box.  

3 Click Submit Changes to save your changes. 

4 In the IAPP Secret Key field, enter a secret key. This secret key must be 
between 16 and 32 bytes.  

5 Determine how the access points authenticate to the network. 

• Check the Allow SWAP check box if you have older access points or 
you are not implementing an 802.1x security solution. 

• Check the Allow TLS check box, if you are implementing an 802.1x 
security solution and you want to use TLS. The access point must 
have a client certificate loaded on it. 

• Check the Allow TTLS check box, if you are implementing an 
802.1x security solution and you want to use TTLS. You must also 
enter a User Name and Password that matches an entry in the 
authentication server. 

6 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

7 Repeat Steps 1 through 6 for each access point in your spanning tree. 
All access points must have the same IAPP secret key to communicate 
with each other. 

In the access point that contains the master radio, click Maintenance > AP 
Connections. The AP Connections screen lists the station radios 
(including ones in other access points) that are communicating with the 
master radio. For help, see “Viewing AP Connections” in Chapter 8. 
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Enabling Secure Communications Between Access Points and 
End Devices 

There are several ways that you can ensure secure communications 
between access points and wireless end devices in your network: 

• Use an ACL. 

• Create a VLAN. 

• Use static WEP keys. 

• Implement an 802.1x security solution. 

The next sections explain how to configure these methods. 

Using an Access Control List (ACL) 
You can use an access control list (ACL) that contains the MAC addresses 
that are authorized to communicate with the network through the access 
point. The end devices do not need any special client software. 

To use the ACL, you must have: 

• a RADIUS server on the network that contains the ACL. 

You can either use an external RADIUS server or you can configure an 
EAS. For help, see Chapter 7, “Configuring the Embedded 
Authentication Server (EAS).” 

• access points, which are the RADIUS clients. 

If the access point has two radios, you can use an ACL for one radio and 
another type of security for the other radio. For example, you have some 
end devices that have an 802.1x supplicant and you have some end devices 
that do not have a supplicant. You can enable one radio to use 802.1x 
authorization and the other radio to use an ACL. You can also use one 
ACL for both radios. However, you cannot use a different ACL for each 
radio. 

To use an ACL 

1 From the main menu, click Security and then click the radio security 
you are configuring. This screen appears. 
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2 Check the ACL Client Authorization check box.  

3 Click Submit Changes to save your changes. 

4 (External RADIUS server only) In the ACL RADIUS Client Password 
field, enter the password. This password must match the password that 
is configured in the external RADIUS server. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 Configure the RADIUS server by clicking Select a RADIUS server for 
ACL authorization. The RADIUS Server List screen appears. 
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7 For each RADIUS server, enter the IP address or DNS name, enter the 
shared secret key, Port number, and check the ACL check box.  

 

Note: If you enter more than one RADIUS server, the other RADIUS 
servers simply serve as backup servers. The access point uses the first 
RADIUS server (starting with Server 1) whose IP address/DNS name 
and secret key are the same as one in the list. 

8 Configure the database. Enter the MAC address for each end device 
radio that is allowed to communicate with the network. 

• In the EAS database, in the Type field choose ACL and then enter 
the MAC address for each end device radio. For help, see Chapter 7, 
“Configuring the Embedded Authentication Server (EAS). 

• For help configuring an external RADIUS server database, see the 
documentation that came with your server. In the database, you will 
also need to enter the ACL RADIUS client password. The default 
password is wireless (case-sensitive). 

 
Note (902 MHz WAP only): In the database, enter the Ethernet MAC 
address for each WAP that is allowed to communicate with the 
network. 

Configuring WEP 64/128/152 Security 

 
Note: If you configure WEP 64/128/152 security for a radio, you cannot 
also enable 802.1x authentication for that radio. 802.1x security uses 
rotating WEP keys that are automatically generated. 

In your 802.11b or 802.11a network, you can configure static WEP keys 
to provide security between the access points and the wireless end devices. 
To use static WEP keys, your radios must support WEP encryption. All 
access points and wireless end devices on a particular network must use the 
same WEP encryption type and the same WEP transmit key. You should 
periodically change this WEP transmit key to prevent an unauthorized 
person with a sniffing tool from monitoring your network and discovering 
the WEP key. 

Since, static WEP keys can be difficult to update, the MobileLAN access 
products and other Intermec products let you enter up to four WEP keys, 
and then pick a WEP transmit key (1-4). It is easier to rotate the WEP 
transmit key than to individually change all the WEP keys. 

• WEP 64 has four 40-bit encryption keys and one 24-bit initialization 
vector (IV) key. Enter five ASCII characters or five hex pairs for the 
WEP keys.  
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• WEP 128 provides a higher degree of encryption protection. It has four 
104-bit encryption keys and one 24-bit IV key. Enter 13 ASCII 
characters or hex pairs.  

• WEP 152 provides the highest degree of encryption protection. It has 
four 128-bit encryption keys and one 24-bit IV key. Enter 16 ASCII 
characters or hex pairs. 

To configure WEP 64/128/152 security 

1 From the main menu, click Security > IEEE 802.11b Radio Security 
or IEEE 802.11a Radio Security. The appropriate radio screen 
appears. 

   

2 Check the Enable WEP Encryption check box, and then click Submit 
Changes. 

3 Configure the parameters for WEP configuration. To ensure maximum 
security, configure each WEP key with a different WEP code. For help, 
see the next table. 

4 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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WEP Configuration Parameter Descriptions 

Parameter Explanation 

Enable WEP 
Encryption 

Determines if you are using WEP 64/128/152 security.  

Allow Unencrypted 
Clients 

Determines if the access point will receive transmissions from 
wireless end devices that are not using WEP encryption.  

Check this check box to accept transmissions from devices that 
are not using WEP encryption.  

Clear this check box to block transmissions from end devices 
that are not using WEP encryption.  

WEP Transmit Key Determines which of the four WEP keys this access point uses 
to transmit data. 

WEP Key 1 through 
WEP Key 4 

For WEP 64, enter five ASCII characters or five hex pairs. For 
WEP 128, enter 13 ASCII characters or hex pairs. For WEP 
128, enter 16 ASCII characters or hex pairs.  

To enter a hexadecimal key, prefix it with 0x. For example, the 
ASCII key ABCDE is equivalent to 0x4142434445. 

  

Implementing an 802.1x Security Solution 
MobileLAN access products can help implement 802.1x security in an 
802.11b or 802.11a network. The IEEE 802.1x standard provides an 
authentication protocol for 802.11 LANs. 802.1x provides strong 
authentication, access control, and key management, and lets wireless 
networks scale by allowing centralized authentication of wireless end 
devices. Intermec can provide a complete 802.1x security solution. For 
more information, see the MobileLAN secure 802.1x Security Solution 
Installation Guide (P/N 073134). 

The 802.1x authentication process uses a RADIUS server, which is the 
authentication server, and access points, which are the authenticators, to 
manage the wireless end device authentication and wireless connection 
attributes. Extensible Authentication protocol (EAP) authentication types 
provide devices with secure connections to the network. They protect 
credentials and data privacy. Examples of EAP authentication types 
include Transport Layer Security (EAP-TLS) and Tunneled Transport 
Layer Security (EAP-TTLS). 

To implement 802.1x security, you must have the following: 

• A trusted certificate authority (CA), which issues digital authentication 
certificates. The authentication server must have a certificate installed 
on it. Also, if the end devices are using EAP-TLS, each one needs a 
client certificate. 

Intermec and others can provide the service of acting as a certificate 
authority and can issue certificates. For more information, contact your 
local Intermec representative. 
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• An authentication server (RADIUS server), which is software that is 
installed on a PC or server on your network or an EAS. The 
authentication server accepts or rejects requests from end devices that 
want to communicate with the 802.1x-enabled network.  

 
Note: If you use an EAS, you must use the EAS on a newer access point 
(WA22, 2101B, WA21, 2100D, or 2106) and your end devices must be 
running the EAP-TLS, EAP-TTLS, or PEAP supplicant. 

For help, see Chapter 7, “Configuring the Embedded Authentication 
Server (EAS).” 

• An authenticator, which is an access point on your network. The 
authenticator receives requests from end devices that want to 
communicate with the network and forwards these requests to the 
authentication server. The authenticator also distributes the WEP keys 
to end devices that are communicating with it. 

• End devices that are 802.1x-enabled. These end devices have an 
802.11b or an 802.11a radio and a supplicant (EAP-TLS, EAP-TTLS 
or PEAP) loaded on them. Supplicants allow your end devices to request 
communication with the authenticator using a specific EAP 
authentication type. For more information on the availability of 802.1x-
enabled end devices, contact your local Intermec representative. 

If the access point has two radios, you can implement 802.1x security on 
one radio network or both radio networks, as long as the radio supports 
802.1x security. For example, you have some end devices that have a 
supplicant, but you also have some end devices that do not have a 
supplicant. You can configure one 802.11b radio to use 802.1x 
authorization and the other 802.11b radio to use an ACL.  

Configuring the Access Point as an Authenticator 
The access point, when acting as an authenticator, receives requests from 
end devices that want to communicate with the network and forwards 
these requests to the authentication server. It also distributes the WEP keys 
to end devices that are communicating with it. Before you configure the 
access point as an authenticator, the access point should be installed and 
configured to communicate with the wireless end devices.  

To configure the access point as an authenticator 

1 From the main menu, click Security and then click the radio security 
that you are configuring. This screen appears. 
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2 Check the WEP/802.1x Authentication check box. 

3 Click Submit Changes to save your changes. 

4 In the WEP Key Rotation Period field, enter how often (in minutes) 
the access point generates a new WEP key to distribute to the end 
devices. 

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 Configure the RADIUS server by clicking Select a RADIUS server for 
802.1x authentication. The RADIUS Server List screen appears. 

 



Chapter 6 — Configuring Security 

MobileLAN access System Manual 159 

7 For each authentication server, enter the IP address or DNS name, enter 
the shared secret key, Port number, and check the 802.1x check box. 

 

Note: If you enter more than one authentication server, the other 
authentication servers simply serve as backup servers. The access point 
uses the first authentication server (starting with Server 1) whose IP 
address/DNS name and secret key are the same as one in the list. 

8 Configure the database. Depending on the authentication type, enter 
the information for each end device that is allowed to communicate 
with the 802.1x network. 

• In the EAS database, in the Type field choose the authentication type 
and then enter the information for each end device. For help, see 
Chapter 7, “Configuring the Embedded Authentication Server 
(EAS). 

• For help configuring an external RADIUS server, see the 
documentation that came with your server. You need to enter each 
authenticator’s IP address and the shared secret key. In the database, 
you need to enter the information for each end device. 

Enabling Secure Communications Between Access Points 
When you configure a radio to use 802.1x security, you automatically 
enable secure IAPP and secure wireless hops. Secure IAPP prevents 
unauthorized MobileLAN access products from joining the spanning tree 
and it encrypts IAPP frames. If you enable secure IAPP, when access 
points communicate with each other through the radios, they will create 
secure wireless hops using one of the authentication methods you have 
chosen: SWAP, TTLS, TLS. 

You usually use TTLS or TLS when you want to authenticate a WAP or 
designated bridge to a wired access point. Use SWAP to authenticate wired 
access points and older access points.  

When the Access Point Is the Supplicant 
By default, TTLS is enabled. If you want to use TTLS, you must also 
enter a user name and password. This login must match an entry in the 
authentication server database. When the access point is acting as a 
supplicant and the authentication server offers the TTLS protocol, the 
access point sends its user name and password.  

You can also enable TLS as the authentication method. You must install a 
client certificate on each access point that will use this method to 
authenticate to the network. When the access point is acting as a 
supplicant and the authentication server offers the TLS protocol, the access 
point sends its certificate credentials. 

If you choose to use both TTLS and TLS, you must choose which 
protocol the access point offers first and the access point must have a login 
configured and a client certificate. 
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By default, Secure Wireless Authentication Protocol (SWAP) is also 
enabled. The access point tells the authenticator that it can perform 
SWAP. If the authenticator allows SWAP, SWAP is used. SWAP allows 
access points to authenticate using an EAP-MD5 challenge. If the 
supplicant or the authenticator does not allow SWAP, the authentication 
must happen at the authentication server using TTLS or TLS. 

When the Access Point Is the Authenticator 
If the Allow Swap check box is cleared, the access point that is acting as 
the authenticator will not perform any authentications using SWAP. 
Supplicants will need to authenticate with the authentication server using 
TTLS or TLS.  

However, older access points do not support these authentication 
methods. If the Allow SWAP check box is checked, the access point that is 
acting as the authenticator will authenticate any supplicants that offer 
SWAP. Note that SWAP authentication is susceptible to downgrade 
attacks from rogue supplicants as it is easier to break SWAP than TLS or 
TTLS. 

Configuring Spanning Tree Security 

 
Note: If you are implementing an 802.1x security solution, secure IAPP 
and secure wireless hops are automatically enabled. 

1 From the main menu, click Security > Spanning Tree Security. The 
Spanning Tree Security screen appears. 

   

2 In the IAPP Secret Key field, enter a secret key. This secret key must be 
between 16 and 32 bytes.  
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3 Choose which authentication methods you want to use to authorize the 
access point to communicate with the network. For help, see the next 
table. 

4 (Optional) Check the Verify CA Certificate check box and enter the 
authentication server common names if you want to verify the access 
point is connecting to the correct authentication server.  

5 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

6 Repeat Steps 1 through 5 for each access point in your spanning tree. 
All access points must have the same IAPP secret key to communicate 
with each other. 

In the access point that contains the master radio, click Maintenance > AP 
Connections. The AP Connections screen lists the station radios 
(including ones in other access points) that are communicating with the 
master radio. For help, see “Viewing AP Connections” in Chapter 8. 

Spanning Tree Security – Authentication Method Descriptions 

Parameter Description 

Allow SWAP Determines if this access point authenticates to other access 
points using an EAP-MD5 challenge. 

Allow TLS If the authentication server offers the TLS protocol for the 
authentication method, this check box determines if this access 
point can use its client certificate to authenticate to the 
network. 

Allow TTLS 
(MSCHAPv2) 

If the authentication server offers the TTLS protocol for the 
authentication method, this check box determines if this access 
point uses a login to authenticate to the network. This login 
must be in the authentication server database. 

Preferred Protocol If TLS and TTLS are enabled, this field specifies which 
protocol is sent to the authentication server when it sends an 
unsupported protocol. 

User Name (TTLS) Enter the user name of the access point when it uses TTLS to 
authenticate to the network. 

Password (TTLS) Enter the password of the access point when it uses TTLS to 
authenticate to the network. 

Verify CA Certificate Determines if you want to verify that the access point is 
connected to the correct authentication server. The server 
certificate signature is verified against the CA certificate and the 
server common name is verified against the authentication 
server common names that are configured in the access point. 
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Spanning Tree Security – Authentication Method Descriptions 
(continued) 

Parameter Description 

Authentication 
Server 1 Common 
Name 

Enter the common name of the authentication server. 

Authentication 
Server 2 Common 
Name 

Enter the common name of the backup authentication server. 

  

Configuring VLANs 
Virtual LANs (VLANs) make it easy to create and manage logical groups 
of wireless end devices that communicate as if they were on the same LAN. 
VLANs let you separate secure and non-secure traffic. For example, you 
want your access points to pass secure data to your wired network and you 
want to provide customers access to the Internet.  

The access points support the 802.1Q standard for VLAN tagging. To 
configure VLANs in your wireless network, the access point must have two 
radios. Each radio can be configured to support one VLAN. You configure 
each radio as a master radio with a unique SSID, channel, and security 
methodology. Then, you distribute the SSID of the secure network to 
your end devices and the SSID of the non-secure network to your 
customers. 

When the access point receives a frame from an end device, it appends the 
appropriate VLAN tag to the frame and then bridges the VLAN-
encapsulated frame to the wired network. If you configure the VLAN field 
to 1, no VLAN tag will be appended and the frames will be put on the 
wired network as raw Ethernet frames. A VLAN-capable Ethernet switch 
receives the VLAN-encapsulated frame and routes it appropriately. Only 
VLAN-aware devices understand frames with VLAN tags; end devices only 
understand and accept frames that are meant for them that do not have a 
VLAN tag. 

In order for the spanning tree to work, all access points must be on the 
same Native port on the Ethernet switch. The switch must be able to 
support a “hybrid” VLAN, which means the switch can support both 
VLAN-tagged and raw Ethernet frames on the switch port. The access 
point only encapsulates wireless traffic. Any communication with the 
access point across the wired network is always raw Ethernet traffic. 
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To configure a VLAN 

1 From the main menu, click Spanning Tree Settings. The Spanning 
Tree Settings screen appears. 

   

2 Configure the Enable GVRP for VLAN check box. 

• Check the check box if the VLAN switch is configured to 
dynamically configure its ports based on the end devices’ needs. 

• Clear the check box if the VLAN switch is statically configured to 
always forward specific VLANs to specific ports. 

3 Click Submit Changes to save your changes. 

4 From the main menu, click Security and then click the radio security 
that you are configuring. This screen appears. 

   

5 In the VLAN field, enter the VLAN number that encapsulates all frames 
received on this radio port. This value must match the values that are set 
in the VLAN-capable Ethernet switches on the primary LAN.  
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6 Repeat Step 4 and Step 5 for the other radio. 

7 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Configuring the Embedded 
Authentication Server (EAS) 

This chapter explains how to configure the embedded authentication 
server (EAS) in your access point for different security solutions to ensure 
that you have a secure wireless network. This chapter covers these topics: 

• About the EAS 

• Installing certificates on the EAS 

• Enabling the EAS 

• Configuring the EAS database 

• Managing the EAS database 

7 
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About the Embedded Authentication Server (EAS) 
The access point has an embedded authentication server (EAS), which is 
an internal RADIUS server. In your network, you can use the EAS on any 
access point. The EAS can act as: 

• a password server that maintains a list of logins of users who can 
configure and manage the access point. 

• a RADIUS server that maintains an ACL, which is a list of MAC 
addresses that can connect to the network. 

• a RADIUS server that maintains a list of RADIUS clients (usually access 
points) that are authorized to connect to the network.  

• a RADIUS server that authorizes TLS, TTLS, and PEAP clients to 
connect to the network.  

If you use the EAS, you may not need to buy an external RADIUS server. 
An EAS supports up to 128 database entries. If you need more database 
entries, you may be able to use the EAS on different access points for 
different purposes. For example, you can use the EAS on one access point 
as a password server and another EAS on another access point as the 
authentication server. 

This table lists the maximum number of end devices that an EAS supports 
if you turn on the end devices at the same time. However, if you turn on 
the end devices in groups, the EAS supports 128 clients with unique 
security credentials. 

Maximum Number of Simultaneous Authentications 

 
RADIUS Server Type 

WA21, 2101B, 
WA22, 2100, 2106 

All Other Access 
Points 

Password server 128 128 

ACL authentication server 128 128 

802.1x authentication server 60 N/A 
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About Certificates 
The access point needs a server certificate: 

• if you want to use the secure web browser interface (HTTPS). 

• if this access point is an authentication server in your 802.1x-enabled 
network.  

The certificate encrypts communication between the internal RADIUS 
server, RADIUS clients, and the supplicants and HTTPS clients. If you 
are configuring another access point as a backup RADIUS server, you 
should also install a unique certificate on it. Server certificates can be in 
either PKCS12 (*.P12/*.PFX) or *.PEM format.  

If the access point supports clients running the TLS authentication type, it 
also needs a trusted certificate authority (CA) certificate. Trusted CA 
certificates can be in *.PEM format or *.CER format. They can contain 
several trusted CAs, but should be kept to a maximum file size of 2K. 

How to Determine If You Need to Install a Certificate 

 
Note: Certificates are only supported on newer access points (WA22, 
2101B, WA21, 2100D, 2106). Older access points cannot use the secure 
web browser interface or be an authentication server. 

If your newer access point shipped from the factory with software release 
1.80 or later preloaded on it, it has a unique server certificate (signed by 
Intermec) with a unique common name and passphrase. It also comes with 
an Intermec trusted CA certificate that supports clients running the TLS 
authentication type. These certificates support the secure web browser 
interface and provide basic security for all authentication types. You can 
also install certificates from a third-party certificate authority. 

If you upgrade the access point to software release 1.80 or later, the 
software installs a default server certificate (ValidforHTTPSOnly). This 
certificate supports the secure web browser interface and it provides basic 
security for clients running the TTLS authentication type. If you use this 
access point as the authentication server, you should install a unique server 
certificate. Also, no trusted CA certificate is installed; therefore, it does not 
support clients running the TLS authentication type. Intermec can provide 
the service of acting as a certificate authority and can issue certificates. For 
more information, contact your local Intermec representative.  

You can view the Certificate Details screen to determine which certificates 
are installed on the access point. 
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To view the certificates 

• From the main menu, click Security > Certificate Details. The 
Certificate Details screen appears. 

   

The Server Certificate lists the server certificate that is installed and the CA 
Certificate lists the trusted CA certificate that is installed. 
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Installing and Uninstalling Certificates 
Once you have determined that you need to install a certificate, use this 
procedure. 

To install certificates 

1 From the main menu, click Security > Certificate Details. The 
Certificate Details screen appears. 

   

2 Click Install certificates in the certificate store. The Import 
Certificate screen appears. 

 

Note: If you are not using the secure web browser, you will be 
prompted to log in again. Click A secure session is available and log in 
to the access point. If a Security Alert dialog box appears, click Yes to 
proceed. Repeat Step 1 and Step 2. 
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3 Click Server Certificate or Trusted CA Certificate. 

4 In the Enter or select the name of the certificate file to import field, 
enter the path and filename of the server certificate. 

Or, click Browse to locate the certificate. 

5 (Server Certificate only) In the Enter the associated passphrase for 
this certificate field, carefully enter the passphrase for the certificate. 

6 Click Import Certificate. 
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To uninstall all certificates 

 
Note: If you follow the procedure to uninstall all certificates, you will lose 
the unique server certificate and the trusted CA certificate. You will need 
to contact your local Intermec representative to purchase new certificates. 

1 From the main menu, click Security > Certificate Details. The 
Certificate Details screen appears. 

   

2 Click Uninstall All Certificates. The unique server certificate and the 
trusted CA certificate are deleted. 

You can still use the secure web browser interface and install new 
certificates using the default certificate (ValidforHTTPSOnly).  
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Configuring the EAS 
Once you decide which access point will be configured to use its EAS, you 
need to enable the EAS on that access point and configure its database. 

To configure the EAS 

1 Install any certificates. For help, see “Installing and Uninstalling 
Certificates” on page 169. 

2 On the access point that will contain the EAS, enable the EAS. For 
help, see “Enabling the EAS” on page 172. 

3 Configure the EAS database. For help, see “Configuring the Database” 
on page 172. 

4 Make sure that all access points that are using this EAS (as a password 
server, ACL, authentication server, etc.) are configured with this access 
point’s IP address in the appropriate RADIUS server IP Address field. 
For help, see: 

• “Configuring the Access Point to Use a Password Server” in 
Chapter 6. 

• “Using an Access Control List (ACL)” in Chapter 6. 

• “Configuring the Access Point as an Authenticator” in Chapter 6. 

Enabling the EAS 
In all MobileLAN access products, the default secret key is the same. By 
having the same default secret key, you can verify that all access points can 
communicate with the EAS. Then, for more security, you should change 
the secret key to prevent unauthorized access points from communicating 
with your network.  

If you want to use the same secret key for communications between the 
EAS and all access points, in the Embedded Authentication Server screen, 
enter the default secret key. For each access point, in the RADIUS Server 
List screen, enter the EAS IP address, enter the default secret key and 
check the 802.1x check box. 

If you want to use a different secret key for communications between the 
EAS and each access point, you need to add each access point to the EAS 
database as a RADIUS client. For each access point, in the RADIUS 
Server List, enter the EAS IP address, enter the default secret key and 
check the 802.1x check box. 
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To enable the EAS 

1 Log in to the access point whose EAS you are enabling. 

2 From the main menu, click Security > Embedded Authentication 
Server. The Embedded Authentication Server screen appears. 

   

3 Check the Enable Server check box. 

4 Click Submit Changes to save your changes. 

5 (Optional) In the Default Secret Key field, enter a default secret key 
that is used between the EAS and all access points. This secret key can 
be from 1 to 32 characters in ASCII or in hexadecimal. To enter a 
hexadecimal key, it must start with 0x.  

6 In the UDP Port field, enter the UDP port number on which the EAS 
listens. Port number assignments are administered by the Internet 
Assigned Number Authority (IANA). If you change this value you 
should choose a number between 49152 and 65535.  

7 In the Authorization Time field, enter the amount of time that 
RADIUS clients (access points) remain authorized by the server before 
they need to be reauthorized. The format is d:hh:mm, where d is days, 
hh is hours, and mm is minutes.  

If you enter 0s, the RADIUS server will only authenticate a RADIUS 
client the first time it connects. 

8 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 
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Configuring the Database 
The EAS database contains up to 128 clients that this access point 
authorizes for logins, RADIUS clients, ACL clients, and 802.1x clients. 
This screen is hot settable; that is, to activate a change, you click 
Save/Discard changes, and then click Save Changes without Reboot. 

You can also create a database (using Microsoft Excel or Notepad) and 
then import it. Or, you can configure one database, export it, and import 
it to an EAS in another RADIUS server. For help, see “Exporting and 
Importing Databases” on page 177. 

 
Note: Intermec recommends that when you are done configuring the 
database, you export it and save the file in a safe place. If you restore the 
access point to its default configuration, the database is not saved. For 
help, see “Exporting and Importing Databases” on page 177. 

To configure the database 

1 Log in to the access point whose EAS you are using. 

2 From the main menu, click Security > Embedded Authentication 
Server > Database. The Database screen appears. 

 

3 In the Type field, choose the type of client you are entering in the 
database. For help, see the next table.  

4 Click Submit Changes to save your changes. 

5 Enter the appropriate user name and password, if applicable. User 
names and passwords can be from 1 to 32 characters. For help, see the 
next table. 

6 Click Submit Changes to save your changes. 
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7 Repeat Steps 3 through 6 for each client. 

8 Click Save/Discard changes, and then click Save Changes without 
Reboot.  

Embedded Authentication Server Entry Descriptions 

Type Description User Name Password 

Login Enter user names and passwords for 
users who are authorized to 
configure and maintain access 
points using the password server. 

User name User 
password 

RADIUS Enter a secret key that is shared by 
the RADIUS client (access point) 
and the RADIUS server. 

You do not need to enter any 
RADIUS clients if you do not 
change the default secret key. 

For more security, you should 
change the default secret key.  

RADIUS 
client IP 
address 

Secret key 

ACL Enter the end device radio MAC 
address for all end devices that are 
authorized to communicate with 
the network. 

(902 MHz WAP only) Enter the 
Ethernet MAC address for all 
WAPs that are authorized to 
communicate with the network. 

MAC address None 

802.1x 
(TTLS/PEAP)  

Enter the login name and password 
of all end devices that are 
authorized to communicate with 
the 802.1x-enabled network. 

For more security, you should 
delete the user name “anonymous” 
and the password “anonymous.” 

End device 
login name 

End device 
login 
password 

802.1x (TLS)  Enter the client certificate common 
name of all end devices that are 
authorized to communicate with 
the 802.1x-enabled network. 

Client 
certificate 
common 
name 

None 
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Using the Rejected List 
The Rejected List screen displays the users and devices that have been 
rejected by the EAS. You can use this list to discover which users and 
devices may need to be added to the database. When using the web 
browser interface, you can immediately add previously rejected end devices 
to the database. You do not need to click Submit Changes or reboot the 
access point. 

 
Note: When you reboot the access point, the rejected list is cleared. 

To view the rejected list 

1 Log in to the access point whose EAS you are using. 

2 From the main menu, click Security > Embedded Authentication 
Server > Rejected List. The Rejected List screen appears. 

3 Determine which users and devices you need to add to the database. For 
help understanding the list, see the next table. 

4 Add users and devices to the database. For help see “Adding Entries to 
the Database” on page 176. 

Rejected List Values 

Column Description 

Type Lists the type of authentication that failed. The type can be: Login, ACL, 
TTLS/PAP, TTLS/CHAP, TTLS/EAP, TTLS/MSCHAP, 
TTLS/MSCHAP-V2, PEAP/MSCHAP-V2, PEAP/GTC, or TLS. 

User 
Name 

Lists the value that was passed in the User Name field of the RADIUS 
server database during the failed attempt. 

Last Time Indicates how long ago the last authentication was attempted.  

Count Indicates how many times the authentication failed. 

NAS IP 
Address 

Displays the IP address of the RADIUS server that rejected the client. 

  

Adding Entries to the Database 
When you accept TTLS/PAP and PEAP/GTC entries, they are added to 
the database and require no further configuration.  

If the authentication type does not allow the EAS to learn the password of 
the rejected client (such as TTLS/CHAP), only the user name is added to 
the database. You need to manually enter the password into the database, 
click Submit Changes > Save/Discard Changes > Save Changes without 
Reboot. 
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To add all entries to the database 

1 Click Select All Entries. A check box appears next to all entries. 

2 Click Accept Selected Entries. 

To add one entry to the database 

1 Check the check box next to the entry you want to add to the database. 

2 Click Accept Selected Entries. 

Clearing the Rejected List 
1 Click Select All Entries. A check box appears next to all entries.  

2 Click Clear Selected Entries. 

Rebooting the access point will also clear the rejected list. 

Exporting and Importing Databases 

 
Note: Intermec recommends that you use the secure web browser interface 
(HTTPS) when you export and import databases. Otherwise, the 
information in the databases is sent in the clear. 

The EAS database is simply a comma-separated text file. You can create 
the database offline (using Microsoft Excel or Notepad) and then import 
it. The file must have the following format: 

ACL, 11-22-33-44-55-66 
TTLS, username, password 
TLS, commonname 
LOGIN, username, password 
RADIUS, 0.0.0.0, secretkey 

 
Note: PEAP entries are imported and exported as TTLS entries, since they 
require the same parameters. 

You should export the database so you have a backup version. You may 
also want to create the database in the primary RADIUS server, and then 
export it to a file that you can import to a backup RADIUS server.  

To export a database 

1 Log in to the access point whose EAS you are using. 

2 From the menu bar, click File Import/Export > Read or write the 
EAS RADIUS database. The EAS Database Import/Export screen 
appears. 



Chapter 7 — Configuring the Embedded Authentication Server (EAS) 

178 MobileLAN access System Manual 

3 If you are not using the secure web browser, click “A secure session is 
available”. Repeat Step 1 and Step 2. 

   

4 Click Export the EAS database from this access point. A File 
Download dialog box appears. 

   

5 Click Save. The Save As dialog box appears. 

   

6 Choose the location and filename of the database. If you use the *.CSV 
extension, you can import it into Microsoft Excel, which recognizes it as 
a comma separated text file.  

7 Click Save.  
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To import a database 

 
Note: As soon as you import the database, it is active. 

1 Log in to the access point whose EAS you are using. 

2 From the menu bar, click File Import/Export > Read or write the 
EAS RADIUS database. The EAS Database Import/Export screen 
appears. 

3 If you are not using the secure web browser, click “A secure session is 
available”. Repeat Step 1 and Step 2. 

   

4 Enter the path and filename of the database. 

Or, click Browse to locate the file. 

5 Click Import Database. 
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Managing, Troubleshooting, 
and Upgrading Access Points 

 

This chapter explains how to manage, maintain, troubleshoot, and 
upgrade the MobileLAN access products. This chapter covers these topics: 

• Configuring the access point so that it can be managed by an SNMP 
management station. You can also manage the access point using 
MobileLAN manager, MobileLAN access Configuration Wizard, a web 
browser, a communications program, or a telnet session. 

• Maintaining the access points by understanding various maintenance 
screens. This section also explains how to restore the access point to its 
default configuration. 

• Troubleshooting the access points. This section also explains how to 
recover a failed access point. 

• Upgrading the access points using the MobileLAN access utility or a 
web browser. 

8 
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Managing the Access Points 
There are several methods that you can use to manage the access points. 
You can use: 

• MobileLAN™manager. You can purchase this software to make it easy 
for you to support your wireless network without having expert 
knowledge of access points or MIBs. It works with the access point’s 
event-driven notification method (instead of traditional polling 
processes) to maintain real-time status on all access points. It also helps 
you troubleshoot your network by providing you with multiple views of 
your network, including what end devices are connected to which access 
point. For more information, go to http://mobilelan.intermec.com. 

• MobileLAN access Configuration Wizard. You can use this wizard to 
add and replace access points, rotate security parameters, clone access 
points, and view changes from factory defaults. You install this wizard 
from the MobileLAN access Tools CD that shipped with the access 
point. This wizard discovers (and can configure) all the access points 
that are on the same Ethernet segment and subnet as the PC it is 
installed on. For more information, run the wizard. 

• a web browser. For help, see “Using a Web Browser Interface” in 
Chapter 1. 

• a communications program, such as HyperTerminal. For help, see 
“Using a Communications Program” in Chapter 1. 

• a telnet session. Go to an MS-DOS prompt and type telnet 
IPaddress, where IPaddress has the form x.x.x.x and x is a number 
from 0 to 255. For more help, see “Using a Communications Program” 
in Chapter 1. The interface looks similar. 

• an SNMP management station. For help, see “Using Simple Network 
Management Protocol (SNMP)” in the next section. 

Using Simple Network Management Protocol (SNMP) 
The access point can be managed using Simple Network Management 
Protocol (SNMP); that is, you access the access point from an SNMP 
management station. Contact your Intermec representative if you need to 
obtain a copy of the MIB. 

Before you can use an SNMP management station, you must define the 
access point’s SNMP community strings.  
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To configure the SNMP community strings 

1 From the menu, click Network Management. The Network 
Management screen appears. 

   

2 Configure the SNMP community parameters. For help, see the next 
table. 

3 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” 
on page 36. 

SNMP Community Parameter Descriptions 

Parameter Description 

SNMP Read 
Community 

Specify a password that provides read-only access. This password 
can be from 1 to 15 characters and is case sensitive.  

SNMP Write 
Community 

Specify a password that provides read and write access. This 
password can be from 1 to 15 characters and is case sensitive.  

SNMP Secret 
Community 

Specify a password that provides read and write access and lets 
the user change the community strings. This password can be 
from 1 to 15 characters and is case sensitive.  
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Maintaining the Access Points 
The Maintenance menu lets you can view different parameters configured 
for the access point, including connections, port statistics, and a 
configuration summary. This information may be needed when you call 
Intermec Technical Support.  

You can also view security events that are in the Security Events log and 
then you can export them to a file. 

Viewing AP Connections 
The AP Connections screen shows information about the devices (access 
points (AP) and end devices (Term)) that are connected through the 
spanning tree.  

It also shows which devices are passed or blocked if you are using an ACL 
or if you implemented 802.1x security. In the ACL or 802.1x column, you 
will see a Pass or a Blocked. If an access point is connected to this access 
point, you will see the Ethernet MAC address. If a WAP is connected to 
this access point, you will see the radio MAC address. If an access point or 
WAP was blocked and should have been allowed to pass, re-enter the IAPP 
secret key in both devices. 

To view AP connections 

• From the menu, click Maintenance > AP Connections. The AP 
Connections screen appears. This screen is read-only. 
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Viewing Port Statistics 
The Port Statistics screen shows the total number of frames and bytes that 
the access point has received and transmitted since it was last booted. 

To view port statistics 

• From the menu, click Maintenance > Port Statistics. The Port 
Statistics screen appears. This screen is read-only. 
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Viewing the Configuration Summary 
The Configuration Summary screen summarizes the configuration settings 
for the access point. Any changes from the default configuration that have 
been made to this access point are blue. 

To view the configuration summary 

• From the menu, click Maintenance > Configuration Summary. The 
Configuration Summary screen appears. This screen is read-only. 
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Viewing the About This Access Point Screen 
This screen shows information about the access point including software 
versions, radio versions, and MAC addresses. 

To view About this Access Point 

• From the menu, click Maintenance > About this Access Point. The 
About this Access Point screen appears. This screen is read-only. 
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Using the LEDs to Locate Access Points 
You can use the LEDs to help you locate a specific access point in your 
building. 

To locate an access point 

1 From the menu, click Maintenance > About this Access Point. The 
About this Access Point screen appears. 

   

2 Click Find This AP. The access point LEDs start flashing. For help, see 
the tables below.  

The LEDs continue to flash until you click Finished Finding AP. 

Find This Access Point – WA22, 2101, WA21, 2100 

 
Power 

Wireless 
#1 

Wireless 
#2 

Wired 
LAN 

Root/ 
Error 

 
Description 

 
   

 
This access point is 
the one you are 
trying to locate. 

   

Find This Access Point – 2102, 2106 

 
Power 

 
Wireless 

Wired 
LAN 

 
Root/ Error 

 
Description 

 
  

 
This access point is 
the one you are 
trying to locate. 
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Restoring the Access Point to the Default Configuration 
You may need to restore the access point to the factory default 
configuration. For a list of the default settings, see “Default Settings” in 
Appendix A. To restore the access point to the default configuration, you 
can use: 

• MobileLAN access Configuration Wizard. For more information, run 
the wizard. 

• MobileLAN access Utility. For help, see “Using the MobileLAN access 
Utility” in the next section. 

• Web browser interface. For help, see “Using the Web Browser 
Interface” later in this section. 

Using the MobileLAN access Utility 

 

Note:, If your access points are running software release 1.90 or later, you 
must use MobileLAN access Utility v2.0. 

For help installing the MobileLAN access utility, see “Using the 
MobileLAN access Utility” in Chapter 1. 

To restore the access point to the default configuration 

1 Start the utility. 

2 In the Select Task field, choose Restore Factory Defaults. 

   

3 In the Current IP Address field, enter the IP address of the access point 
you want to restore to factory defaults. 

4 Disconnect and reconnect the power cable to the access point. The 
access point has no On/Off switch, so it boots as soon as you apply 
power. 

5 Immediately click Restore. The Status box lets you know when the 
default configuration has been restored. You will need to reconfigure 
your network settings. 
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6 To close the utility, from the File menu choose Exit. 

For more help using the utility, from the Help menu choose Contents. 

Using the Web Browser Interface 
1 In the menu bar, click Save/Discard Changes.  

   

This screen appears. 

   

2 Click Restore Factory Defaults. Under Pending Changes, you will see 
a list of what parameters need to be changed. 

3 Click Save Changes and Reboot. When the access point is done 
rebooting, it will use the factory default settings as its active 
configuration. You may need to reset the IP address and other network 
parameters. 

Troubleshooting the Access Point 
This section provides you with information on getting help with your 
installation and some general problems and solutions. 

Getting Help With Your Installation 
The access point provides some configuration error messages that may help 
you troubleshoot your installation. Or, you can call Intermec Technical 
Support. 
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Using the Configuration Error Messages 
When you click Save/Discard Changes, the access point checks for 
potential problems with the network configuration and security settings. If 
you see error message hyperlinks under the Possible Configuration Errors 
heading, you can click the hyperlink to go to the screen where you can fix 
the configuration. 

  

Calling Intermec Technical Support 
The access points are designed to be easy to install and configure; however, 
you may need to call Intermec Technical Support if you have problems. 
Before calling, be sure you can answer the following questions: 

• What kind of network are you using? 

• What were you doing when the error occurred? 

• What error message did you see? 

• Can you reproduce the problem? 

• What versions of access point firmware are you using? For help, see 
“Viewing the About This Access Point Screen” earlier in this chapter. 

You should have the information on the About this Access Point screen 
available when you call Intermec Technical Support. In the U.S.A., call 
Intermec Technical Support at 1-800-755-5505. In Canada, call 1-800-
668-7043. Outside the U.S.A. or Canada, call your local Intermec 
representative. 
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General Troubleshooting 

Problem/Question Possible Solution/Answer 

Is the access point fully 
booted? 

It takes about 30 seconds for an access point to boot. 
When the access point is done booting, the Power LED 
remains steady green, the Wired LAN #1 LED flashes 
green, and: 

• if the access point is connected to the Ethernet 
network, the Wired LAN LED flashes green. 

• if there is a radio in radio slot #2, the Wired LAN #2 
LED flashes green. 

• if the access point is configured as a root access point, 
the Root/Error LED remains steady green. 

The Power LED is not on. 1. Make sure the power cable is firmly plugged into the 
access point and the power source. 

2. Unplug the access point, and then plug it back into the 
power source. After the access point boots, verify that 
the Power LED remains on. 

3. The access point may have a hardware problem. Call 
Intermec Technical Support. 

The Wireless #2 LED and 
the Root LED are flashing 
at the same time. 

You may only have the boot ROM code loaded in the 
access point; you have lost all the other access point files. 
You need to use the MobileLAN access Utility to recover 
the access point. For help, see “Recovering a Failed Access 
Point” later in this chapter. 

You cannot connect to the 
access point using the serial 
port. 

1. Verify that you are using a null-modem cable to 
connect the access point to your terminal or PC. 

2. Verify that you are communicating through the correct 
serial port. 

3. Verify that your terminal or PC is set to 9600, N, 8, 1, 
no flow control. (Verify that the baud rate is not 
115200.) 

4. Your system may be in autobaud mode. Reboot and 
press a key once per second until the signon screen 
appears. 

You cannot connect to the 
access point using a web 
browser. 

1. Verify that you did not disable the Browser Access field 
in the Security screen.  

2. If you access the Internet through a proxy server, be 
sure you have added the IP address of the access point 
to the Exceptions list. 

You cannot ping or telnet 
to an access point. 

1. You must set an IP address and subnet mask using the 
MobileLAN access Utility or a communications 
program before you can remotely connect to the access 
point. 

2. Verify that you did not disable the Telnet Access field 
in the Security screen.  

3. The access point may have lost its files. For help, see 
“Recovering a Failed Access Point” later in this chapter. 
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General Troubleshooting (continued) 

Problem/Question Possible Solution/Answer 

The Ping Utility screen 
does not appear when you 
click a MAC address or an 
IP address in the AP 
Connections screen. 

The web browser you are using does not have Java 
support. Intermec recommends that you use Internet 
Explorer v3.0 or later or Netscape Communicator v4.0 or 
later. 

You cannot connect to the 
access point using 
MobileLAN manager or 
another SNMP 
management station. 

Verify that you did not disable the SNMP Access field in 
the Security screen.  

The end device cannot 
connect to the network. 

• From the Maintenance menu, choose AP Connections 
and verify that the MAC address of your end device 
appears on your PC screen. If it does not appear, your 
end device is not communicating with the access point. 
Check your radio configuration settings. 

• Verify that the access point is not filtering out the type 
of traffic you are trying to pass through it. 

The end device cannot 
synch to the access point. 

If you are using 802.11b or 802.11a radios: 

• Verify that the end device and the access point have the 
same SSID (network name) and security. 

If you are using OpenAir radios: 

• Verify that the end device and access point have the 
same LAN ID, security ID, channel, and subchannel. 

• Verify that the access point is configured as a master 
and that the end device is configured as a station. 

If you are using 902 MHz radios: 

• Verify that the end device and the access point have the 
same LAN ID and mode-channel. 

If you are using S-UHF radios: 

• Verify that the end device and the access point have the 
same frequency. 

The end devices are unable 
to roam from one access 
point to another. 

The switches in your network may not support backward 
learning. Use data link tunneling to force all wireless traffic 
through a fixed point so that roaming is transparent to the 
bridges or switches.  

The end devices must have IP addresses from the root IP 
subnet. 

For more information, see “About Data Link Tunneling” 
in Chapter 5. 

The end devices are unable 
to roam between a 
MobileLAN access product 
and 011X devices. 

Set the Unicast Flood Mode to Hierarchical. For more 
information, see “Configuring Global Flooding” in 
Chapter 5. 
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General Troubleshooting (continued) 

Problem/Question Possible Solution/Answer 

You cannot originate an IP 
tunnel to an access point 
on a remote IP subnet. 

1. Verify that the IP Router (Gateway) address is correct. 

2. Verify that the access points on the ends of the tunnel 
have the same LAN ID. 

3. On the root access point verify that the IP address of 
the access point at the endpoint of the IP tunnel 
appears in the IP Addresses list. 

You need to verify the 
static WEP keys. 

You cannot verify the WEP keys. The keys are encrypted 
after you enter them and are never displayed again. You 
may need to reconfigure your access points and end 
devices to reset the WEP keys. 

The filters are not filtering 
properly. 

Check all of your filter settings. Conflicts may exist 
between the various filters. 

You need to confirm which 
master radio a WAP is 
connected to. 

To verify that a WAP is communicating with a particular 
radio, view the AP Connections screen for the access 
point. Click Maintenance, and then click AP Connections. 

The throughput seems 
slow. 

• Verify that your antennas are well placed and that 
metal or other obstacles do not block them. 

• You may want to add a second access point and 
implement roaming if you move the antenna closer to 
the device and throughput increases. 

• You may be able to set filters to eliminate Ethernet 
traffic on the wireless network. For more information 
about filters, see “Configuring IP Tunnel Filters” in 
Chapter 5. 

The radio coverage is less 
than you expected it to be. 

Verify that the antennas or antenna cables are plugged into 
the correct connectors by reading the label on the access 
point. The connectors for the WA21 and WA22 are 
different than the ones for the 2100 and the 2101. 
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Troubleshooting the Radios 
If you are having problems communicating with your wireless network, 
you can use the access point LEDs, a serial connection, or the access point 
to help you troubleshoot any radio problems. 

Using LEDs 
If the access point LEDs show the following pattern after it boots, the 
radio may be faulty or the configuration matrix string is incorrect. Contact 
your local Intermec representative to help you correct the problem. 

Power Wireless #1 Wireless #2 Wired LAN Root/Error 

     

 = On  = Off 

Using Radio MAC Ping (802.11b Radios) 
Radio MAC Ping runs at the MAC sublayer of the Data Link layer, thus 
allowing you to ping any 802.11b device that is connected to the access 
point. Radio MAC Ping can help you determine the connectivity and 
signal strength of an 802.11b radio. 

To use radio MAC ping 

1 From the menu, click Maintenance > AP Connections. The AP 
Connections screen appears. All devices that support a radio MAC ping 
will have their MAC address listed with a hyperlink. 

   

2 Click a MAC address hyperlink. The access point pings the device, and 
then the Ping Utility screen appears showing the results. 
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3 Click Return to connections to return to the AP Connections screen. 

Using ICMP Echo 
ICMP (Internet Control Message Protocol ) echo lets you ping devices 
using their IP address. ICMP echo can only be used if the access point has 
determined the IP address of the end device or another access point. If the 
access point is acting as an ARP server, it will determine the IP addresses of 
the end devices that are attached to it and allow you to use ICMP echo on 
the wireless network. The access point always knows the IP address of all 
access points in the spanning tree. 

To use ICMP echo 

1 From the menu, click Maintenance > AP Connections. The AP 
Connections screen appears. 

   

2 Click an IP address link. The access point pings the device, and then the 
Ping Utility screen appears showing the results. 
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3 Click Return to connections to return to the AP Connections screen. 

Troubleshooting Security 
This section helps you troubleshoot problems you may have while 
installing and configuring security in your network. For more help 
troubleshooting 802.1x security, refer to the documentation for the 
MobileLAN secure 802.1x security solution, the Odyssey server, and the 
end devices. 

Viewing the Security Events Log 
The access point logs a variety of 802.1x events in its Security Events log. 
Only the access point that generates the security event displays it in its 
Security Events log.  

To see all the 802.1x events in your network, you need to use MobileLAN 
manager or another SNMP management station or network management 
tool. 

To view the Security Events log 

• From the menu, click Security > Security Events. The Security Events 
log appears. 
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For help understanding the events, see the next table. 

Security Events Log Description 

Column Description 

MAC 
Address 

Ethernet MAC address of the device that caused the event. 

IP Address IP address of the device that caused the event. 

Priority Priority of the event (critical, high, low, informative). 

Trap Specifies if the event generated an SNMP-reliable trap. Any event with a 
priority of critical or high will generate an SNMP reliable trap. 

Count Number of times the event occurred. 

Type Details of the event that occurred. 

Age Amount of time that has passed since the event occurred. 

  

 
Note: If you use an SNMP management station or another network 
management tool, the age represents how much time has passed since the 
access point was booted that this event occurred. 

Exporting the Security Events Log 
You can export the Security Events log from the web browser interface to a 
comma-separated file. You can open this file using Microsoft Excel or 
Notepad.  

To export the security events log 

1 From the menu, click Security > Security Events. The Security Events 
log appears. 

2 Click Export the Security Events Log from this access point. A File 
Download box may appear. 
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3 Click Save. The Save As dialog box appears. 

4 Choose where you want to save the file, seclog.csv, and then click Save. 

General Security Troubleshooting 
This section provides you with information on getting help with your 
secure network and some problems and solutions. 

Problem/Question Possible Solution/Answer 

You enabled secure IAPP in 
your network, but the 
access points do not 
communicate with the root 
access point. 

• The root access point is running software release 1.80 
or later. All access points must also be running software 
release 1.80 or later. Upgrade all access points to the 
same software release as the root access point. 

• Verify that you enabled secure IAPP on all access 
points. 

• In the root access point, click Maintenance, and then 
click AP Connections. If any access point station radios 
are blocked, re-enter the IAPP secret key in all access 
points. 

You are implementing 
802.1x security and you 
cannot get an end device to 
authenticate with a 
RADIUS server. 

• Verify that the RADIUS server IP address is correct. 
Re-enter the RADIUS server secret key in both the 
access point and the RADIUS server. 

• Verify that the IAPP secret key is the same in all access 
points. 

• Verify that the access point that the end device is 
communicating with has the 802.1x Authentication 
field set to authenticate the radio that is in the end 
device. 

• Verify that the root access point is running software 
release 1.72 or later. 

• Verify that your end device is configured properly for 
802.1x security. For help, see the end device user’s 
manual. 
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Recovering a Failed Access Point 

 

Note: Do not use this procedure to upgrade your access point software. 
For upgrading instructions, see “Upgrading the Access Points” on page 
203. 

You should never need to use this procedure. However, if your access 
point is not functioning, you may need to download an entirely new file 
system. If the access point loses all its files except the boot ROM code, the 
Wireless #2 LED and the Root LED are flashing at the same time. You 
will not be able to ping the access point and you cannot establish a telnet 
session to the access point.  

You can recover a failed access point using: 

• the MobileLAN access Utility. For more information, see the next 
section “Using the MobileLAN access Utility.” 

• a Windows NT 4.0/2000/XP PC  

Using the MobileLAN access Utility 
The MobileLAN access Utility enables your PC to recover an access point 
that is not functioning.  

 

Note:, If your access points are running software release 1.90 or later, you 
must use MobileLAN access Utility v2.0. 

For help installing the MobileLAN access utility, see “Using the 
MobileLAN access Utility” in Chapter 1. 

To recover a failed access point 

1 Download the upgrade software to your PC. 

2 Start the utility.  

3 In the Select Task field, choose Recover Failed Access Point. 
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4 In the Temporary IP Address field, enter a temporary IP address for 
the access point you need to recover. You can use any IP address that is 
valid on your network. 

5 In the Ethernet MAC Address field, enter the MAC address of the 
access point you need to recover. This MAC address is printed on a 
label that is on the bottom of the access point. 

 
Note: If you are only recovering one access point, you can enter 
00:10:40:FF:FF:FF. This special MAC address works with all access 
points. 

6 In the Access Point Model box, choose the model of the access point 
you are recovering. 

7 In the Upgrade File Location field, enter the pathname and filename 
of the upgrade software. The upgrade software must be a .BIN file. 

8 Click Start. 

9 Disconnect and reconnect the power cable (or Ethernet cable, if you are 
using power over Ethernet) to the access point. The access point has no 
On/Off switch, so it boots as soon as you apply power. 

10 Click Recover. The Status box lets you know when the access point is 
successfully recovered. 

You will need to reconfigure the access point. 

Using a Windows NT 4.0/2000/XP PC 
If you do not have the MobileLAN access Utility, you can use a Windows 
NT 4.0/2000/XP PC and a command prompt to recover a failed access 
point. To access a command prompt, see your Windows documentation. 
For this procedure you will need to contact Intermec Technical Support to 
obtain the appropriate .DNL file. 

MobileLAN access DNL File 

Access Point Upgrade File 

WA22, WA21, 2106 AP824X.DNL 

2100D, 2101B AP855.DNL 

2100A, 2100B, 2100C, 
2101A, 2102 

UAP.DNL 

  

To recover a failed access point 

1 From a command prompt, type this command to create a static ARP 
cache entry for the netloader. 

arp –s x.x.x.x yy-yy-yy-yy-yy-yy 
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where: 

x.x.x.x is the IP address that you want to assign the access  
point 

yy-yy-yy-yy-yy-yy is the MAC address of the access point. This MAC 
address is printed on a label that is on the bottom of 
the access point. 

 
Note: If you are only recovering one access point, you can enter 
00:10:40:FF:FF:FF. This special MAC address works with all access 
points. 

2 Type this command to continuously ping the access point while you 
boot the access point. 

ping –t –l 100 IPaddress 

where IPaddress is the access point IP address you assigned in Step 1. 

3 Disconnect and reconnect the power cable (or Ethernet cable, if you are 
using power over Ethernet) to the access point. The access point has no 
On/Off switch, so it boots as soon as you apply power. 

4 When the access point responds to the ping, use any TFTP client to 
transfer the appropriate .DNL file to the access point. Make sure the 
Transfer mode is binary. 

 tftp –i IPaddress put filename.dnl 

where: 

IPaddress is the access point IP address you assigned in Step 1. 

filename is the name of the appropriate .DNL file. 

Once the TFTP transfer is complete, the access point will begin booting 
the image that was just passed to it. This image is only resident in RAM. 
If you reboot the access point or if the access point loses power, the 
.DNL image will be lost. 

5 Type this command to remove the static ARP cache entry from your 
PC. 

arp –d IPaddress 

where IPaddress is the access point IP address you assigned in Step 1. 

When the access point is done booting, all access point services are 
available. You can now telnet to the access point to upgrade it with a 
permanent image and configure it.  

 
Note: You may be unable to access the web browser interface if the 
support files for this interface still need to be recovered. If so, use telnet to 
upgrade the access point, and then use the web browser interface to 
configure it. 
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Upgrading the Access Points 

 
Note: If the access point that you are upgrading is running a software 
release earlier than 1.50, first upgrade it to 1.50. Then, use the 
MobileLAN access Utility or the web browser interface to upgrade it to the 
desired software release. 

For optimal performance, you should install the most current software 
version on all the access points in your network. To upgrade the software, 
you must copy the software release to your PC, and then you can upload 
the release to your root access point and other access points. However, you 
can also configure the root access point to copy the release to all other 
access points in its spanning tree. 

You can upgrade the access point software using: 

• the MobileLAN access Utility as a distributed upgrade server. For help, 
see the next section “Using the MobileLAN access Utility” and the 
online help. 

• a web browser interface. For help, see “Using a Web Browser Interface” 
on page 205. 

To copy the software release to your PC 

1 Using a web browser, navigate to http://www.intermec.com. 

2 From the Service & Support menu, choose Downloads. 

3 Select the MobileLAN access product that you are upgrading. 

4 Click the software link to save the upgrade file on your PC. 

Using the MobileLAN access Utility 
The MobileLAN access Utility enables your PC to act as a distributed 
upgrade server. The PC stores the upgrade software and you configure the 
root access point to retrieve the software at a specified time. You can also 
configure the root access point to inform other access points in its 
spanning tree where they can get the software so they can be upgraded. 

If you use this utility, you only need to configure the root access point and 
all access points will be upgraded. However, when the access points request 
the upgrade software, the utility must be active. 

 
Note: The PC that is running the MobileLAN access Utility does not need 
to be on the same IP subnet as the access points. 

 
Note: To upgrade your access points from software release 1.80 to 1.90, 
you must use MobileLAN access Utility v2.0.  
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For help installing the MobileLAN access utility, see “Using the 
MobileLAN access Utility” in Chapter 1. 

To upgrade the access point software 

1 Start the utility. 

2 In the Upgrade File Location field, enter the path and filename of the 
upgrade file (AP*WEB.BIN) or click Browse to find the file. For 
example, AP180WEB.BIN. 

   

3 Click Start. The utility must remain active until the upgrade procedure 
is complete; do not close the utility. 

4 Configure the root access point to retrieve the software. 

a From the Actions menu, click Configure Access Point, and then 
enter the IP address of the root access point. A web browser session is 
established. 

b From the menu bar, click Distributed Network Upgrade. The 
Distributed Network Upgrade screen appears. 
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c In the Server IP Address field, enter the IP address of the PC 
contains the software release and that is running the utility. 

d In the Start Time field, choose when you want the upgrade to start. 

e Check the Reboot selected Access Points after successful upgrade 
check box if you want to access points to run the upgraded software 
after it is downloaded. 

If clear this check box, you will need to reboot the access points when 
you want them to run the upgraded software. 

5 Configure the root access point to tell the other access points where to 
get the upgrade software. 

a Under the Access Points on the Network title, you can see a list of all 
the access points in the spanning tree.  

b Check the Upgrade check box of all access points you want to 
upgrade. 

To select all access points that are listed, click the Select All Access 
Points button. 

To deselect all access points that are selected, click the Deselect All 
Access Points button. 

When the start time expires, the root access point retrieves the upgrade 
software and reboots. When it is done rebooting, it will be running the 
new software. The other access points that you configured to be upgraded 
will also retrieve the upgrade software. If you checked the Reboot selected 
Access Points after successful upgrade check box, they will also reboot, and 
then they will be running the new software. 

Using a Web Browser Interface 
You can use a web browser interface to upgrade the access points one at a 
time. In other words, for each access point you want to upgrade, you will 
need to establish a web browser session with it, upgrade its software, save 
the new configuration, and reboot it. 

To upgrade the access point software 

1 Establish a web browser session with the access point you want to 
upgrade. 

2 From the menu bar, click Upgrade Software. The Upgrade Software 
screen appears. 
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3 Enter the path and filename of the upgrade file (AP*WEB.BIN) or click 
Browse to find the file on your PC. For example, AP180WEB.BIN. 

4 Click Upgrade to start the upgrade. The upgrade may take up to three 
minutes to complete. 

5 When the upgrade is complete, click Save Changes and Reboot. 

When the access point is done rebooting, it is upgraded to the new 
software. Repeat this procedure for each access point you want to upgrade. 

Troubleshooting the Upgrade 
Each access point on a wired LAN requires approximately three minutes to 
upgrade (it takes slightly longer for wireless access points). The web 
browser screen updates every 30 seconds as the upgrade progresses and 
shows the final status when all upgrades are complete. If you checked the 
Reboot selected Access Points after successful upgrade check box, the web 
browser disconnects. Click the Refresh button to log in again.  

Errors may occur during the upgrade process or during the final reboot. If 
an error occurs, an explanation appears on the web browser screen.  

If an error occurs during the upgrade, none of the access points reboot. 
You should: 

1 Recheck the access points where the error occurred. 

2 Click Start Upgrade to attempt the upgrade again. If the upgrade is 
successful and you checked the Reboot selected Access Points after 
successful upgrade check box, the access points will reboot. 

If an error occurs during the final reboot, you should: 

1 Wait five minutes for the access points that did not reboot to refresh.  

2 Refresh your web browser screen and check the access points that are 
not running the new version.  
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3 Press Start Upgrade to attempt the upgrade again. If the upgrade is 
successful and you checked the Reboot selected Access Points after 
successful upgrade check box, the access points will reboot according 
to your Reboot selection. 

If you need to downgrade an access point to an earlier release, contact 
Intermec Technical Support. 
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Additional Access Point 
Features 

This chapter explains some of the more advanced ways that you can 
maintain the MobileLAN access products. This chapter covers these 
topics: 

• Understanding the Access Point Segments 

• Using the AP Monitor 

• Using Console Command mode 

• Creating script files 

9 
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Understanding the Access Point Segments 
The 2101, 2100, and 2102 have these four segments in their file system: 

• The current active boot or startup segment (can be segment 1 or 2) 

• The current inactive boot or startup segment (can be segment 1 or 2) 

• The current active data segment (can be segment 3 or 4) 

• The current inactive data segment (can be segment 3 or 4) 

You can enter commands to manipulate the boot and data segments. For 
instance, you typically download new access point software into an 
inactive segment, and then make that segment active the next time the 
access point boots.  

The WA22, WA21, and 2106 have only one segment. 

Using the AP Monitor 
The AP (access point ROM) monitor is system software that lets you 
manipulate the access point files and file segments. You can only access the 
AP monitor through the serial port using a communications program. 
Therefore, you cannot use this feature with the 2106. 

 
Note: Certain functions available through the AP monitor can erase the 
access point configuration. Intermec strongly recommends that you only 
use the AP monitor when absolutely necessary. For example, you might 
use the AP monitor to upgrade the access point software or when 
instructed to do so by Intermec Technical Support.  

Entering the AP Monitor 
1 Use a communications program to start a session with the access point. 

2 Reboot the access point. 

3 When you see the message <Press any key within 5 seconds to enter the 
AP monitor> during the boot process, press Enter. 

The ap prompt (ap>) appears.  
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Using AP Monitor Commands 
You can display a list of AP monitor commands on the screen anytime you 
see the ap prompt. 

To list AP monitor commands 

• Press any key (except the letter B, which reboots the access point), and 
then press Enter. A list of AP monitor commands appears. 

   

B 
 Purpose: Reboots the access point. 

 Syntax: B 

FD 
 Purpose: Displays the flash file system directory, including information about the 

boot file.  

 Syntax: FD 

FR 
 Purpose: Finds the first executable file in the access point boot segment and tries to 

run it; therefore, the first executable file in the access point boot segment 
must be the boot file.  

 Syntax: FR 
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FX 
 Purpose: Downloads a file using Ymodem batch protocol into the flash segment 

that is specified by s. 

 Syntax: FX s 

where s is segment 1, 2, 3, or 4. 

MR 
 Purpose: Displays the manufacturing record for the access point. Use the MR 

command to display the MAC address, configuration string, and serial 
number for your access point.  

 Syntax: MR 

SR 
 Purpose: Sets the baud rate of the access point.  

 Syntax: SR z 

where z is the baud rate. You must enter the baud rate as a whole number 
with no commas. For example, to enter a baud rate of 19,200, you must 
enter 19200. 

You can also set the baud rate to autobaud, which lets the access point set 
its baud rate to match the baud rate of your terminal. Type SR 0 and press 
Enter twice.  

Using Content Addressable Memory (CAM) Mode Commands 
You may need to use CAM commands to perform certain functions. Since 
the Ethernet port on the access points (except the 2102) supports data 
rates significantly higher than the radio ports, all frames cannot be 
forwarded form the Ethernet network to the radios. CAM, which is 
controlled by the Field Programmable Gate Array (FPGA), filters frames 
based on the radio’s capability.  

Because the commands can cause undesirable results if not properly 
executed, you should contact Intermec Technical Support for assistance if 
you are unsure about the proper procedure to use.  

To enter CAM mode 

1 Type CAM and press Enter.  

2 Enter a password. The default password is EV98203C (case sensitive). 

When you are in CAM mode, the CAM prompt (CAM>) appears. 
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To exit CAM mode 

• At the test prompt, type X and press Enter. 

You return the ap prompt.  

To display CAM commands 

• Type any letter or number other than B and press Enter. The CAM 
commands appear on the screen.  

 

Using Test Mode Commands 
Within the AP monitor, Test mode lets you perform certain test 
functions.  

Because the commands can cause undesirable results if not properly 
executed, you should contact Intermec Technical Support for assistance if 
you are unsure about the proper procedure to use.  

To enter Test mode 

1 Type TEST and press Enter.  

2 Enter a password. The default password is EV98203T (case sensitive). 

When you are in Test mode, the test prompt (test>) appears. 

To exit Test mode 

• At the test prompt, type X and press Enter. 

You return the ap prompt.  
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To display test commands 

• Type any letter or number other than B and press Enter. The test 
commands appear on the screen.  

 

Using Service Mode Commands 
In Service mode, you can perform file functions and segment functions 
such as deleting a file, downloading a file using the Ymodem protocol, and 
erasing a segment. 

To enter Service mode 

1 At the ap prompt, type SRVC and press Enter. 

2 Enter the service password. The default password is EV98203S (case 
sensitive). 

The service prompt (service>) appears. 

To exit Service mode 

• At the service prompt, type X and press Enter. 

You return the ap prompt.  
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To list service commands 

• Press any key (except the letter B, which reboots the access point), and 
then press Enter. The service commands appear on the screen.  

 

Many of the commands that are available in Service mode are also 
available in the AP monitor or Console Command mode. 

B 
 Purpose: Reboots the access point. 

 Syntax: B 

FB 
 Purpose: Makes an inactive segment the active segment.  

 Syntax: FB bootsegment (datasegment) 

where: 

bootsegment  is the name or number of the boot segment to be activated. 

datasegment  is the optional name or number of the data segment to be  
activated. 

 Example: To make segment 2 the active boot segment and segment 4 the active data 
segment, enter: 

FB 2 4  

You can use an asterisk instead of a segment name if you want to leave that 
segment unchanged. For example, to leave the active boot segment 
unchanged and make segment 4 the active data segment, you could enter:  

FB * 4 

After loading software into the access point a common task is to activate 
the new software. To activate the new software, enter: 

FB IB: ID: 
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FB (continued) 

This command activates the inactive boot and data segments. You do not 
need to know which of the boot and data segment numbers the flash is 
loaded into. 

FC 
 Purpose: Compacts the files in a particular segment. 

 Syntax: FC s 

where s is the name or number of the segment to be compacted. You can 
enter ALL instead of a segment name or number if you want to erase all 
segments. 

 Example: To compact the contents of segment 1, enter: 

FC 1  

To compact the contents of the inactive boot segment, enter: 

FC IB: 

FD 
 Purpose: Displays the flash file system directory, including information about the 

boot file.  

 Syntax: FD 

FDEL 
 Purpose: Deletes a particular file from a segment.  

 Syntax: FDEL f (s) 

where: 

f is the name of the file to be deleted. 

s is the optional segment location of the file. 

 Example: To delete the file UAP.PRG from the inactive boot segment, enter: 

FDEL IB:UAP.PRG  

 
Note: When you use the FDEL command, the file is marked as invalid 
and remains in the file system. To reclaim the file space, you must erase 
the entire segment. Use the FE command to erase a segment. 
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FE 
 Purpose: Erases the files in a particular segment. To recover the files after they have 

been erased, you must reload them from another source.  

 
Note: You must execute this command before you execute a TFTP 
transfer. 

 Syntax: FE s 

where s is the name or number of the segment to be erased. You can enter 
ALL instead of a segment name or number if you want to erase all 
segments. 

 Example: To erase the contents of segment 1, enter: 

FE 1  

To erase the contents of the inactive boot segment, enter: 

FE IB: 

FFR 
 Purpose: Runs a program f, from a location s.  

 Syntax: FFR f (s) 

where: 

f is the program name. 

s is the optional segment location of the program. 

 Example: To run program UAPBOOT.PRG from segment 1, enter: 

FFR UAPBOOT.PRG 1 

FI 
 Purpose: Reinitializes the access point file system. If the access point file system or a 

file segment becomes corrupt, use this command to reset it. 

 Syntax: FI (s) 

where s is the optional number of the segment to be reinitialized. 

FX 
 Purpose: Downloads a file using Ymodem batch protocol into the flash segment 

that is specified by s. 

 Syntax: FX s 

where s is segment 1, 2, 3, or 4. 
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HDW 
 Purpose: Loads the FPGA configuration file into the access point. If you are 

directed to change the FPGA firmware in the access point, use this 
command. 

 Syntax: HDW f (s) 

where: 

f is the FPGA configuration filename. 

s is the optional segment where you want to load the configuration  
file. 

Using Command Console Mode 
You can use the Command Console mode to manipulate some access 
point files and file segments. You can also use Command Console mode to 
upgrade access points using TFTP and script files.  

You access the Command Console mode through the serial port using a 
communications program or over the network using a telnet session. You 
cannot access Command Console mode using a web browser interface. 

Entering Command Console Mode 
1 Use a communications program or telnet to start a session with the 

access point. For help, see “Using a Communications Program” in 
Chapter 1. 

2 From the Access Point Configuration menu, choose Maintenance. 

3 From the Maintenance menu, choose Command Console. The list of 
commands appears. 
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To exit Command Console mode 

• At the prompt, type exit. 

You return to the Maintenance menu. 

Using the Commands 
Several of these commands require that you enter filenames. To indicate 
the segment where the file is located, precede the filename with either a 
segment number or name followed by a colon. For example, 1:uap.prg 
refers to the file named UAP.PRG that is located in segment 1. If you do 
not specify a segment name or number, the access point searches the 
segments in the following order until it finds a file that matches the file 
name RAM, 1, 2, 3, 4. 

FB 
 Purpose: Makes an inactive segment the active segment.  

 Syntax: FB bootsegment datasegment 

where: 

bootsegment  is the name or number of the boot segment to be activated.  

datasegment  is the name or number of the data segment to be activated. 

 Example: To make segment 2 the active boot segment and segment 4 the active data 
segment, enter: 

FB 2 4  

You can use an asterisk instead of a segment name if you want to leave that 
segment unchanged. For example, to leave the active boot segment 
unchanged and make segment 4 the active data segment, you could enter:  

FB * 4 

After loading software into the access point a common task is to activate 
the new software. To activate the new software, enter: 

FB IB: ID: 

This command activates the inactive boot and data segments. You do not 
need to know which of the boot and data segment numbers the flash is 
loaded into. 
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FD 
 Purpose: Displays the flash file system directory, which includes information about 

the boot file. Use this command to ensure that the correct version of the 
file is in the active boot segment. 

 Syntax: FD 

 Example: To show only the files loaded in the active boot segment., enter: 

FD ab: 

 
Note: If the active segment contains no files when you reboot the access 
point, the access point enters the AP monitor and you will no longer be 
able to telnet to it during this session. If this occurs, you must access the 
access point through its serial port to correct the problem. 

FDEL 
 Purpose: Deletes a particular file from a segment.  

 
Note: When you use the FDEL command, the file is marked as invalid 
and remains in the file system. To reclaim the file space, you must erase 
the entire segment. Use the FE command to erase a segment. 

 Syntax: FDEL f 

where f is the name of the file to be deleted. 

 Example: To delete the file UAP.PRG from the inactive boot segment, enter: 

FDEL IB:UAP.PRG  

FE 
 Purpose: Erases the files in a particular segment. To recover the files after they have 

been erased, you must reload them from another source.  

 
Note: You must execute the FE command before you execute a TFTP 
transfer.  

 Syntax: FE s 

where s is the name or number of the segment to be erased. You can enter 
ALL instead of a segment name or number if you want to erase segments 1 
through 4. 

 Example: To erase the contents of segment 1, enter: 

FE 1  

To erase the contents of the inactive boot segment, enter: 

FE IB: 
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SCRIPT 
 Purpose: Executes a specified file as a list of console commands. You can create a 

script file to automate a software download.  

 Syntax: SCRIPT f 

where f is the name of the script file to be executed.  

For more information about using the script command, see “Creating 
Script Files” on page 228. 

Using TFTP Commands 
TFTP commands are file transfer commands. An access point can act as 
either a client or server in the TFTP environment. As a server, the access 
point can service read and write requests from an access point client. As a 
client, the access point can read files from and write files to any TFTP 
server on the network. Both the client and server must operate in octet, or 
8-bit, mode. 

When executing a script file, the access point retries TFTP client 
commands get and put until the command is successfully completed. If 
the first attempt fails, the access point retries after a one-minute delay. 
With each successive failure, the retry time doubles until it reaches eight 
minutes. Once this limit is reached, it remains at eight minutes until the 
command is completed. 

In general, TFTP client sessions should fail only if the server is not 
responding either because it is busy serving other clients or because it has 
not been started. In either case, the access point backoff algorithm should 
prevent excessive network traffic when many access points are trying to 
contact a TFTP server. 

TFTP GET 
 Purpose: TFTP client requests a file from the TFTP server.  

 
Note: You must use the FE command to erase the segment before you 
execute a TFTP GET command. If you do not erase the segment, you 
may get a “can’t write file” error. 
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TFTP GET (continued) 

 Syntax: TFTP GET IPaddress foreignfilename localfilename 

where: 

IPaddress  is the IP address or DNS name of the server. You can 
use an asterisk (*) here if you want to use the value in 
serveripaddress. 

foreignfilename is the name of the file on the server. The filename can  
contain directory path information and must be in 
the format required by the server operating system. 
The file must already have the appropriate file header 
before the transfer to the access point. 

localfilename is the name you wish to call the file on the access  
point. The name must include a segment number or 
name followed by a colon. An actual filename is 
optional. If only the segment name is supplied, the 
filename is set equal to the filename that is embedded 
in the file header on the server.   

 Example: The following command gets file UAP.DNL from a directory on a PC 
server with IP address 1.2.3.4 and stores it in the inactive boot segment on 
the access point.  

TFTP GET 1.2.3.4 C:\STARTUP\UAP.DNL IB: 

The access point may generate these error messages when it issues a TFTP 
GET command. Other error messages may be returned from the server 
and displayed by the access point. See your server documentation for 
additional information. 

Error Message Explanation 

Can’t write file The file may be too big. 

The file may not have a access point file header 
(filehdr.exe). 

The file name may be incorrectly formed. 

The file may already exist in the segment and cannot be 
overwritten. You must erase the file first. 

Invalid opcode during read This error should not occur under normal operating 
conditions. This error indicates a TFTP protocol error that 
will not occur when you use TFTP servers that conform to 
the protocol. 
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TFTP PUT 
 Purpose: Copies a file from a TFTP client to the TFTP server or to another access 

point.  

 Syntax: TFTP PUT IPaddress foreignfilename localfilename 

where: 

IPaddress  is the IP address or DNS name of the server. You can 
use an asterisk (*) here if you want to use the value in 
the serveripaddress. 

foreignfilename is the name of the file as it will appear on the server.  
The file name can contain directory path information 
and must be in the format required by the server 
operating system. 

localfilename is the name of the file to be sent from the access  
point. 

 Example: The following command takes file UAP.PRG that is saved in the active 
boot drive on the access point client and stores it in the inactive boot 
segment on the access point server that has IP address 1.2.3.4. 

TFTP PUT 1.2.3.4 IB:UAP.PRG AB:UAP.PRG 

The access point may generate these error messages when it issues a TFTP 
PUT command. Other error messages may be returned from the server 
and displayed by the access point. See your server documentation for 
additional information. 

Error Message Explanation 

Can’t read file The requested file may not exist. 

Invalid opcode during put This error should not occur under normal operating 
conditions. This error indicates a TFTP protocol error that 
will not occur when you use TFTP servers that conform to 
the protocol. 

  

TFTP SERVER LOG 
 Purpose: The access point can function as a TFTP server. You can use the TFTP 

server log command to save a history of TFTP client requests. The TFTP 
server log contains useful TFTP server status information. The log begins 
when you set up the server. To clear the log, reboot the access point. 

 Syntax: TFTP SERVER LOG 
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TFTP SERVER START 
 Purpose: Use this command to enable the access point to act as a server. You can 

enable one access point to act as a TFTP server and download files to 
additional access points.  

 Syntax: TFTP SERVER START 

After you issue this command, the access point responds to TFTP client 
requests that are directed to its IP address. When acting as a server, the 
access point supports up to four concurrent TFTP sessions.  

TFTP SERVER STOP 
 Purpose: When you are done transferring files, you can stop the access point from 

being a TFTP server by using this command.  

 Syntax: TFTP SERVER STOP 

After you issue this command, the access point no longer responds to 
TFTP client requests; however, current TFTP sessions with the server are 
allowed to complete. This table lists error messages that can be issued from 
the TFTP server. These messages are sent to the client and are meant to be 
read from the client perspective. 

Error Message Explanation 

TFTP server only 
supports octet mode 

The client is attempting to transfer a file in ASCII mode. The 
access point TFTP server only supports octet mode, which 
includes binary and image. 

Unable to open remote 
file 

The TFTP server cannot open the file that is named in the 
read or write request. If you are trying to read a file, the file 
may not exist. If you are trying to write a file, the file may be 
too big, the file may not have a access point file header, or the 
file name may be incorrectly formed. 

Can’t read remote file The server returns this message if the access point file system 
returns an error while the server is attempting to read the file. 
This message is unlikely to occur. 

Can’t write remote file The server returns this message if the access point file system 
returns an error while the server is attempting to write the file. 
This message is unlikely to occur. 

TFTP opcode not read 
or write request 

This error should not occur under normal operating 
conditions. This error indicates that the TFTP client does not 
conform to the protocol. 

Invalid opcode during 
read 

This error should not occur under normal operating 
conditions. This error indicates that the TFTP client does not 
conform to the protocol. 

Invalid opcode during 
write 

This error should not occur under normal operating 
conditions. This error indicates that the TFTP client does not 
conform to the protocol. 
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Using sdvars Commands 
Use sdvars commands to manipulate certain software download variables. 
Sdvars commands support both GET and SET arguments. You can enter 
sdvars commands to GET a software download object, and then issue the 
sdvars command using the SET argument to assign the object a specified 
value. 

This section describes the sdvars commands using the SET argument. To 
execute an sdvars command using the GET argument, omit the variable 
from the end of the command. 

sdvars set serveripaddress 
 Purpose: Sets the internal variable called serveripaddress to a specified address. 

 Syntax: sdvars set serveripaddress ipaddress 

where ipaddress is the address of the TFTP server.  

 Example: To set the IP address of the server to 192.168.49.29, enter: 

sdvars set serveripaddress 192.168.49.29  

sdvars set scriptfilename 
 Purpose: Sets the internal variable scriptfilename to a specified string. The specified 

string should be the filename of the script to be retrieved from the TFTP 
server.  

 Syntax: sdvars set scriptfilename foreignfilename 

where foreignfilename is a script filename on the TFTP server.  

 Example: To set the scriptfilename to SCRIPT.DAT, enter: 

sdvars set scriptfilename script.dat 

sdvars set starttime 
 Purpose: Sets the internal variable starttime. Starttime is a countdown time; that is, 

when zero is reached, the software download process begins. Set this 
variable to reflect how far into the future the access point is to begin 
downloading and executing the script file from the TFTP server. When 
the timer reaches 0, the access point uses the values in serveripaddress and 
scriptfilename to get the script file that is to be executed. If either 
serveripaddress or scriptfilename contains no value, an error is noted in the 
status variable and the software download process is terminated.  
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sdvars set starttime (continued) 

 Syntax: sdvars set starttime dd:hh:mm:ss 

where dd:hh:mm:ss is how far in the future the reboot is to begin and 

dd is days. 

hh  is hours. 

mm  is minutes. 

ss is seconds. 

 Example: To begin the script file download in 5 minutes, enter: 

sdvars set starttime 00:00:05:00  

 
Note: If you need to stop the download, you can do so by setting starttime 
to 0 if it has not already been reached by the countdown. Resetting 
starttime to 0 stops the timer and the download process. 

sdvars set checkpoint 
 Purpose: Sets the internal variable called checkpoint to a specified value. The 

checkpoint variable is useful for monitoring the progress of a script file as 
it is executed. You can set the checkpoint variable to a different value after 
each script command, and then query the checkpoint value using SNMP 
to determine the progress of the download.  

 Syntax: sdvars set checkpoint value 

where value is a whole number.  

 Example: Consider the following script file commands: 

sdvars set checkpoint 1 

fe ab 

sdvars set checkpoint 2 

TFTP get * uap.prg ab 

sdvars set checkpoint 3 

reboot 

When the software download is started, you can use SNMP to query its 
progress by reading the checkpoint variable. If the variable has a value of 2, 
you know that the access point is trying to execute the TFTP get 
statement. If the value is 3, you know the script has completed and the 
reboot was executed. The value of the checkpoint variable may also be 
helpful in determining where an error occurred if the script fails.  
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sdvars set terminate 
 Purpose: Sets the internal variable terminate to a specified value. Use terminate to 

stop a countdown process in the access point. If either starttime or 
nextpoweruptime is counting down, setting this variable stops the timer 
and halts the countdown process.  

 
Note: You should use caution when using this command. If the script file 
is being downloaded or executed, setting this variable interrupts the 
processing and can leave the access point in an undetermined state that 
may require user intervention. 

 Syntax: sdvars set terminate 

sdvars set setactivepointers 
 Purpose: Sets the setactivepointers command to change inactive segments to active 

segments the next time the access point is rebooted. This command is 
usually used with the nextpoweruptime command.  

 Syntax: sdvars set setactivepointers none/boot/data/both 

where: 

none does not change the active segments. The default is none.  
Also, when the reboot is completed, the access point resets 
this value to none. 

boot  changes the inactive boot segment to the active boot segment. 

data  changes the inactive data segment to the active data segment. 

both changes both the boot and data inactive segments to the  
active segments. 

 Example: To change the inactive boot and data segments to active at the next 
reboot, enter: 

sdvars set setactivepointers both 

sdvars set nextpoweruptime 
 Purpose: Sets the nextpoweruptime command to set the internal variable 

nextpoweruptime to a countdown time so that when 0 is reached, the 
access point will reboot. When the nextpoweruptime counter reaches 0, 
the access point checks the value of the setactivepointers variable, takes the 
appropriate action, and then reboots.  

 
Note: If you need to terminate the reboot, you can do so by setting 
nextpoweruptime to 0 if it has not already been reached by the 
countdown. By resetting nextpoweruptime to 0, the timer is stopped so 
the unit does not reboot. 
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 Syntax: sdvars set nextpoweruptime dd:hh:mm:ss 

where dd:hh:mm:ss is how far in the future the reboot is to begin.   

dd is days. 

hh  is hours. 

mm  is minutes. 

ss is seconds. 

 Example: To reboot the access point 2 hours from now, enter: 

sdvars set nextpoweruptime 00:02:00:00  

Creating Script Files 
You can create a script file that will execute a series of commands. For 
example, when you upgrade the access point, you typically need to erase 
the appropriate file segments, download the new files, and reboot using 
the new software. You can create a script file to perform these commands. 

Script files are ASCII text files with a 32-byte file system header appended. 
You may need to contact your local Intermec representative for a copy of 
the header file called filehdr.exe.  

Follow these rules when creating script files: 

• The total file size including the header must be less than 4096 bytes, 
which is the size of the RAM file segment. 

• Each line in the script file must have fewer than 80 characters 

• Each line in the script file must be terminated by a line feed or carriage 
return.  

• You can only have one command per line.  

• You can include comments on a line by using the pound (#) sign; all 
characters after a pound sign are ignored. 

To test a script file, log onto an access point and type each of the script file 
commands. 

#Sample script file for upgrading an access point  

#Step 1. Delete files 

file sdvars set checkpoint 1 

file fe ib: 

file fe id: 
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#Step 2. Get boot files 

file sdvars set checkpoint 2 

file tftp get *\data\bootchk.dnl ib: 

file tftp get *\startup\uap.dnl ib: 

file tftp get *\startup\uapboot.dnl ib: 

 

#Step 3. Get data files 

file sdvars set checkpoint 3 

file tftp get *\data\bkgrnd.dnl id: 

file tftp get *\data\bootchk.dnl id: 

file tftp get *\data\discinca.dnl id: 

file tftp get *\data\falcon_.dnl id: 

file tftp get *\data\help.dnl id: 

file tftp get *\data\hlp.dnl id: 

file tftp get *\data\intermec.dnl id: 

file tftp get *\data\menu.dnl id: 

file tftp get *\data\sftdwnl.dnl id: 

file tftp get *\data\welcome.dnl id: 

file tftp get *\data\write.dnl id: 

 

#Step 4. Set checkpoint to show completed 

file sdvars set checkpoint 4 
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Specifications 

 

This appendix provides specifications for reference purposes only. Actual 
product performance and compliance with local telecommunications 
regulations may vary from country to country. Intermec only ships 
products that are type approved in the destination country. 

A 
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Specifications 

WA22 
Height 4.6 cm (1.8 in) 

Length 25.0 cm (9.8 in) 

Width 15.9 cm (6.3 in) 

Weight 526 g (1.16 lb) 

POE electrical rating x 48V, 315 mA 

Operating temperature -20°C to +55°C (-4°F to +131°F) 

Storage temperature -40°C to +70°C (-40°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT/100BaseTx (twisted-pair) 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Ethernet data rate 10 Mbps/100 Mbps (Ethernet) 
100 Mbps (Fiber optic) 

Fiber optic interface (optional) MT-RJ 

Radios supported IEEE 802.11b, IEEE 802.11a 

Media Access protocol CSMA/CD 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Serial port maximum data rate 115,200 bps 

Management interfaces Web browser-based manager, text-based menu system, 
serial port, Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 

Regulatory Approvals EN 550022/CISPR 22 Class A; FCC Part 15 & ICES-
003 Class A; C tick Marked (AS 3548); CE Market, 
Compliant with RTT&E, EMC, LVD directives; (See 
separate radio approvals); UL Listed 1950 & IEC 
60529-IP53; CSA Certified, C22.2 #950 & C22.3 
#94-ENC 3.5; TUV Licensed, EN 60950 & EN 
60529-IP53; NYCE Certified, NOM 19, plenum-rated 
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2101 
Height 3.8 cm (1.5 in) 

Length 25.0 cm (9.8 in) 

Width 15.9 cm (6.3 in) 

Weight 526 g (1.16 lb) 

AC electrical rating ∼100 to 240V, 1.0A, 50 to 60 Hz 

POE electrical rating x 48V, 315 mA 

Operating temperature -20°C to +65°C (-4°F to +149°F) 

Storage temperature -40°C to +70°C (-40°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT/100BaseTx (twisted-pair) 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Ethernet data rate 10 Mbps/100 Mbps (Ethernet) 
100 Mbps (Fiber optic) 

Fiber optic interface (optional) MT-RJ 

Radios supported IEEE 802.11b, WLI-Forum OpenAir 

Media Access protocol CSMA/CD 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Serial port maximum data rate 115,200 bps 

Management interfaces Web browser-based manager, text-based menu system, 
serial port, Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 

Regulatory Approvals FCC Part 15.247 Certified; Canada RSS 210 Certified; 
ETS 300 328 Type Approved; EN 55022 / CISPR 22 
Class B; FCC Part 15 & ICES-003 Class A; SCT 
Certification, NOM-EM-121, pending AS 3548, C 
tick Marked; Compliant with all European Directives, 
CE Marked (~ETS 300 826); UL Listed, UL 1950 & 
IEC 60529–IP53; CSA Certified, C22.2 #950 & 
C22.2; #94–ENC 3.5; TUV Licensed, EN 60950 & 
EN 60529–IP53; NYCE Certified, NOM 19. 
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WA21 
Height 9.5 cm (3.8 in) 

Length 35.5 cm (14.0 in) 

Width 23.6 cm (9.3 in) 

Weight 2.63 kg (5.8 lb) 

AC electrical rating 
    Standard 
    Heater (optional) 

 
∼100 to 240V, 1.0 to 0.5A, 50 to 60 Hz 
∼100 to 120V, 1.0A, 50 to 60 Hz 
or ∼200 to 240V, 0.5A, 50 to 60 Hz 

POE electrical rating x 48V, 315 mA 

Operating temperature  

    Standard -25°C to +70°C (-13°F to +158°F) 

    Heater (optional), AC only -30°C to +70°C (-22°F to +158°F) 

    Heater/insulated bag 
    (optional), AC only 

 
-30°C to 0°C (-22°F to +32°F) 

Storage temperature -40°C to +70°C (-40°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Industrial sealing IP54 (NEMA 4) 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT/100BaseTx (twisted-pair) 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Ethernet data rate 10 Mbps/100 Mbps (Ethernet) 
100 Mbps (Fiber optic) 

Fiber optic interface (optional) MT-RJ 

Radios supported IEEE 802.11b, IEEE 802.11a 

Media Access protocol CSMA/CD 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Serial port maximum data rate 115,200 bps 

Management interfaces Web browser-based manager, text-based menu system, 
serial port, Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 

Regulatory Approvals EN 55022 / CISPR 22 ClassA; FCC Part 15 & ICES-
003 Class A; C tick Marked (AS 3548); CE Market, 
compliant with RTT&E, EMC, LVD Directives (see 
separate radio approvals); UL listed UL 1950/C22.2 
#950 IEC; 60529-IP53 and C22.2 #94-ENC 3.5; 
TUV Licensed, EN 60950 & EN 60539-IP53; NYCE 
Certified; NOM 19, plenum-rated. 
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2100 
Height 9.5 cm (3.8 in) 

Length 35.5 cm (14.0 in) 

Width 23.6 cm (9.3 in) 

Weight 2.63 kg (5.8 lb) 

AC electrical rating 
    Standard 
    Heater (optional) 

 
∼100 to 240V, 1.0 to 0.5A, 50 to 60 Hz 
∼100 to 120V, 1.0A, 50 to 60 Hz 
or ∼200 to 240V, 0.5A, 50 to 60 Hz 

Operating temperature  

    Standard -25°C to +70°C (-13°F to +158°F) 

    Heater (optional), AC only -30°C to +70°C (-22°F to +158°F) 

    Heater/insulated bag 
    (optional), AC only 

 
-30°C to 0°C (-22°F to +32°F) 

Storage temperature -40°C to +70°C (-40°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Industrial sealing IP54 (NEMA 4) 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT/100BaseTx (twisted-pair) 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Ethernet data rate 10 Mbps/100 Mbps (Ethernet) 
100 Mbps (Fiber optic) 

Fiber optic interface (optional) MT-RJ 

Radios supported IEEE 802.11b, WLI-Forum OpenAir,  
902 MHz 

Media Access protocol CSMA/CD 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Serial port maximum data rate 115,200 bps 

Management interfaces Web browser-based manager, text-based menu system, 
serial port, Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 
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2100 (continued) 

Regulatory Approvals FCC Part 15.247 Certified; Canada RSS 210 Certified; 
ETS 300 328 Type Approved; EN 55022 / CISPR 22 
Class A; FCC Part 15 & ICES-003 Class A; SCT 
Certification, NOM-EM-121; AS 3548, C tick 
Marked; Compliant with all European Directives, CE 
Marked (ETS 300 826); UL Listed, UL 1950/C22.2 
#950 IEC; 60529-IP53 and C22.2 #94-ENC3.5; Non-
incendive 2.4 GHz and 900 MHz antenna circuits UL 
Listed, UL 1604 & C22.2 #213 for Div 2; Class I–
Groups A, B, C & D; Class II–Groups F & G; Class 
III; TÜV Licensed, EN 60950 & EN 60529-IP53; 
NYCE Certified, NOM 19 

  

2102 
Height 9.3 cm (3.7 in) 

Length 14.7 cm (5.8 in) 

Width 3.5 cm (1.4 in) 

Weight 232 g (0.5 lb) 

Electrical ∼100 to 240V, 1.0A, 50 to 60 Hz 

Operating temperature -20°C to +65°C (-4°F to +149°F) 

Storage temperature -40°C to +70°C (-40°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT (twisted-pair) 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Ethernet data rate 10 Mbps (Ethernet) 

Radios supported IEEE 802.11b, WLI-Forum OpenAir 

Media Access protocol CSMA/CD 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Serial port maximum data rate 115,200 bps 

Management interfaces Web browser-based manager, text-based menu system, 
serial port, Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 

Regulatory Approvals FCC Part 15.247 Certified, Canada RSS 210 Certified, 
ETS 300 328 Type Approved, EN 55022 / CISPR 22 
Class B, FCC Part 15 & ICES-003 Class A, SCT 
Certification, NOM-EM-121, pending, AS 3548, C 
tick Marked, Compliant with all European Directives, 
CE Marked (prETS 300 826), UL Listed, C22.2 II 
950, TÜV Licensed, EN 60950, NYCE Certified, 
NOM 19 
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2106 
Height 9.3 cm (3.7 in) 

Length 14.7 cm (5.8 in) 
Width 3.5 cm (1.4 in) 
Weight 232 g (0.5 lb) 

Electrical ∼100 to 240V, 1.0A, 50 to 60 Hz 

Operating temperature 0°C to +45°C (32°F to +113°F) 

Storage temperature -20°C to +70°C (-4°F to +158°F) 

Humidity (non-condensing)  10 to 90% 

Architecture Transparent bridge 

Ethernet interfaces 10BaseT/100BaseTx (twisted-pair) 

Ethernet data rate 100 Mbps 

Radios supported IEEE 802.11a 

Media Access protocol CSMA/CD 

Ethernet compatibility Ethernet frame types and Ethernet addressing 

Filters (protocol) IP, IPX, NetBEUI, DECNET, AppleTalk 

Filters (others) IP, ARP, Novell RIP, SAP, LSP 

Management interfaces Web browser-based manager, text-based menu system, 
Telnet, SNMP 

SNMP agent RFC 1213 (MIB-2), RFC 1398 (dot3), RFC 1493 
(Bridge), 802.11, 802.1x, MobileLAN access 

Regulatory Approvals FCC Part 15.247 Certified, Canada RSS 210 Certified, 
FCC Part 15 & ICES-003 Class A, UL Listed, C22.2 
II 950, NYCE Certified, NOM 19 
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Radio Specifications 

IEEE 802.11b 
Frequency band 2.4 to 2.5 GHz worldwide 

Type Direct sequence, spread spectrum 

Modulation Direct sequence, spread spectrum (CCK, DQPSK, DBPSK) 

Power output 32 mW (15 dBm) 

Data rate 11 Mbps (High), 5.5 Mbps (Medium), 2 Mbps (Standard), 1 
Mbps (Low) with automatic fallback for increased range 

Channels 11 (North America), 13 (Europe), 4 (France), 14 (Japan). 1 
(Israel) 

Range (11 Mbps) 160 m (525 ft) open environment 

50 m (165 ft) semi-open environment 

24 m (80 ft) in closed environment 

Unlimited range with roaming 

Receiver sensitivity 
(11 Mbps)  

-82 dBm 

Security IEEE 802.11 Wired Equivalent Privacy (WEP) standard, 
WEP 64, WEP 128 

  

IEEE 802.11a 
Frequency band Full range 5.15 to 5.35 GHz (Indoor only) 

Mid range 5.25 to 5.35 GHz (Indoor and outdoor) 

Type Direct sequence, spread spectrum 

Power output 40mW 

Data rate 802.11 compliant mode: 54 Mbps, 48 Mbps, 36 Mbps, 24 
Mbps, 12 Mbps, 6 Mbps with automatic fallback for 
increased range 

Turbo mode: 72 Mbps, 48 Mbps, 36 Mbps, 24 Mbps, 12 
Mbps with automatic fallback for increased range 

Channels 802.11 compliant mode (Full range): 8 (North America) 
802.11 compliant mode (Mid range): 4 (North America) 

Turbo mode: 3 (North America) 

Range (depending on 
environment) 

248 m (813.7 ft)  6 Mbps 
240 m (787.4 ft)  12 Mbps 
175 m (574.2 ft)  18 Mbps 
132 m (433.1 ft)  24 Mbps 
56 m (183.7 ft)  36 Mbps 
37 m (121.4 ft)  48 Mbps 
19 m (62.3 ft)  54 Mbps 

Receiver sensitivity (54 
Mbps)  

-68 dBm 
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WLI Forum OpenAir 
Frequency band 2.4 GHz, actual frequencies vary by country 

Type Frequency hopping, spread spectrum 

Power output 

  2100 
 

  2101 

  2102 

 

500 mW (27 dBm) 
100 mW (20 dBm) (Europe) 

100 mW (20 dBm) 

100 mW (20 dBm) 

Data rate 1.6 Mbps  

Channels 15 

Range Up to 300 m (1,000 ft) outdoors 
Up to 150 m (500 ft) indoors 

Receiver sensitivity -77 dBm @ 1.6 Mbps 
-85 dBm @ 800 Kbps 

  

902 MHz  
Frequency band 902 to 928 MHz (not available in Europe) 

Type Direct sequence, spread spectrum 

Power output Minimum 24dBm (250 mW) 
Typical   25.5dBm (350 mW) 
Maximum 27dBm (500 mW) 

Data rate 90, 225, or 450 Kbps (depends on installation) 

Channels 7 @ 90 Kbps, 1 @ 225, or 450 Kbps 

Range  Up to 600 m (2,000 ft) line of sight 

Coverage 9,000 to 31,500 sq m (100,000 to 350,000 sq ft)  
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Antennas and Antenna Accessories 
This table identifies many of the Intermec antennas and antenna 
accessories for the radios. Contact your local Intermec representative for 
detailed information. 

Description Part Number Description 

MobileLAN 
access antennas 

(All access points) 

067261 Antenna, 2.4 GHz, 3 dBi, mini omni 

 063363 Antenna, 2.4 GHz, 5 dBi, omni 

 065349 Antenna, 2.4 GHz, 9 dBi, omni 

 067262 Antenna, 2.4 GHz, 5 dBi, dual flat 

 067263 Antenna, 2.4 GHz, 9 dBi, flat panel 

 063366 Antenna, 2.4 GHz, 14 dBi, flat panel 

 063365 Antenna, 2.4 GHz, 15 dBi, Yagi 

   

MobileLAN 
access accessories 

(All access points) 

061475 Cable connector, Type N polarized  

 063146 Cable connector, Type N 

 063245 Cable, Plug/N Plug, 1.5 m (5 ft) 

 063246 Cable, Plug/N Plug, 6.1 m (20 ft) 

 064616 Cable, TNC, Plug/N Plug, 7.6 m (2.5 ft) 

 073446 Cable, TNC, Plug/N Plug, LRM400, 1.85 m (6 
ft) 

 071178 Cable, TNC, Plug/N Plug, LRM400, 3.7 m (12 
ft) 

 071179 Cable, N, Plug/N Plug, LMR600, 9.1 m (30 ft) 

 064432 LMR400 cable, 30.5 m (100 ft) 

 589377 LMR400 cable prep tool 

 067265 Adapter cable (to cable), TNC, Plug/N Recept, 
LMR200, 0.3 m (1 ft) 

 067266 Adapter cable (to antenna), TNC, Plug/N Plug, 
LMR400, 0.61 m (2 ft) 

 061868 Lightning suppressor and bracket  

 063198 Splitter, 2.4 GHz only 

 063153 Shrink tubing kit 
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Antennas and Antenna Accessories (continued) 

Description Part Number Description 

WA22/2101/ 
WA21/2100 
antennas 

071122 Antenna, 2.4 GHz, corner reflector 

 071121 Antenna, 2.4 GHz, 3 dBi, diversity 

   

WA22/WA21/ 
2100 antennas 

066147 Antenna, 2.4 GHz, omni 

   

WA22/WA21 
antennas 

072730 Antenna, 5 GHz, 4 dBi, omni, swivel, TNC 

 072759 Antenna, 5 GHz, 6 dBi, omni  

 072760 Antenna, 5 GHz, 9 dBi, omni 

 072761 Antenna, 5 GHz, 3 dBi, omni, ceiling mount 

 072762 Antenna, 5 GHz, corner reflect 

   

WA22/WA21 
accessories for 
plenum rating 

072821 Adapter cable (to cable), TNC, Plug/N Recept, 
LMR200, 0.3 m (1 ft) 

 072822 Adapter cable (to antenna), TNC, Plug/N Plug, 
LMR400, 0.61 m (2 ft) 

 072823 Cable, TNC, Plug/N Plug, LRM400, 3.7 m (12 
ft) 

 073447 Cable, TNC, Plug/N Plug, LRM400, 1.85 m (6 
ft), plenum-rated 

 072824 Cable, TNC, Plug/N Plug, 7.6 m (2.5 ft) 

 072825 Cable, Plug/N Plug, 1.5 m (5 ft) 

 072826 Cable, Plug/N Plug, 6.1 m (20 ft) 

 072827 Cable, N, Plug/N Plug, LMR600, 9.1 m (30 ft) 

   

2100/2101/2102 
accessories 

586610 Lightning suppressor capsule 



Appendix A — Specifications 

242 MobileLAN access System Manual 

Antennas and Antenna Accessories (continued) 

Description Part Number Description 

2100 antennas 065285 Antenna, 900 MHz, 7 dBi Omni 

 067264 Antenna, 900 MHz, 9 dBi Flat Panel 

 805-472-002 Antenna, 900 MHz, Whip 

 203-449-002 Antenna, S-UHF, 1.5 m (5 ft) 

 203-449-003 Antenna, S-UHF, 5.5 m (18 ft) 

 805-430-001 Antenna, S-UHF, 5 dB Mag Mount (includes 
3.67 m (12 ft) cable, no extensions) 

 805-431-000 Antenna, S-UHF, 1/4 Wave Ground Plane 

 805-511-001 Antenna, 400 MHz UHF, Whip 

   

2100 accessories 069304 Splitter, 900 MHz 

 216-565-003 Cable extension, 5.5 m (18 ft) 

 216-565-001 Cable extension, 11 m (36 ft) 

 216-565-004 Cable extension, 15.2 m (50 ft) 

 216-565-006 Cable extension, 30.5 m (100 ft) 

   

2101/2102 
antennas 

070140 Antenna, 2.4 GHz, 3 dBi Mini Flat (OpenAir) 

 070141 Antenna, 2.4 GHz, 3 dBi Mini Flat (802.11b) 

 071488 Antenna, Diversity, OpenAir/MobileLAN card 
11 

 071489 Antenna, Diversity, 802.11b 

 069886 Adapter cable, OpenAir/MobileLAN card 11 (to 
cable) 

 069887 Adapter cable, 802.11b (to cable) 

 069910 Adapter cable, OpenAir/MobileLAN card 11 (to 
cable adapter 067265/ 067266) 

 069911 Adapter cable, 802.11b (to cable adapter 
067265/ 067266) 

 070402 Adapter cable, OpenAir/MobileLAN card 11 (to 
antenna) 

 070403 Adapter cable, 802.11b (to antenna) 

   

2101 antennas 069753 Antenna, 2.4 GHz Omni (2101 spare) 

 069903 Antenna, 2.4 GHz Omni, 802.11b (2101 spare) 

   

2102 accessories  Mounting kit for printers. 
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Default Settings 

 

This appendix provides factory defaults for reference purposes only. 

B 
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Default Settings 
The factory default settings for the access points are listed in this section. 
You can record the settings for your installation in each table for reference.  

TCP/IP Settings Menu Defaults 

Parameter Name Range Default Your Site? 

IP Address 4 nodes, 0 to 255 0.0.0.0  

IP Subnet Mask 4 nodes, 0 to 255 255.255.255.0  

IP Router (Gateway) 4 nodes, 0 to 255 0.0.0.0  

DNS Address 1 4 nodes, 0 to 255 0.0.0.0  

DNS Address 2 4 nodes, 0 to 255 0.0.0.0  

DNS Suffix 1 0 to 31 characters (blank)  

DNS Suffix 2 0 to 31 characters (blank)  

DHCP Mode Always use DHCP, 
Use DHCP if IP 
Address is Zero, 
Disable DHCP, This 
AP is a DHCP Server 

Use DHCP if IP 
Address is Zero 

 

DHCP Server Name 0 to 31 characters (blank)  

Auto ARP Minutes 0 to 120 5  

    

DHCP Server Setup Menu Defaults 

Parameter Name Range Default Your Site? 

Low Address 4 nodes, 0 to 255 10.10.10.100  

High Address 4 nodes, 0 to 255 10.10.10.199  

Lease Time days:hours:minutes 0:00:20  
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Spanning Tree Settings Menu Defaults 

Parameter Name Range Default Your Site? 

AP Name 0 to 16 characters (access point serial 
number) 

 

LAN ID (Domain) 0 to 254 0  

Root Priority 0 to 7 1  

Enable Ethernet 
Bridging 

Check/Clear Check  

Enable GVRP for 
VLAN 

Check/Clear Clear  

Secondary LAN Bridge 
Priority 

0 to 7 0  

Secondary LAN 
Flooding 

Enabled, Multicast, 
Unicast, Disabled 

Disabled  

    

Global Flooding Menu Defaults 
Parameter Name Range Default Your Site? 

Multicast Flooding  Universal, 
Hierarchical, Disabled 

Hierarchical  

Multicast Outbound to 
Secondary LANs 

Enabled globally/Set 
locally 

Set locally  

Allow Multicast 
Outbound to Terminals 

Check/Clear Check  

Unicast Flooding Universal, 
Hierarchical, Disabled 

Disabled  

Unicast Outbound to 
Secondary LANs 

Enabled globally/Set 
locally 

Set locally  

Allow Unicast 
Outbound to Terminals 

Check/Clear Check  

Enable ARP Flooding Check/Clear Check  
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Global RF Parameters Menu Defaults 
Parameter Name Range Default Your Site? 
Perform RFC1042/DIX 
Conversion 

Check/Clear Check  

S-UHF Rfp Threshold    

Set Globally Enabled/Disabled Disabled  

Value 0 to 250 bytes 70 bytes  

S-UHF Frag Size    

Set Globally Enabled/Disabled Disabled  

Value 50 to 250 bytes 250 bytes  

902 MHz Frag Size    

Set Globally Enabled/Disabled Disabled  

Value 50 to 250 bytes 250 bytes  

S-UHF/902 MHz 
Awake Time 

   

Set Globally Enabled/Disabled Disabled  

Value 0 to 250 tenths of a 
second 

10 (902 MHz) 
20 (S-UHF) 

 

RFC1042 Types to Pass 
Through 

   

1 Two sets of 
hexadecimal pairs 00 
through FF. 

80 F3  

2 Two sets of 
hexadecimal pairs 00 
through FF. 

81 37  

3 through 20 Two sets of 
hexadecimal pairs 00 
through FF. 

00 00  
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Ethernet Configuration Menu Defaults 

Parameter Name Range Default Your Site? 

Port Type 10/100 Mb Twisted-
Pair/100 Mb Fiber 
Optic 

10/100 Mb 
Twisted-Pair 

 

Link Speed Auto Select, 100 Mbps 
Full-Duplex, 100 
Mbps Half-Duplex, 10 
Mbps Full-Duplex, 10 
Mbps Half-Duplex 

Auto Select  

Enable Link Status 
Check 

Check/Clear Clear  

Address Table    

1 through 20 Six sets of hexadecimal 
pairs 00 through FF. 

00 00 00 00 00 
00 

 

Frame Type Filters    

Allow/Pass Check/Clear Check  

Scope Unlisted/All Unlisted  

Predefined Subtype 
Filters 

   

Allow/Pass Check/Clear Check  

Customizable Subtype 
Filters 

   

Allow/Pass Check/Clear Check  

SubType DIX-IP-TCP-Port, 
DIX-IP-UDP-Port, 
DIX-IP-Protocol, 
DIX-IPX-Socket, 
DIX-EtherType, 
SNAP-IP-TCP-Port, 
SNAP –IP-UDP-Port,
SNAP –IP-Protocol, 
SNAP –IPX-Socket, 
SNAP –EtherType, 
802.3-IPX-Socket, 
802.2 –IPX-Socket, 
802.2-SAP 

DIX-IP-TCP-Port  

Value Two sets of 
hexadecimal pairs 00 
through FF. 

00 00  



Appendix B — Default Settings 

248 MobileLAN access System Manual 

Ethernet Advanced Filters Menu Defaults 
Parameter Name Range Default Your Site? 

Filter Values    

Value ID  0  

Value  (blank)  

Filter Expressions    

ExprSeq  0  

Offset  0  

Mask  (blank)  

Op EQ, NE, GT, LE EQ  

Value ID  0  

Action And, Pass, Drop And  

    

IP Tunnels Menu Defaults 

Parameter Name Range Default Your Site? 

Mode Listen, Originate If 
Root, Disabled 

Listen  

Enable IGMP (Listen 
mode) 

Check/Clear Clear  

Allow IP Multicast 
(Originate if Root 
mode) 

Check/Clear Clear  

Multicast Address 4 nodes, 0 to 255 224.0.1.65  

IP Addresses    

1 through 8 4 nodes, 0 to 255 or 
DNS name up to 31 
characters 

  

Frame Type Filters    

Allow/Pass Check/Clear Check  

Scope Unlisted/All Unlisted  

Predefined Subtype 
Filters 

   

Allow/Pass Check/Clear Check  
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IP Tunnels Menu Defaults (continued) 

Parameter Name Range Default Your Site? 

Customizable Subtype 
Filters 

   

Allow/Pass Check/Clear Check  

SubType DIX-IP-TCP-Port, 
DIX-IP-UDP-Port, 
DIX-IP-Protocol, 
DIX-IPX-Socket, 
DIX-EtherType, 
SNAP-IP-TCP-Port, 
SNAP –IP-UDP-Port,
SNAP –IP-Protocol, 
SNAP –IPX-Socket, 
SNAP –EtherType, 
802.3-IPX-Socket, 
802.2 –IPX-Socket, 
802.2-SAP 

DIX-IP-TCP-Port  

Value Two sets of 
hexadecimal pairs 00 
through FF. 

00 00  

    

Network Management Menu Defaults 

Parameter Name Range Default Your Site? 

SNMP Read 
Community 

1 to 15 characters public  

SNMP Write 
Community 

1 to 15 characters CR52401  

SNMP Secret 
Community 

1 to 15 characters Secret  
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Security Menu Defaults 

Parameter Name Range Default Your Site? 

Browser Access Secure-Only (Port 
443), Enabled (Port 
80/443), Disabled 

Enabled (Port 
80/443) 

 

Allow Telnet Access 
(Port 23) 

Check/Clear Check  

Allow SNMP Access 
(Port 161/162) 

Check/Clear Check  

Allow TFTP Access 
(Read-Only) 

Check/Clear Check  

Allow ICMP 
Configuration 

Check/Clear Check  

    

Passwords Menu Defaults 
Parameter Name Range Default Your Site? 

Use RADIUS for Login 
Authorization 

Check/Clear Clear  

User Name 1 to 32 characters Intermec  

Password 1 to 32 characters Intermec  

Read Only Password 1 to 32 characters (blank)  

Allow Service Password Check/Clear Check  

    

IEEE 802.11 (b or a) Radio Security Menu Defaults 
Parameter Name Range Default Your Site? 

ACL Client 
Authorization 

Check/Clear Clear  

ACL RADIUS Client 
Password 

1 to 31 characters wireless  

VLAN 1-4094 1 (Disabled)  

WEP/802.1x 
Authentication 

Check/Clear Clear  

WEP Key Rotation 
Period 

 5  

Enable WEP Encryption Check/Clear Clear  

Allow Unencrypted 
Clients 

Check/Clear Clear  

WEP Transmit Key 1 to 4 1  

WEP Key 1-4 5, 13, or 16 bytes (blank)  
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RADIUS Server List Menu Defaults 
Parameter Name Range Default Your Site? 

IP Address 4 nodes, 0 to 255 0.0.0.0  

Secret Key 16 to 32 bytes (factory default)  

Port 1-65535 

Recommended range is 
49152-65535 

1812  

802.1x Check/Clear Clear  

ACL Check/Clear Clear  

Login Check/Clear Clear  

    

Spanning Tree Security Menu Defaults 
Parameter Name Range Default Your Site? 

Secure IAPP Check/Clear Check  

IAPP Secret Key 16 to 32 bytes (factory default)  

Allow SWAP Check/Clear Check  

Allow TLS Check/Clear Clear  

Allow TTLS Check/Clear Check  

Preferred Protocol TLS/TTLS TTLS  

User Name 1 to 31 characters anonymous  

Password 1 to 31 characters anonymous  

Verify CA Certificate Check/Clear Clear  

Authentication Server 1 
Common Name 

1 to 31 characters (blank)  

Authentication Server 2 
Common Name 

1 to 31 characters (blank)  

    

Embedded Authentication Server Menu Defaults 
Parameter Name Range Default Your Site? 

Enable Server Check/Clear Clear  

Default Secret Key 16 to 32 bytes (factory default)  

UDP Port 49152-65535 1812  

Authorization Time hh:dd:mm 0:01:00  
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IEEE 802.11b Radio Menu Defaults 

Parameter Name Range Default Your Site? 

Node Type Master, Station, 
Disabled 

Master  

SSID (Network Name) 0 to 32 characters INTERMEC  

Frequency Channel 1 to 11, 
2412 to 2462 MHz 

Channel 03, 
2422 MHz 

 

Advanced Configuration    

Data Rate 11, 5.5, 2, or 1 Mbps 11 MBits (High)  

Allow Data Rate 
Fallback 

Check/Clear Check  

Basic Rate 11, 5.5, 2, or 1 Mbps 2 MBits (Standard)  

Enable Medium 
Reservation 

Check/Clear Clear  

Reservation Threshold 1 to 65535 500  

Distance Between APs Large, Medium, or 
Small 

Large  

Enable Microwave 
Oven Robustness 

Check/Clear Clear  

Enable Load Balancing Check/Clear Clear  

Enable Medium 
Density Distribution 

Check/Clear Clear  

Data/Voice Settings Data Traffic Only, 
Data and 
SpectraLink Traffic, 
SpectraLink Traffic 
Only 

Data Traffic only  

Disallow Network 
Name of ‘ANY’ 

Check/Clear Clear  

DTIM Period 1 to 65535 1  

Inbound Filters    

Allow IAPP Check/Clear Check  

Allow Wireless 
Transport Protocol 
(WTP) 

Check/Clear Check  

Allow SpectraLink 
Voice Protocol (SVP) 

Check/Clear Check  

Allow UDP Plus 
(UDP/IP Port 5555) 

Check/Clear Check  

Allow DHCP Check/Clear Check  

Allow All Other 
Protocols 

Check/Clear Check  
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IEEE 802.11a Radio Menu Defaults 

Parameter Name Range Default Your Site? 

Node Type Master, Station, 
Disabled 

Master  

SSID (Network Name) 0 to 32 characters INTERMEC  

Frequency Dynamic, 36, 40, 42, 
44, 48, 50, 52, 56, 
58, 60, 64 

(full-range) 
Channel 36, 5180 
MHz IEEE 

(mid-range) 
Channel 52, 5260 
MHz IEEE 

 

Advanced Configuration    

Data Rate 54, 48, 36, 24, 12, or 
6 Mbps 

54 MBits (High)  

Allow Data Rate 
Fallback 

Check/Clear Check  

Basic Rate 24, 12, 6 Mbps 6 MBits (Low)  

Reservation Threshold 1 to 65535 2347 (Disabled)  

Fragmentation 
Threshold 

256 to 2346 2346  

Disallow Network 
Name of ‘ANY’ 

Check/Clear Clear  

Beacon Period 20 to 1000 TU 100  

DTIM Period 1 to 5 1  

Inbound Filters    

Allow IAPP Check/Clear Check  

Allow Wireless 
Transport Protocol 
(WTP) 

Check/Clear Check  

Allow UDP Plus 
(UDP/IP Port 5555) 

Check/Clear Check  

Allow DHCP Check/Clear Check  

Allow All Other 
Protocols 

Check/Clear Check  

    



Appendix B — Default Settings 

254 MobileLAN access System Manual 

OpenAir Radio Menu Defaults 

Parameter Name Range Default Your Site? 

Node Type Master, Station, 
Disabled 

Master  

Security ID 1 to 20 characters (blank)  

Channel 1 to 15 1  

Subchannel 1 to 15 1  

MAC Configuration Default, Interference, 
Throughput, or 
Manual 

Default  

Inbound Filters    

Allow IAPP Check/Clear Check  

Allow Wireless 
Transport Protocol 
(WTP) 

Check/Clear Check  

Allow UDP Plus 
(UDP/IP Port 5555) 

Check/Clear Check  

Allow DHCP Check/Clear Check  

Allow All Other 
Protocols 

Check/Clear Check  

Manual MAC 
Parameters 

   

Hop Period 100, 200, or 400 ms 200 ms  

Beacon Frequency 1 to 7 2  

Deferral Slot Default, 1, 3, or 7 Default  

Fairness Slot Default, 1, 3, or 7 Default  

Fragment Size 1 to 1540 310  

Transmit Mode AUTO, BFSK, or 
QFSK 

AUTO  

Normal Ack Retry 1 to 255 255  

Fragment Ack Retry 1 to 255 255  

Normal QFSK Retry 1 to 255 255  

Fragment QFSK Retry 1 to 255 255  
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902 MHz Radio Configuration Menu Defaults 

Parameter Name Range Default Your Site? 

Port Control Check/Clear Check  

Mode-Channel Depends on country DS 225K-Channel 
25 

 

Multicast Filter Check/Clear Clear  

File Name FALCON_D.BIN FALCON_D.BIN  

Hello Period 1, 2, or 3 seconds 1 second  

    

adfadf 
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ARP (Address Resolution Protocol) cache 
A table that stores IP addresses and their corresponding MAC addresses. 
The access point maintains an ARP cache and can act as an ARP server. 

BFSK (Binary Frequency Shift Key) 
A broadcasting method that lengthens the range but halves the throughput 
as compared to the QFSK method. In access points using an OpenAir 
radio, the radio can be configured so that it automatically switches to this 
method when the RF protocol determines that throughput is degrading 
due to range. The transmit mode parameter determines if BFSK will be 
used. The default setting for transmit mode is AUTO, which allows this 
automatic switching to occur.  

broadcast 
A type of transmission in which a message sent from the host is received 
by many devices on the system. 

data link tunneling 
An access point feature that encapsulates the data into an OWL data 
frame. This frame is then forwarded via the Ethernet port to the next 
access point on the path and so on until the frame reaches the root access 
point or designated bridge. The root access point or designated bridge 
unencapsulates the frame and forwards it to the host. When the root access 
point or designated bridge receives data on the Ethernet network for an 
end device, it reverses this process.  

You should only use data link tunneling if you have Ethernet switches that 
do not support the IEEE 802.1d requirements for backward learning or if 
you are using IP tunnels to provide mobility of other routable protocols. 

To enable data link tunneling, disable Ethernet bridging. 

designated bridge 
Also called a secondary LAN bridge. An access point that is assigned the 
role of bridging frames destined for or received from a secondary LAN. A 
designated bridge connects a secondary LAN with the primary LAN. In 
the access point, the secondary LAN bridge priority parameter determines 
if the access point is a candidate to become the designated bridge. 

DHCP (Dynamic Host Configuration Protocol) 
An Internet standard stack protocol that allows dynamic distribution of IP 
address and other configuration information to IP hosts on a network. 
Implementation of the DHCP client in Intermec network devices 
simplifies installation because the devices automatically receive IP 
addresses from a DHCP server on the network. 
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directional antenna 
An antenna (often called a yagi) that transmits and receives RF signals 
more in one direction than others. This radiation pattern is similar to the 
light that a flashlight produces. These antennas have a narrower beam 
width, which limits coverage on the sides of the antennas. Directional 
antennas have much higher gain than omni antennas and work best for 
covering large narrow areas or on point-to-point bridges. 

distribution LAN 
Any Ethernet LAN attached to access points that are bridging between the 
Ethernet LAN and the radio network. At any given time, only one access 
point in a distribution LAN provides access to the Ethernet LAN for a 
given node in the domain. 

DIX 
A standardized Ethernet frame format developed by Digital Equipment 
Corporation, Intel Corporation, and Xerox. Another frame format is 
802.3. 

EAP (Extensible Authentication Protocol) 
Used in 802.1x-enabled networks. A standard mechanism for support of 
different authentication methods. EAP authentication types provide 
devices with secure connections to the network as well as protect 
credentials and data privacy. See also “TLS” and “TTLS.” 

Ethernet bridging 
When an access point receives wireless traffic and the destination address is 
known, it forwards frames to the port with the shortest path to the 
destination address. When the access point has not learned the direction of 
the shortest path for the destination address, it forwards frames based on 
flooding settings to try to locate the destination address. 

flooding 
A frame is flooded when the destination location is unknown. The 
destination location of a multicast frame is never known. Unicast and 
multicast flooding parameters determine how a flooded frame is 
forwarded.  

hello period 
A time increment (usually 1, 2, or 3 seconds) that determines how often 
the access point sends out a type of multicast frame so that it can 
dynamically discover and test connections to other devices in the network. 
Once this information is learned, the access point and routers can 
exchange routing information. 
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home IP subnet 
Also called the root IP subnet and primary LAN. The IP subnet that 
contains the root access point. If wireless end devices need to roam 
between IP subnets, each end device needs to have an IP address from the 
home IP subnet. 

IAPP (Inter Access Point Protocol)  
Access points use this Intermec protocol to communicate with each other. 
For example, when a wireless end device roams to a new access point, the 
new access point informs the old access points via the root access point 
that any traffic for the end device needs to be routed to the new access 
point. 

This protocol also allows 802.1x-ready devices to roam seamlessly through 
the network without having to reauthenticate after each roam. IAPP 
distributes security credentials throughout the network. When an end 
device roams from one access point to another, its credentials are also 
transferred. 

Secure IAPP prevents unauthorized MobileLAN access products from 
joining the spanning tree and it encrypts IAPP frames. If you enable secure 
IAPP, access points will use SWAP to create secure wireless hops when 
communicating with each other. 

IGMP (Internet Group Management Protocol) 
A standard protocol that lets you originate multiple IP tunnels using one 
IP multicast address. IGMP allows IP multicast frames to be routed to 
remote IP subnets that have hosts participating in the multicast group. By 
enabling IGMP, access points can act as IP hosts and participate in an IP 
multicast group. 

inbound frames 
Frames moving toward the primary LAN. 

IP router 
A software and hardware connection between two or more subnetworks 
that permits traffic to be routed from one network to another on the basis 
of the intended destinations. 

IP subnet 
A single member of the collection of hardware networks that comprise an 
IP network. Host addresses on a given subnet share an IP network number 
with hosts on all other subnets of the IP network. The local address is 
divided into subnet-number and host-number fields to indicate which 
subnet a host is on. 
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IP tunneling 
IP tunneling is used on networks with routers. IP tunneling allows wireless 
end devices to roam across IP subnet boundaries without losing 
connection. IP tunneling encapsulates standard IP frames with Generic 
Routing Encapsulation (GRE) and forwards the frames from the root 
access point on a home IP subnet to another access point on a remote IP 
subnet. IP tunneling is done through the access points’ logical IP ports. 

MAC address 
There are two types of MAC addresses: unicast and broadcast. Unicast 
specifies a single Ethernet interface, while multicast specifies a group of 
Ethernet addresses. Broadcast is a variation of multicast in which a 
multicast is received by all interfaces.  

MIB (Management Information Base) 
This repository stores network traffic information that SNMP 
management programs collect. Your network administrator can use 
management software interacting with the MIB to obtain information 
about network activity. Contact your local Intermec representative to learn 
how to obtain a copy of the MIB for the access point. 

multicast address 
A form of broadcast address through which copies of the frame are 
delivered to a subset of all possible destinations that have a common 
multicast address.  

NAT (Network Address Translation) 
A mechanism for reducing the need for different IP addresses. NAT allows 
an organization with IP addresses that are not unique to connect to the 
network by translating those addresses into routable address space. The 
access point can act as a DHCP/NAT server. 

non-bridging secondary LAN 
A secondary LAN that does not have a designated bridge. A non-bridging 
secondary LAN is used to interconnect access points without using 
wireless hops. 

omni antenna 
An antenna that transmits and receives RF signals in all directions equally 
on a horizontal plane. This radiation pattern is similar to a doughnut with 
the antenna being in the center of the doughnut hole. These antennas 
provide the widest coverage and are most commonly used inside buildings.  

outbound frames 
Frames moving away from the primary LAN.  



Glossary 

262 MobileLAN access System Manual 

peer-to-peer network 
A type of LAN whose workstations are capable of being both clients and 
servers. 

point-to-multipoint bridge 
See also wireless bridge. A bridge that connects two wired networks with 
similar architectures. Two access points can be used to provide a point-to-
multipoint bridge between two buildings so that wired and wireless 
devices in each building can communicate with devices in the other 
building. A point-to-multipoint bridge has two radios, which allows 
wireless end devices to communicate with it. 

point-to-point bridge 
See also wireless bridge. A bridge that connects two wired networks with 
similar architectures. Two access points can be used to provide a point-to-
point bridge between two buildings so that wired and wireless devices in 
each building can communicate with devices in the other building. 

power bridge 
The MobileLAN power bridge combines power and data onto an Ethernet 
cable that is connected to the MobileLAN splitter or the access point with 
the power over Ethernet option. 

primary bridging 
Ethernet bridging on a root port. An access point uses primary bridging to 
bridge frames to and from the Ethernet network on its root port. Note 
that primary bridging is not the same as bridging to the primary LAN.  

primary LAN 
Also called the home IP subnet and root IP subnet. The IP subnet that 
contains the root access point. The primary LAN is typically the LAN on 
which the servers are located. 

QFSK (Quad Frequency Shift Key) 
A broadcasting method that shortens the range but doubles the 
throughput as compared to the BFSK method. In access points using a 2.4 
GHz OpenAir radio, the radio can automatically switch between QFSK 
and BFSK as needed if the transmit mode is set to AUTO. 

remote IP subnet 
An IP subnet that is separated from the primary IP subnet (primary LAN) 
by a router. Remote IP subnets communicate with the primary LAN 
through IP tunnels. A remote IP subnet is a type of secondary LAN. 
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root access point 
The access point with the highest root priority becomes the root of the 
network spanning tree. If the root becomes inactive, the remaining root 
candidates negotiate to determine which access point becomes the new 
root. The root can be used to set system-wide flooding and RF parameters. 
The root is also the only node in the network that can originate IP 
tunnels. 

root port 
The access point port that provides the inbound connection to the 
spanning tree. The root port provides a link to a parent access point. Note 
that a root access point does not have a root port. 

root IP subnet 
Also called the home IP subnet and primary LAN. The IP subnet that 
contains the root access point. If wireless end devices need to roam 
between IP subnets, each end device needs to have an IP address from the 
root IP subnet. 

secondary bridging 
Ethernet bridging on a non-root port. An access point that is the 
designated bridge for a secondary LAN uses secondary bridging to bridge 
frames to and from the secondary LAN on a non-root port. 

secondary LAN 
Any LAN that is reached by routing traffic through an access point. 
Wireless end devices that are communicating through a WAP comprise a 
secondary LAN. A remote IP subnet is a type of secondary LAN. 

SNAP 
A protocol extension typically used by Appletalk networks.  

SNMP (Simple Network Management Protocol) 
SNMP is a popular network management protocol in the TCP/IP and 
SPX/IPX protocol suite. SNMP allows TCP/IP and SPX/IPX sites to 
exchange configuration and status information. It uses management 
programs called “agents” to monitor network traffic. SNMP stores the 
information it collects in the Management Information Base (MIB). Your 
network administrator can use management software, such as MobileLAN 
manager, interacting with the MIB to obtain information about network 
activity. 



Glossary 

264 MobileLAN access System Manual 

spanning tree 
A form of network organization in which each device on the network has 
only one path to the root. The access points automatically configure into a 
self-organized network that provides efficient, loop-free forwarding of 
frames through the network. 

splitter 
The MobileLAN splitter converts 48V input power to 5V or 3.3V output 
power. If you want to use power over Ethernet, you plug the access point 
into the splitter and then you plug the splitter into a MobileLAN power 
bridge.  

The WA22, WA21, and 2100 do not use a splitter. 

SWAP (Secure Wireless Authentication Protocol) 
This protocol creates secure wireless hops if you enable secure IAPP. It 
forces access points to authenticate each other using an EAP-MD5 
challenge. 

TLS (Transport Layer Security) 
An EAP authentication type that not only requires a certificate on the 
authentication server, but also one on the end device. There is both server 
and client side authentication before the end device can communicate 
with the network. 

TTLS (Tunneled Transport Layer Security)  
An EAP authentication type that only requires a certificate on the 
authentication server. End devices have a user name and password that 
proves that they are authorized to communicate with the network. 

triangular routing 
The routing logic used for a mobile IP end device that has roamed to a 
foreign network. Frames destined for a mobile end device are always sent 
to the home subnet of the end device. If the end device has roamed to 
another subnet, the frame must be forwarded to the remote subnet where 
the end device currently resides. 

unicast address 
A unique Ethernet address assigned to a single device on the network. 

WAP (Wireless Access Point) 
Also called a repeater. This access point does not have any connections on 
its Ethernet port. It forwards data between the access point and the 
secondary LAN. 
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WEP (Wired Equivalent Privacy) encryption 
A feature that can be enabled in the IEEE 802.11b or 802.11a radio that 
allows data encryption for wireless communications. 

wireless bridge 
Also called a point-to-point bridge. A wireless link that connects two wired 
Ethernet segments. Two access points can be used to provide a wireless 
bridge between two buildings, so that wired and wireless devices in each 
building can communicate with devices in the other building. 

wireless hop 
A wireless link that occurs when data from a wireless end device moves 
from one access point to another access point through the radio ports. 
Using MobileLAN access products, Intermec recommends that your data 
does not travel through more than three wireless hops. 

Secure wireless hops are created when secure IAPP is enabled. Access 
points use SWAP to authenticate each other. 
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Numbers 
100BaseFX  See fiber optic 
10BaseT port  8 
10BaseT/100BaseTx port  8 
2100   

cable access door, removing  8 
connecting 

to power  46 
to the fiber optic network  50 
to the network  46 

environments  11 
installing  45 
LEDs, illustration  7 
mounting  45 
ports, illustration  10 
specifications  235 
See also access points. 

2101   
connecting 

to power  43 
to the fiber optic network  50 
to the network  43 

environments  11 
installing  42 
LEDs, illustration  7 
mounting  42 
ports, illustration  9 
specifications  233 
See also access points. 

2102   
antenna, positioning  47 
connecting to power  49 
environments  11 
external antenna, attaching  48 
installing  47 
LEDs, illustration  8 
ports, illustration  11 
specifications  236 
See also access points. 

2106   
antenna, positioning  47 
connecting to power  49 
environments  11 
installing  47 
LEDs, illustration  8 
ports, illustration  11 
specifications  237 
See also access points. 

802.11a radio 
Advanced Configuration screen  94 
advanced parameters, described  95 
configuring  92 

advanced parameters  94 
inbound filters  96 
WAP example  20 

Inbound Filters screen  97 
inbound filters, parameters described  97 
parameters, described  93 
specifications  238 
worldwide frequencies  94 

802.11b radio 
Advanced Configuration screen  87 
advanced parameters, described  88 
antenna diversity  55 
antennas, positioning  55 

dual radio  56 
for antenna diversity  55 

configuring  85 
advanced parameters  87 
inbound filters  89 
WAP example  19 

Inbound Filters screen  90 
inbound filters, described  90 
parameters, described  86 
specifications  238 
worldwide frequencies  86 

802.1x security 
certificates, installing  167, 169 
configuring  156 

the authentication server  172 
the authenticator  157 

troubleshooting  197 
understanding  156 

902 MHz radio 
Awake Time field  139 
configuring  104 
Frag Size field  139 
parameters, described  105 
specifications  239 

902 MHz Radio screen  105 
defaults  255 
File Name field  105 
Hello Period field  105 
Mode-Channel field  105 
Multicast Filter check box  105 
Port Control check box  105 

A 
About this Access Point screen  187 
access control list  See ACL 
access methods 

enabling  144 
parameters, described  145 

Access Point Login screen  34 
access points 

AP monitor, using  210–18 
configuration summary, viewing  186 
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configuring  29 
as a DHCP client  61 
as a DHCP server  62 
as a NAT server  66 
as a point-to-point bridges  22 
as a WAP  16 
as an authenticator  157 
dual radios for redundancy  28 
the EAS  166, 172 
to send ARP requests  66 

connections, viewing  184 
decreasing inteference from  41 
default settings  244 
described  2 
file segments, understanding  210 
installation guidelines  40 
maintaining  184 
managing  182 
patent information  xiv 
recovering  200 
saving configuration  36 
specifications  232 
table, features comparison  4 
troubleshooting  190 
understanding  2 

LEDs  6 
ports  8 

upgrading the software  203 
what’s new  5 

accessories, antennas  240 
ACL  166 

configuring the access point  152 
database, configuring  174 
troubleshooting  197 
using for security  152 

ACL Client Authorization check box  153 
ACL RADIUS Client Password field  153 
Action field  77 
active configuration file, about  36 
address table  See IP Addresses screen. See Ethernet 

address table 
Address Table screen  68 
Advanced Configuration screen  87, 94 

Allow Data Rate Fallback check box  88, 91, 95 
Basic Rate field  88, 92, 95 
Beacon Period field  96 
Data Rate field  88, 95 
Data/Voice Settings field  89, 91 
defaults  252, 253 
Disallow Network Name of ‘ANY’ check box  89, 

96 
Distance Between APs field  88 
DTIM Period field  89, 96 
Enable Load Balancing check box  88 
Enable Medium Density Distribution check box  88 
Enable Microwave Oven Robustness check box  88 
EnableMedium Reservation check box  88 

Fragmentation Threshold field  95 
Reservation Threshold field  88, 95 

advanced filters 
configuring  74 
example  77, 79 

advanced parameters, configuring 
for 802.11a radio  94 
for 802.11b radio  87 

Allow All Other Protocols check box  90, 97, 101 
Allow Data Rate Fallback check box  88, 91, 95 
Allow DHCP check box  90, 97, 101 
Allow IAPP check box  89, 90, 96, 97, 100, 101 
Allow ICMP Configuration check box  145 
Allow IP Multicast check box  123 
Allow Multicast Outbound to Terminals check box  

137 
Allow Service Password check box  147, 149 
Allow SNMP Access check box  145 
Allow SpectraLink Voice Protocol check box  90 
Allow SWAP check box  151, 161 
Allow Telnet Access check box  145 
Allow TFTP Access check box  145 
Allow TLS check box  151, 161 
Allow TTLS check box  151, 161 
Allow UDP Plus check box  89, 90, 96, 97, 100, 101 
Allow Unencrypted Clients check box  156 
Allow Unicast Outbound to Terminals check box  137 
Allow Wireless Transport Protocol check box  89, 90, 

96, 97, 100, 101 
antenna diversity  See antennas. See diversity 
antennas 

directional  56 
external, attaching to 2102  48 
guidelines on placement  54 
list of  240 
omni  56 
positioning 

2102  47 
2106  47 
for diversity  55 
for dual radios  56 
for IEEE 802.11b radio  55 
for OpenAir WAP  56 

AP Connections screen  184, 195, 196 
AP monitor 

commands, list of  211 
commands, using  211 
entering  210 
using  210 

AP Name field  114 
AP*WEB.BIN  204, 206 
AP824X.DNL, using to recover an access point  201 
AP855.DNL, using to recover an access point  201 
architecture 

2100  235 
2101  233 
2102  236 
2106  237 
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architecture (continued) 
WA21  234 
WA22  232 

ARP flooding, enabling  135 
ARP requests, configuring the access point to send  66 
attaching 

2102, external antenna  48 
external antennas  54 

authentication server  61, 166 
certificates, installing  167, 169 
configuring  172 
database, configuring  174 
enabling  172 
requirements  157 
See also EAS. 

Authentication Server Common Name field  162 
authenticator  157 

configuring  157 
Authorization Time field  173 
autobaud, using to set baud rate  212 

B 
Basic Rate field  88, 92, 95 
baud rate, setting  212 
Beacon Frequency field  103 
Beacon Period field  96 
boot segment  210 
bridges  See point-to-point bridges 
bridging 

restrictions  116 
understanding  115 

Browser Access field  145 
bytes transmitted and received, viewing  185 

C 
cable access door, removing  8 
CAM mode commands, using  212 
cautions, understanding  xii 
certificate authority, about  156 
Certificate Details screen  168, 171 
certificates 

installing  167, 169 
uninstalling  171 
viewing  168 

changing 
passwords  148 
user name  148 

Channel field  99 
channels 

902 MHz radio  239 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

Command Console mode  34 
entering  218 
using  218 
using sdvars commands  225 

commands 
AP monitor, using  211 

CAM mode, using  212 
Command Console mode, using  219 
sdvars, using  225 
Service mode, using  214 
Test mode, using  213 
TFTP, using  221 

communications program, using 
to configure the access points  31 
to manage access points  182 

community strings  See SNMP 
comparing IP tunnels to mobile IP  134 
configuration 

discarding changes  37 
understanding files  36 
viewing  186 

configuration error messages, using for troubleshooting  
191 

Configuration Summary screen  186 
configuration wizard  See MobileLAN access 

Configuration Wizard 
configuring 

802.11a radio  92 
802.11b radio  85 
802.1x security  156 
902 MHz radio  104 
access points  29 

using a communications program  31 
using a telnet session  35 
using a web browser interface  34 
using the MobileLAN access Configuration 

Wizard  29 
using the MobileLAN access Utility  29 

ACL  152 
authentication server  172 
designated bridge  110 
EAS  172 
Ethernet address table  68 
Ethernet filters  69 
Ethernet settings  67 
fiber optic settings  67 
global flooding  135 
global RF parameters  138 
IP address list  124 
IP tunnel filters  124 
IP tunnels  123 
OpenAir radio  98 
root access point  109 
spanning tree  113 
SpectraLink network  91 
TCP/IP settings  60 
the access point 

as a DHCP client  61 
as a DHCP server  62 
as a NAT server  66 
as an authenticator  157 
to send ARP requests  66 

VLANs  162 
WEP 64/128 security  154 
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connecting 
2100 

to Ethernet  46 
to power  46 

2101 
to Ethernet  43 
to power  43 

2102 
to Ethernet  49 
to power  49 

2106 
to Ethernet  49 
to power  49 

fiber optic network  50 
power over Ethernet  53 
WA21 

to Ethernet  45 
to power  45 

WA22 
to Ethernet  42 
to power  42 

cordless telephones, decreasing interference from  41 
coverage 

802.11a radio  238 
802.11b radio  238 
902 MHz radio  239 

creating 
EAS database  174 
script files  228 

current configuration file, about  36 
Customizable Subtype Filters screen  72, 128 
customizing subtype filters  72, 128 

example  73 

D 
data link tunneling 

enabling  111 
understanding  111 

data rate 
902 MHz radio  239 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

data rate fallback, allowing  88, 91, 95 
Data Rate field  88, 95 
data segment  210 
Data/Voice Settings field  89, 91 
database 

configuring 
for authentication server  174 
for EAS  174 

entries, described  175 
exporting  177 
importing  179 
rejected list 

adding entries  176 
deleting entries  177 
using  176 

Database screen  See Embedded Authentication Server 
Database screen 

decreasing interference  40 
default configuration file, about  36 
Default Secret Key field  173 
default settings 

list of  244 
restoring  189 

Deferral Slot field  103 
designated bridges 

configuring  110 
understanding  110 

DHCP 
configuring the access point 

as a client  61 
as a server  62 

server setup parameters, described  64 
setting inbound filter  90, 97, 101 
supported server options  64 
unsupported server options  65 

DHCP Mode field  62, 63, 66 
DHCP Server Name field  62 
DHCP Server Setup screen  64 

defaults  244 
High Address field  64 
Lease Time field  64 
Low Address field  64 

directional antennas  55, 56, 57 
See also antennas. 

Disallow Network Name of ‘ANY’ check box  89, 96 
Distance Between APs field  88 
distributed upgrade server  See MobileLAN access 

Utility 
diversity   

antennas, list of  240 
positioning antennas  55 
See also antennas. 

DNL files, using to recover an access point  201 
DNS Address field  61 
DNS Suffix field  61 
domain  See LAN ID 
DTIM Period field  89, 96 
dual radios 

positioning antennas  56 
using for redundancy  28 

E 
EAS 

802.1x (TLS)  175 
802.1x (TTLS/PEAP)  175 
ACL  175 
configuring  172 
database 

adding entries from the rejected list  176 
clearing the rejected list  177 
configuring  174 
creating  177 
entries, described  175 
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EAS, database (continued) 
exporting  177 
importing  179 

enabling  172 
Login  175 
RADIUS  175 
using 

as an authentication server  157 
the rejected list  176 
to authorize logins  145 
to maintain an ACL  152 

EAS Database screen  178, 179 
electrical specifications 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

embedded authentication server  See EAS 
Embedded Authentication Server Database screen  174 

802.1x (TLS)  175 
802.1x (TTLS/PEAP)  175 
ACL  175 
Login  175 
Password field  175 
RADIUS  175 
Type field  174, 175 
User Name field  175 

Embedded Authentication Server screen  173 
Authorization Time field  173 
Default Secret Key field  173 
defaults  251 
Enable Server check box  173 
UDP Port field  173 

Enable ARP Flooding check box  137 
Enable Ethernet Bridging check box  109, 110, 114 

using to enable data link tunneling  111, 112 
Enable GVRP for VLAN check box  163 
Enable IGMP check box  123 
Enable Link Status Check check box  68 
Enable Load Balancing check box  88 
Enable Medium Density Distribution check box  88 
Enable Medium Reservation check box  88 
Enable Microwave Oven Robustness check box  88 
Enable Server check box  173 
Enable VRP for VLAN check box  114 
Enable WEP Encryption check box  155, 156 
enabling 

access methods  144 
secure IAPP  150, 159 
secure wireless hops  150, 159 

entering 
AP monitor  210 
Command Console mode  218 
Service mode  214 
Test mode  213 

environments, choosing access points  11 

Ethernet 
address table, configuring  68 
compatibility 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

configuring 
address table  68 
settings  67 
TCP/IP settings  60 

connecting 
2100  46 
2101  43 
2102  49 
2106  49 
WA21  45 
WA22  42 

data rate 
2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

interfaces 
2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

parameters, described  60, 67 
Ethernet address table, configuring  68 
Ethernet filters 

advanced filters 
using  74 
example  77, 79 

configuring  69 
example  73 
frame type filters, using  69 
predefined subtype filters, using  71 
subtype filters, customizing  72 

Ethernet screen  67 
defaults  247 
Enable Link Status Check check box  68 
Link Speed field  67 
Port Type field  67 

examples 
advanced filters  77, 79 
configuring 

802.11a point-to-point bridge  27 
802.11a WAP  20 
802.11b access point  13 
802.11b point-to-point bridge  26 
802.11b WAP  19 



Index 

MobileLAN access System Manual 273 

examples, configuring (continued) 
OpenAir access points  15 
OpenAir WAP  21 

customizable subtype filters  73 
IP tunnel filters  130 

exiting 
CAM mode  213 
Command Console mode  219 
Service mode  214 
Test mode  213 

exporting the EAS database  177 
exporting the Security Events log  198 
Expression Sequence field  76 
ExprSeq field  See Expression Sequence field 
extending network range  16 
external antenna 

attaching to 2102  48 
guidelines on placement  54 

F 
factory default settings  See default settings 
Fairness Slot field  103 
Falcon radio  See 902 MHz radio 
features  4 
fiber optic  8 

configuring settings  67 
connecting 

to an MT-RJ network  50 
to an SC network  51 
to an ST network  52 

parameters, described  67 
specifications  232, 233, 234, 235 
using to connect the access points  50 

File Name field  105 
file segments, access point  210 
filter expressions 

parameters, described  76 
setting  75 

Filter Expressions screen  76 
Action field  77 
defaults  248 
Expression Sequence field  76 
Mask field  76 
Offset field  76 
Operation field  76 
Value ID field  77 

Filter Values screen  75 
defaults  248 

filter values, setting  74 
filters   

2100  235 
2101  233 
2102  236 
2106  237 
advanced, configuring  74 
ARP server  121 
configuring 

for 802.11a radio  96 

for 802.11b radio  89 
for OpenAir radio  100 

examples 
Ethernet advanced filters  77, 79 
IP filters  130 

expressions, setting  75 
permanent  122 
predefined subtype, using  71, 127 
subtype, customizing  72, 128 
values, setting  74 
WA21  234 
WA22  232 
See also IP tunnel filters. See also inbound filters. See 

also Ethernet filters. 
Find This AP button  188 
Fragment Ack Retry field  104 
Fragment QFSK Retry field  104 
Fragment Size field  103 
Fragmentation Threshold field  95 
frame forwarding  120 

always forwarded  125 
inbound  121 
never forwarded  122 
outbound  121, 122 

frame type filters 
parameters, described  71, 127 
using  69, 125 

Frame Type Filters screen  70, 126 
frames transmitted and received, viewing  185 
frequencies, worldwide 

802.11a radio  94 
802.11b radio  86 

frequency band 
902 MHz radio  239 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

Frequency field  86, 93 

G 
global flooding 

configuring  135 
parameters, described  136, 137 

Global Flooding screen  136 
Allow Multicast Outbound to Terminals check box  

137 
Allow Unicast Outbound to Terminals check box  

137 
defaults  245 
Enable ARP Flooding check box  137 
Multicast Flooding field  23, 136 
Multicast Outbound to Secondary LANs field  136 
Unicast Flooding field  137 
Unicast Outbound to Secondary LANs field  137 

global RF parameters 
902 MHz Frag Size field  139 
configuring  138 
described  139 
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global RF parameters (continued) 
RFC1042 Types to Pass Through field  139 
S-UHF Frag Size field  139 
S-UHF Rfp Threshold field  139 
S-UHF/902 MHz Awake Time field  139 

Global RF Parameters screen  138 
defaults  246 
Perform RFC1042/DIX Conversion check box  139 

guidelines 
for antenna placement  54 
for installing access points  40 

H 
hardware installed, viewing  186 
Hello Period field  105 
help  See troubleshooting 
High Address field  64 
Hop Period field  103 
HTTP server  See MobileLAN access Utility 
HTTPS  See secure web browser interface 
humidity 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

I 
IAPP   

setting inbound filter  89, 90, 96, 97, 100, 101 
understanding  108 
See also secure IAPP. 

IAPP Secret Key field  151, 160 
ICMP echo, using  196 
IEEE 802.11a radio  See 802.11a radio 
IEEE 802.11a Radio screen  92 

defaults  253 
Frequency field  93 
Node Type field  93 
SSID field  93 

IEEE 802.11a Radio Security screen  See IEEE 802.11b 
Radio Security screen 

IEEE 802.11b radio  See 802.11b radio 
IEEE 802.11b Radio screen  85 

defaults  252 
Frequency field  86 
Node Type field  86 
SSID field  86 

IEEE 802.11b Radio Security screen  153, 155, 158, 
163 

ACL Client Authorization check box  153 
ACL RADIUS Client Password field  153 
Allow Unencrypted Clients check box  156 
defaults  250 
Enable WEP Encryption check box  155, 156 
VLAN field  163 
WEP Key fields  156 

WEP Key Rotation field  158 
WEP Transmit Key field  156 
WEP/802.1x Authentication field  158 

IGMP 
enabling  123 
understanding  119 

Import Certificate screen  170 
Server Certificate option  170 
Trusted CA Certificate option  170 

importing an EAS database  177, 179 
improving network performance  40 
Inbound Filters screen  90, 97, 101 

Allow All Other Protocols check box  90, 97, 101 
Allow DHCP check box  90, 97, 101 
Allow IAPP check box  89, 90, 96, 97, 100, 101 
Allow SpectraLink Voice Protocol check box  90 
Allow UDP Plus check box  89, 90, 96, 97, 100, 

101 
Allow Wireless Transport Protocol check box  89, 

90, 96, 97, 100, 101 
inbound filters, configuring 

for 802.11a radio  96 
for 802.11b radio  89 
for OpenAir radio  100 

installing 
2100  45 
2101  42 
2102  47 
2106  47 
certificates  167, 169 
general guidelines  40 
WA21  44 
WA22  41 

interference, decreasing  40 
intermediate certificate authority  See certificate 

authority 
internal RADIUS server  See EAS. See authentication 

server. See RADIUS server 
Internal RADIUS Server  See Embedded 

Authentication Server 
Internet Control Message Protocol echo  See ICMP 

echo 
IP address 

guidelines for non-IP protocols  112 
setting  29 

IP Address field  61 
IP Addresses screen  124 
IP broadcast address, supported DHCP server option  

64 
IP Router field  61 
IP Subnet Mask field  61 
IP tunnel filters 

configuring  124 
examples  130 
frame type, using  125 
predefined subtype, using  127 
subtype filters, customizing  128 
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IP tunnels 
comparing to mobile IP  134 
configuring  123 
filters, configuring  124 
originating  117, 119 
parameters, described  123 
understanding  115 

IP Tunnels screen  123 
Allow IP Multicast check box  123 
defaults  248 
Enable IGMP check box  123 
Mode field  118, 120, 123 
Multicast Address field  123 

L 
LAN ID field  109, 110, 111, 112, 114 
Lease Time field  64 
LED Descriptions table  6 
LEDs 

2100 illustration  7 
2101 illustration  7 
2102 illustration  8 
2106 illustration  8 
descriptions  6 
Power  6 
Radio  6 
Root/error  6 
summary  6 
using 

to indicate incorrect configuration matrix string  
195 

to locate access points  188 
to troubleshoot radios  195 

WA21 illustration  7 
WA22 illustration  7 
Wired LAN  6 
Wireless #1  6 
Wireless #2  6 

Link Speed field  67 
load balancing, enabling  88 
locating access points, using LEDs  188 
logins 

changing  148 
using password server to authorize  145 

Low Address field  64 

M 
MAC address, viewing  187 
MAC configuration 

parameters, described  103, 104 
setting parameters manually  102 

MAC Configuration field  99 
maintaining access points  184 
management interfaces 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 

WA22  232 
managing access points  182 

using MobileLAN access Configuration Wizard  182 
using MobileLAN manager  182 
using SNMP  182 

manual 
audience  xiii 
cautions  xii 
change record  iii 
notes  xii 
warnings  xii 

Manual MAC Parameters screen  102 
Beacon Frequency field  103 
defaults  254 
Deferral Slot field  103 
Fairness Slot field  103 
Fragment Ack Retry field  104 
Fragment QFSK Retry field  104 
Fragment Size field  103 
Hop Period field  103 
Normal Ack Retry field  103 
Normal QFSK Retry field  104 
Transmit Mode field  103 

Mask field  76 
Master List screen  17, 100 
master list, configuring for OpenAir radio  100 
Media Access protocol 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

medium density distribution, enabling  88 
menu bar  37 
MIB, passwords  182 
microwave ovens, decreasing interference from  40, 88 
mobile IP, comparing to IP tunnels  134 
MobileLAN access Configuration Wizard, using 

to configure access points  29 
to manage access points  182 
to restore default configuration  189 

MobileLAN access family  See access points 
MobileLAN access Utility 

enabling access  145 
using 

as a distributed upgrade server  203 
to configure access points  29 
to recover an access point  200 
to restore default configuration  189, 204 
to upgrade access points  203 

MobileLAN manager, using to manage access points  
182 

MobileLAN splitter  See splitter 
MobileLAN voice network  See SpectraLink network 
Mode field  118, 120, 123 
Mode-Channel field  105 
modulation, IEEE 802.11b radio  238 
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mounting 
2100  45 
2101  42 
WA21  44 
WA22  41 

MT-RJ network, connecting the access points  50 
Multicast Address field  123 
Multicast Filter check box  105 
Multicast Flooding field  23, 136 
multicast IP tunnels, creating  119 
Multicast Outbound to Secondary LANs field  136 

N 
NAT server, configuring the access point  66 
NAT, understanding  65 
network address translation  See NAT 
Network Management screen  183 

defaults  249 
SNMP Read Community field  183 
SNMP Secret Community field  183 
SNMP Write Community field  183 

network name  See SSID field 
networks  See wireless networks 
NNL  112 
Node Type field  86, 93, 99 
non-routable network layer  See NNL 
Normal Ack Retry field  103 
Normal QFSK Retry field  104 
notes, understanding  xii 

O 
Offset field  76 
omni antennas  55, 56, 57 

See also antennas. 
Op field  See Operation field 
OpenAir radio 

configuring  98 
inbound filters  100 
master list  100 
WAP example  21 

Inbound Filters screen  101 
inbound filters, described  101 
MAC configuration, setting parameters manually  

102 
Manual MAC Parameters screen  102 
Master List screen  100 
parameters, described  99 
positioning antennas for WAP  56 
specifications  239 

OpenAir Radio screen  98 
Channel field  99 
defaults  254 
MAC Configuration field  99 
Node Type field  99 
Security ID field  99 
Subchannel field  99 

Operation field  76 
options, list of antennas and accessories  240 
originating IP tunnels  117, 119 

P 
Password field  149, 161, 175 
password server 

configuring the access point  146 
requirements  145 
using to authorize logins  145, 146 

Passwords screen  146, 148 
Allow Service Password check box  147, 149 
defaults  250 
Password field  149 
Read Only Password field  149 
Use RADIUS for Login Authorization check box  

147, 148, 149 
User Name field  149 

passwords, changing  148 
patent information  xiv 
Perform RFC1042/DIX Conversion check box  139 
permanent filters  122 
physical specifications 

2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

Ping Utility screen  196, 197 
ping, using to troubleshoot radios  195, 196 
point-to-point bridges  2 

802.11a, example  27 
802.11b, example  26 
configuring  22 
illustration  22 

Port Control check box  105 
Port Descriptions table  8 
Port Statistics screen  185 
port statistics, viewing  185 
Port Type field  67 
ports 

10BaseT port  8 
10BaseT/100BaseTx port  8 
2100 illustration  10 
2101 illustration  9 
2102 illustration  11 
2106 illustration  11 
descriptions  8 
fiber optic  8 
IP tunnels, understanding  115 
power  8 
priorities  3 
serial  8 
summary  8 
WA21 illustration  10 
WA22 illustration  9 

positioning antennas 
2102/2106  47 
for antenna diversity  55 
for dual radios  56 



Index 

MobileLAN access System Manual 277 

positioning antennas (continued) 
for IEEE 802.11b radio  55 
for OpenAir WAP  56 

Power LED  6 
power output 

902 MHz radio  239 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

power over Ethernet   
connecting  53 
See also splitter. 

power port  8 
power, connecting 

2100  46 
2101  43 
2102  49 
2106  49 
WA21  45 
WA22  42 

Predefined Subtype Filters screen  71, 127 
predefined subtype filters, using  71, 127 
Preferred Protocol field  161 
primary LAN, understanding  109 

R 
Radio LED  6 
radio MAC ping, using  195 
radios 

features  84 
specifications  238 
supported  232 to 237 
troubleshooting 

general  195 
using LEDs  195 

viewing version  187 
RADIUS clients  See access points 
RADIUS server  166 

requirements  152, 157 
using 

as an authentication server  157 
to authorize logins  145 
to maintain an ACL  152 

See also EAS. See also authentication server. See also 
password server. See also EAS. 

RADIUS Server List screen, defaults  251 
range 

902 MHz radio  239 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

Read Only Password field  149 
receiver sensitivity 

IEEE 802.11b radio  238 
WLI Forum OpenAir radio  239 

recovering a failed access point, using  200 
a DNL file  201 
a Windows NT PC  201 

the MobileLAN access Utility  200 
redundancy, using dual radios  28 
rejected list 

entries 
adding to the database  176 
deleting  177 

understanding  176 
using  176 
viewing  176 

reloading access point files  200 
remote IP subnet, understanding  110 
repeaters  See WAPs 
Reservation Threshold field  88, 95 
restoring the default configuration, using  189 

a web browser interface  190 
the MobileLAN access Utility  189, 204 

RFC1042 Types to Pass Through field  139 
roaming 

example  15 
using access points  13 

ROM monitor  See AP monitor 
root access point 

configuring  109 
understanding  109 

root certificate authority  See certificate authority 
Root Priority field  109, 110, 112, 114 
Root/error LED  6 

S 
safety icons  xii 
safety summary  xi 
saving the configuration  36 
SC network, connecting the access points  51 
script files, creating  228 
sdvars commands, using  225 
Secondary LAN Bridge Priority field  109, 110, 112, 

115 
Secondary LAN Flooding field  23, 111, 115 
secondary LANs, understanding  110 
secure IAPP   

enabling  150, 159 
troubleshooting  150, 184 
understanding  108 
See also IAPP. 

Secure IAPP check box  151 
secure web browser interface  35, 145 

certificates, installing  167, 169 
secure wireless hops  89, 96, 100 

enabling  150, 159 
troubleshooting  184 
See also wireless hops. 

security 
changing the default login  146, 148 
enabling 

access methods  144 
secure IAPP  150, 159 
secure wireless hops  150, 159 

IEEE 802.11b radio  238 
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security (continued) 
implementing in a wireless network  142 
spanning tree, configuring  150, 160 
troubleshooting  197, 199 
using 

802.1x  156 
a password server  145 
a RADIUS server  152 
a secure web browser interface  145 
an ACL  152 
VLANs  162 
WEP keys  154 

Security Events log 
exporting  198 
understanding  198 
viewing  197 

Security ID field  99 
Security screen  144 

Allow ICMP Configuration check box  145 
Allow SNMP Access check box  145 
Allow Telnet Access check box  145 
Allow TFTP Access check box  145 
Browser Access field  145 
defaults  250 

segments, file system  210 
serial port  8 

maximum data rate 
2100  235 
2101  233 
2102  236 
WA21  234 
WA22  232 

Server Certificate option  170 
Service mode commands 

displaying list of  215 
using  214 

service password  146 
enabling  149 

setting 
filter expressions  75 
filter values  74 
MAC configuration parameters manually  102 

Simple Network Management Protocol  see SNMP 
SNMP 

access, enabling  145 
community strings, configuring  182 
MIB passwords  182 
parameters, described  183 
using to manage access points  182 

SNMP agent 
2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

SNMP Read Community field  183 
SNMP Secret Community field  183 

SNMP Write Community field  183 
software upgrades, performing  203 
software version, viewing  187 
spanning tree 

configuring  113 
configuring security  150, 160 
parameters, described  114 
understanding  108 
viewing  184 

Spanning Tree Security screen  151, 160 
Allow SWAP check box  151, 161 
Allow TLS check box  151, 161 
Allow TTLS check box  151, 161 
Authentication Server Common Name field  162 
defaults  251 
IAPP Secret Key field  151, 160 
Password field  161 
Preferred Protocol field  161 
Secure IAPP check box  151 
User Name field  161 
Verify CA Certificate check box  161 

Spanning Tree Settings screen  113, 163 
AP Name field  114 
defaults  245 
Enable Ethernet Bridging check box  109, 110, 111, 

112, 114 
Enable GVRP for VLAN check box  114, 163 
LAN ID field  109, 110, 111, 112, 114 
Root Priority field  109, 110, 112, 114 
Secondary LAN Bridge Priority field  109, 110, 112, 

115 
Secondary LAN Flooding field  111 
Secondary LAN Flooding field  23, 115 

specifications  232 
2100  235 
2101  233 
2102  236 
2106  237 
902 MHz radio  239 
architecture  232 to 237 
electrical  232 to 237 
Ethernet compatibility  232 to 237 
Ethernet data rate  232 to 237 
Ethernet interfaces  232 to 237 
fiber optic  232 to 235 
filters  232 to 237 
humidity  232 to 237 
IEEE 802.11a radio  238 
IEEE 802.11b radio  238 
management interfaces  232 to 237 
Media Access protocol  232 to 237 
physical  232 to 237 
radios supported  232 to 237 
serial port maximum data rate  232 to 236 
SNMP agent  232 to 237 
temperature  232 to 237 
WA21  234 
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specifications (continued) 
WA22  232 
WLI Forum OpenAir radio  239 

SpectraLink network, configuring  91 
inbound filter  90 

splitter, connecting  53 
square connector network  See SC network 
SSID field  86, 93 
ST network, connecting the access points  52 
straight tip network  See ST network 
Subchannel field  99 
subtype filters 

customizing  72, 128 
parameters, described  73, 129 
predefined  127 
using  71 

supplicant, requirements  157 
support 

telephone  xiii 
warranty information  xii 
web site address  xii 

supported DHCP server options, IP broadcast address  
64 

SWAP  150, 160 

T 
TCP/IP parameters 

configuring  60 
described  61 

TCP/IP Settings screen  35, 60, 62 
defaults  244 
DHCP Mode field  62, 63, 66 
DHCP Server Name field  62 
DNS Address field  61 
DNS Suffix field  61 
IP Address field  61 
IP Router field  61 
IP Subnet Mask field  61 

technical support 
contacting Intermec Technologies Corporation  191 

telephone support  xiii 
telnet, using  29, 145 

to configure the access points  35 
to manage access points  182 
to save a configuration  37 

temperature ratings 
2100  235 
2101  233 
2102  236 
2106  237 
WA21  234 
WA22  232 

Test mode commands 
displaying list of  214 
using  213 

TFTP commands, using  217, 220, 221 
Transmit Mode field  103 

troubleshooting  190 
contacting Intermec Technical Support  191 
general problems/solutions  192 
radios  195 

using ICMP echo  196 
using LEDs  195 
using radio MAC ping  195 

reloading access point files  200 
secure IAPP  150, 184 
secure wireless hops  184 
security  197, 199 
upgrading access points  206 
using the configuration error messages  191 

Trusted CA Certificate option  170 
tunnels  See IP tunnels 
Type field  174, 175 

U 
UAP.DNL, using to recover an access point  201 
UDP Plus, setting inbound filter  90, 97, 101 
UDP Port field  173 
understanding 

LEDs  6 
ports  8 
security  142 

Unicast Flooding field  137 
unicast IP tunnels, creating  117 
Unicast Outbound to Secondary LANs field  137 
unsupported DHCP server options  65 
upgrade server  See MobileLAN access Utility 
Upgrade Software screen  206 
upgrading access points  203 

troubleshooting  206 
using 

a web browser interface  205 
the MobileLAN access Utility  203 

Use RADIUS for Login Authorization check box  147, 
148, 149 

User Name field  149, 161, 175 
user name, changing  148 
using 

access points 
for point-to-point bridges  22 
for roaming end devices  13 
for WAPs  16 
with dual radios for redundancy  28 

AP monitor  210 
CAM mode commands  212 
Command Console mode  218 
Ethernet frame type filters  69 
IP tunnel frame type filters  125 
MobileLAN splitter  53 
predefined subtype filters  71, 127 
sdvars commands  225 
Service mode commands  214 
static WEP keys for encryption  154 
Test mode commands  213 
TFTP commands  221 
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V 
Value ID field  77 
Verify CA Certificate check box  161 
viewing 

About this Access Point screen  187 
access point connections  184 
certificates  168 
configuration summary  186 
port statistics  185 
rejected list  176 
Security Events log  197 

virtual LANs, configuring  See VLANS, configuring 
VLAN field  163 
VLANs, configuring  162 
voice over IP  See SpectraLink network 

W 
WA21   

cable access door, removing  8 
connecting 

to power  45 
to the fiber optic network  50 
to the network  45 

environments  11 
installing  44 
LEDs, illustration  7 
mounting  44 
ports, illustration  10 
specifications  234 
See also access points. 

WA22   
connecting 

to power  42 
to the fiber optic network  50 
to the network  42 

environments  11 
installing  41 
LEDs, illustration  7 
mounting  41 
ports, illustration  9 
specifications  232 
See also access points. 

WAPs  2 
802.11a, example  20 
802.11b, example  19 
configuring  16 
illustration  16 

OpenAir, example  21 
positioning OpenAir antennas  56 

warnings, understanding  xii 
warranty information  xii 
web browser interface, using  29 

enabling access  145 
to configure the access points  34 
to manage access points  182 
to restore default configuration  189, 190 
to save configuration  37 
to upgrade access points  203, 205 

web support  xii 
WEP 128 security, configuring  154 
WEP 64 security, configuring  154 
WEP Key fields  156 
WEP Key Rotation Period field  158 
WEP keys 

configuring dynamic keys  156 
configuring static keys  154 
parameters, described  156 

WEP Transmit Key field  156 
WEP/802.1x Authentication field  158 
what’s new  5 
Wired LAN LED  6 
wired LANs, bridging between  22 
Wireless #1 LED  6 
Wireless #2 LED  6 
wireless access points  See WAPs 
wireless hops 

forming secure wireless hops  89, 96, 100, 150, 159 
understanding  16, 22 

wireless networks  11 
configuring 

multiple access points  13 
one access point  12 
point-to-point bridges  22 
WAPs  16 

implementing security  142 
improving performance  40 

Wireless Transport protocol  See WTP 
wizard  See MobileLAN access Configuration Wizard 
WLI Forum OpenAir radio  See OpenAir radio 
worldwide frequencies 

802.11a radio  94 
802.11b radio  86 

WTP, setting inbound filter  90, 97, 101 
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About This Addendum 
This addendum adds information to the MobileLAN access System Manual 
(067150) for software release 1.94. With the addition of this addendum to 
your system manual, the part number changes to -012. 

 

Note: Since the MobileLAN access System Manual was last updated for 
software release 1.90, there have been two minor software releases (1.91 
and 1.93) that only fixed software issues. 

What’s New for Software Release 1.94? 
Software release 1.94 can be installed on all MobileLAN access products. 
However, Intermec recommends that you only install this release if you 
need a feature or one of the software fixes. For more details on these 
software fixes, contact Intermec Technical Support. 

This feature was added for this software release: 

• Wavelink Avalanche client management system support. To use 
Avalanche, you need Avalanche Manager v3.0 or later. 

This feature was removed for this software release: 

• OpenAir radio support. If you have OpenAir radios in your access 
point, do not upgrade it to release 1.94. 

Using Wavelink Avalanche With Your MobileLAN access Products 
This section provides a brief overview of the Wavelink Avalanche client 
management system, explains how to configure your access points with 
software release 1.94 or later to work with Avalanche, and describes how to 
use Avalanche to manage your access points. 

Learning About Avalanche 
The Wavelink Avalanche client management system uses three main 
components to help you easily manage your wireless network. 

Component Description 

Enabler Resides on all devices managed by the Avalanche system. It 
communicates information about the device to the Avalanche Agent 
and manages software applications on the device. 

Agent Automatically detects and upgrades all devices in the Avalanche system 
and manages the daily processing functions.  

Console The administrative user interface that lets you configure and 
communicate with the Avalanche Agent. From the console, you can 
configure and monitor devices and build and install software packages 
and software collections. 
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The enabler is already installed on access points with software release 1.94 
or later. You can install the agent and the console on the same PC. 
Avalanche uses a hierarchical file system organized into software packages 
and software collections: 

• Software packages are groups of files for an application that resides on 
the device.  

• Software collections are logical groups of software packages. 

For more information about software packages and software collections, 
see the Wavelink Avalanche documentation and online help. Or, visit the 
Wavelink web site at www.wavelink.com. 

 Configuring Your Access Points to Use Avalanche 
The first time an access point (with software release 1.94) is assigned an IP 
address, either manually or from a DHCP server, it attempts to connect to 
the Avalanche Management Console through the Avalanche Agent. Once 
it finds the agent, it automatically configures the console IP address. 

However, if you upgrade an existing access point to software release 1.94 
or later, you may need to configure your access points to use Avalanche. 

 

Note: The access points that you want Avalanche to configure and manage 
must be on the same subnet as the agent. 

To configure your access points to use Avalanche 

1 Start the web browser application. 

2 In the Address field (Internet Explorer) or in the Location field 
(Netscape Communicator), enter the access point IP address, and press 
Enter. The Access Point Login screen appears. 

3 Enter a user name and a password, and then click Login. The TCP/IP 
Settings screen appears. 

4 From the main menu, click Network Management. The Network 
Management page appears. 
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5 In the Avalanche Console Address field, enter the IP address or DNS 
name of the console.  

Or, leave this field blank and the access point sends out a broadcast 
request looking for any available agent. 

6 Click Submit Changes to save your changes. 

7 From the main menu, click Security. The Security page appears. 

   

8 Verify that the Allow Avalanche Access check box is checked. 

9 Click Submit Changes to save your changes. To activate your changes, 
from the menu bar click Save/Discard Changes, and then click Save 
Changes and Reboot. For help, see “Saving Configuration Changes” in 
your system manual. 

10 Repeat Steps 1 through 9 for each access point. 

Using Avalanche to Manage Your Access Points 
Each time the access point is rebooted, it attempts to connect to the 
Avalanche Agent. When the access point connects to the agent, the agent 
determines whether an update is available and immediately starts the 
software upgrade, file transfer, or configuration update. You can also 
schedule these updates or you can manually initiate an update. 

 

Note: The first time the access point locates the agent, it needs to 
synchronize with the Avalanche system. On the agent, you must have 
installed a software package that can be downloaded to the access point.  
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To use Avalanche to manage your access points 

1 Create a software package (.AVA file) that includes the latest software 
release (.BIN file) using Avalanche Package Builder. 

   

Parameter Explanation 

Package Title A descriptive title of the application. For example, enter 
AP194. 

Package Type Choose Application. 

Package Revision The package version number. For example, enter 1.94. 

Menu Order Enter 1. 

Target 
 
 
 
 
 
 
 
 
 
 

 

Specifies which access points can receive this application. 
Enter a | between each ModelName. 
ModelName=ITCAPWA21 
ModelName=ITCAPWA22 
ModelName=ITCAP2106 
ModelName=ITCAP2100v2 
ModelName=ITCAP2100 
ModelName=ITCAP2101v2 
ModelName=ITCAP2101 
ModelName=ITCAP2102 
 
Note: The ITCAP2100v2 refers to the 2100D and 
ITCAP2101v2 refers to the 2101B. 

Package Files The files that are included in this package. For example, 
ap220web.bin. 
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2 Install the software package using the Avalanche Management Console. 

3 Schedule access point updates or manually initiate an update using the 
console. 

For more information on using the Wavelink Avalanche client 
management system, see the Wavelink Avalanche documentation and 
online help. Or, visit the Wavelink web site at www.wavelink.com.  

Important Information When Using Avalanche With Your Access Points 
• If your access point is a DHCP server and Avalanche contains a network 

profile for the access point that assigns IP addresses from a DHCP 
server, the access point will lose its static IP address. Any devices that 
were supposed to receive an IP address from the access point will not 
succeed. 

• If you are using the MobileLAN access Utility to recover a failed access 
point and you are using Avalanche to manage the access point, the 
recovery process may fail. 

• If you change security parameters in your wireless network and you are 
using Avalanche, make sure that you update the security parameters on 
your end devices before you update the security parameters on your 
access point. Otherwise, you will lose connectivity between your end 
devices and your access point. 
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